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 Web Forms

Web form on a web page

Order form of your e-Commerce web site
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Mailing list (subscription form and list of contacts)
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Catalogs & Products

Online Stock

Online Orders

Customer accounts

Shipments & Shipping Prices

Payments (credit cards, PayPal, Stripe, wire transfers, checks, ...)

Coupons rebates code

Download files for sale (ebook, photos, musics, ...)

Advertising

 Themes & Topics

Start or restart your Theme

Customize your theme

Gallery

Add new Topics

Add Paragraphs & Sidebar Panels

Add Tabs    New ! 
Appearance of paragraphs

Display paragraphs side by side

Paragraphs aside background images

Datestamp on paragraphs

Web, local and custom Fonts

Blogging using group topics

 Publish your website

Publish your website on your web space

Search Engine Optimization & Google

Advice when connection or publication fails

Website not visible or online pages not displayed correctly

Custom error pages, robots.txt and .htaccess

Sitemap file(s)

Export your pages to PDF

 Other Features

Site Optimizer

Multilingual website

Scripts & source code (html, javascript, php, ...)

TOWeb portable

Terms of Use, Sales and Cookies

Site compliant to the European GDPR

Opt-in & Opt-out



 





https://www.lauyan.com/en/catalogues.html
https://www.lauyan.com/en/catalogues.html#xnuUrtyC
https://www.lauyan.com/en/ecommerce.html#UefbRDfZ
https://www.lauyan.com/en/ecommerce.html#RVyHnXwX
https://www.lauyan.com/en/ecommerce.html#ZPe6BDKR
https://www.lauyan.com/en/ecommerce.html#aPVOx5xv
https://www.lauyan.com/en/ecommerce.html#5gMKxsAc
https://www.lauyan.com/en/download-file-sales.html
https://www.lauyan.com/en/ads.html
https://www.lauyan.com/en/theme-creation.html
https://www.lauyan.com/en/theme-creation.html#J7fwE0fg
https://www.lauyan.com/en/gallery.php
https://www.lauyan.com/en/topics.html
https://www.lauyan.com/en/topics.html#gl0kZaTB
https://www.lauyan.com/en/topics.html#qPKv89GF
https://www.lauyan.com/en/topics.html#sLJmX6xD
https://www.lauyan.com/en/topics.html#rJMiUEvh
https://www.lauyan.com/en/topics.html#rBR2mh8q
https://www.lauyan.com/en/topics.html#yKPNcvWt
https://www.lauyan.com/en/theme-creation.html#webfonts
https://www.lauyan.com/en/blogging.html
https://www.lauyan.com/en/publish.html
https://www.lauyan.com/en/seo.html
https://www.lauyan.com/en/publish.html#PfNBYa4I
https://www.lauyan.com/en/publish.html#rAzVuRty
https://www.lauyan.com/en/site-rules.html
https://www.lauyan.com/en/site-rules.html#sitemap
https://www.lauyan.com/en/topics.html#yb0z21rU
https://www.lauyan.com/en/seo.html
https://www.lauyan.com/en/multilingual-website.html
https://www.lauyan.com/en/scripts.html
https://www.lauyan.com/en/backups.html#i7n8O9jy
https://www.lauyan.com/en/site-conditions-cookies.html
https://www.lauyan.com/en/gdpr.html
https://www.lauyan.com/en/site-conditions-cookies.html#b8lucLE4


Installation, Reinstallation & Registration

Installation

TOWeb V14 minor Updates (versions 14.xx)

License upgrade

Install your registration key

Reinstallation & Advices

Uninstallation

Installation

Download the latest version 14.01 of TOWeb for Windows or Mac OS X . Once the installation file is downloaded, double-click it to start the installation
procedure. Once installed, you will find shortcuts on your desktop and in the Start menu of Windows to run TOWeb (or inside your Applications folder
under Mac OS X). If you purchased a older version (ie. lower than 14) and need to reinstall it, please go to the TOWeb former versions page. If any
error when starting the application, please follow our tips on how to allow or unblock TOWeb on your computer .

TOWeb V14 minor Updates (versions 14.xx)

All version 14.xx can be installed with no need to uninstall your previous version. The latest install procedure of TOWeb will automatically update your
previous files. For more information see the lastest changes of TOWeb .

License upgrade

If you are a user of the Standard Edition and never purchased any version of TOWeb you can order your TOWeb Edition  and continue

your website previously started using the free edition.  

If you already purchased a version of TOWeb and want to upgrade to higher Edition then start TOWeb V14 and from the "License" (  ) screen,

click on the Upgrade button of the new Edition you want to purchase.

If you were previously using at least version 5 of TOWeb then all your websites will be imported and kept identically without any loss in
TOWeb 14 using both the "File > Open" function and the "File > Restore" function (provided of course that you still have the data of your sites

on your computer and/or that you have kept the WGA files of your backups previously made with TOWeb). On the other hand, if you were using

version 4 or lower, the very old technology of the sites of that time will require you to make adjustments by following our help page on migrating

old V1-V4 sites to TOWeb V14.

Install your registration key

After completion of the installation, TOWeb runs in Standard edition mode. If you have purchased a license key for the Premium, e-Commerce or
Studio edition, you will receive a registration key by email (If you have lost your registration key fill out this form to request your key). Follow the 3
steps below to install your key:

1 - Select your key from the email

From the delivery email you received, select all the characters of the long license key with your
mouse.

2 - Copy your registration key to the clipboard

Right click on the selection and choose "Copy" from the context menu or directly press the keyboard shortcut Ctrl+C (or Cmd+C on Mac OS X)
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Reinstallation & Advices

IMPORTANT !!! : In case of data loss on your hard drive (crash disk, viruses, errors, ...) including complete or partial loss of your website, your will
need to restore your website from a backup file containing all the necessary information to maintain it and generate it again. If don't have any
website backup file previously stored anywhere, you won't be able to restart your website just from the generated web pages
published on the internet but will have to create it again. Therefore it's important to periodically backup versions of your website to be able to
continue it in such event and not restart it from scratch.

How to get back your registration key if you lost you delivery mail ?

If, despite our recommendations, you have not made a backup of your delivery mail, fill out this form to request your key. You will need to enter your
invoice number and your email address.

How to install TOWeb again after a crash disk ?

You first need to install TOWeb again on your machine. To do so, download it from our website and install it using your registration key delivered to
you by email (if you have lost your registration key, please contact us at contact lauyan.com and provide us with your name, address, email address
and your invoice number).
Once TOWeb is installed, you need to restore your website from a backup file previously archived on an external media such as second hard drive or
CD-ROM. The restore feature is accessible from the link located in the "File" step of TOWeb.

How to install TOWeb on my new computer ?

If you have a new computer on which you want to transfer your website and continue using TOWeb, please follow these instructions :

1. Backup your website from the "Publish" step and save it on any external media such as CD-ROM or a shared drive where you will also save the
email containing your registration key.

2. Install TOWeb on your new computer directly from our website and use your registration key
3. Then uninstall your TOWeb license from your old computer

For more information please read also the information related to the TOWeb restore feature.

Uninstallation

If you want to uninstall TOWeb you can proceed from the Windows Control Panel in the Add or Remove Programs area or from the TOWeb submenu
added to your Windows Start menu in All programs depending on your Microsoft Windows version.

IMPORTANT: All the data information of your website (including local backups you may have created) will not be deleted after the uninstallation. If you
decide to reinstall TOWeb later you will still be able to reuse the website you have previously created.
But if you want to delete all your website data information as well, then open your folder My Documents and from there delete the entire directory
TOWeb sites with all its content.
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TOWeb interface overview

A website managed like a document

When you start TOWeb and create or open your website, it will work like a document meaning that any changes will not be definitely saved on your
computer until you say so. To save you changes at any time you may either use the CTRL  + S  shortcut or the Save changes button located on the
main toolbar. If you have made changes and want to close the application, TOWeb will ask you if you want to save your changes. Caution : if you say
NO all your changes since you open your website (or date of your last save) will all be canceled and lost.
Despite your website is seen as a document it contains many pages and files and hours of works that you do not want to loose so we recommend to
make backups very often to be able to restore all your website data back on your computer in case of problem (such as virus, crash disk and any type
of errors that could delete or corrupts files of your websites).

The 6 steps of TOWeb

  Step 1: File

Create your first site from a template. In this step you will be able to see the summary of your site and use site management features such as open,
backup and restore but also manage different versions of your site . To estimate the size of your site (displayed in its summary) you need to generate
a local preview in your web browser using the Build and Preview button (  ) or the SHIFT  + F12  keyboard shortcut.

 Step 2: Theme

Start your website from one of our numerous templates theme and customize it by adding your own pictures, styles and texts using the theme editors .

  Step 3: Topics

Add and modify different types of topics :

single web pages,

albums,

collections of pages or items,

catalogs of products

blogs

To edit the content of your topic, click on the paragraph your want to update. Once selected the left side panel is filled out with information &
properties of your paragraph that you may change like for instance the width of your paragraph or add/change an object into it such as picture .
If you want to change the title or text of your paragraph just double-click on it. A small toolbar will appear on top of it

and you will be able to edit your text, align it, add or remove links a buttons , change text colors, style to bold or italic, perform copy/paste, add
ordered list, etc.

The version 13 of TOWeb has also introduced a new button   to highlight a word or a sentence in your page in order to make it more visible not

only to your visitors but also to search engines like Google.

When hovering over a paragraph, a simplified toolbar appears to allow you to directly perform the most common actions such as deleting this
paragraph, duplicating it, editing its title or text. But you can also right-click on a paragraph, this not only activate it to see its properties on the
sidebar but also display in a popup menu containing the complete list of actions you can apply to it.

The top toolbar of TOWeb contains the list of all your topics. You may open a topic from this list or click on any links present in your page (like for
instance one on your website menu) to directly open and edit the topic of this link.
On the top toolbar you can also add new topics (  ) or import them, delete (  ) a topic and organize your topics (  ) of your website to decide
their position, which topics needs to appear in your main menu or in a submenu or inside a group or not be displayed at all in the menu of your
website.
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 Step 4: E-Commerce
In this step you configure the e-Commerce options and functions for your store's sales (shopping cart, payments, deliveries, coupons, stock, ...).
Activating the e-commerce functions requires to have at least 1 catalog with 1 or more products to sell, these can be physical products or services or
downloadable digital products.

 Step 5: Back-Office
In this step, you configure and directly access your website's back office. From your back office, you can monitor the various online i-services used on
your site, such as bookings, orders, polls and downloadable files.

  Step 6: Options

In this step configure any additional function for your website such as a local search engine or cookie management or the possibility to add
different languages to your website but also change the TOWeb interface options such its language (among English, Italian, French, German,
Portuguese and Spanish), choose you preferred color mode (between light, dark or automatic) or adjust button size of toolbar to your liking.

Each of these 7 steps has a sidebar that you can make disappear or reappear if you wish by making multiple clicks on the button of the step in
which you are. This "hide/show" operation can be activated or deactivated from the "TOWeb Interface" screen to allow you to increase the width of the
TOWeb working window whenever you want for greater comfort of use.

TOWeb 14 in Light mode
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TOWeb 14 in Dark mode

  Step 7: Publish Your Website

Finally enter your host parameters and publish your website . Once this is done just click on the publish button to make it available online to all on the
internet. TOWeb integrates a FTP module optimized to only publish the new files and the ones that have changed since your last publication. You may
also use additional options to publish your site at a scheduled time and turn off your computer thereafter, which can allow you to republish your site in
the middle of the night for example.

The other buttons of TOWeb's main toolbar

In addition to the TOWeb steps buttons, the main toolbar also contains all the following buttons you may also need to use frequently.

 Save button : visible each time a change has been made to your site, use this button whenever your satisfy and and want to save all your

changes.

 Undo button : visible each time a change has been made to your site, use this button when you want to undo all the changes made since the

last time you used the save button.

 Versioning button : directly access to the versioning screen to manage or simply use another version of your site for testing and many other

different needs. 

 License button : display the version and license information of the TOWeb application you are currently using as well as your upgrade license

buttons too.

 Help & Technical support : use this assistant if you need to access the TOWeb help pages or want to contact our technical support.

Fast search of topics

This new feature allows you to quickly find and select a particular topic of your website by simply typing a word and/or filtering by topic types.
Useful and efficient when your site starts to contain many pages, you can use the search button (   ) in different places like:

when creating a link to another topic
from the toolbar of the "Topics" step to quickly navigate to a specific topic

The keyboard shortcut CTRL  + F  can also be used in the "Topics" step as well as the "Theme" step to navigate even faster from one section to
another at any time without using the mouse.



 



https://www.lauyan.com/en/publish.html
https://www.lauyan.com/en/toweb-overview.html#buttons
https://www.lauyan.com/en/versioning.html
https://www.lauyan.com/en/toweb-overview.html#header
https://www.lauyan.com/en/_media/img/xlarge/toweb-ui-dark-mode-2.webp


List of TOWeb keyboard shortcuts

Using the shortcuts below requires version 13 or higher.

CTRL  + O  = Open a site
CTRL  + N  = Create a new site
CTRL  + S  = Save changes
CTRL  + L  = Display or upgrade your TOWeb license
CTRL  + M  = Open your site's menu management window
CTRL  + T  = Change the dimensions of the TOWeb application to different predefined sizes
CTRL  + W  = Go to the "File > Backup" screen
CTRL  + R  = Go to the "File > Restore" screen
CTRL  + G  = Go to the "File > Versioning" screen
CTRL  + H  = Go to the "Options > Security & HTML" screen

F1  = Online help
F4  = Go to the "E-Commerce" step
F5  = Go to the "File" step
F6  = Go to the "Topics" step
F7  = Go to the "Theme" step
F8  = Go to the "Publish" step
F9  = Go to the "Options" step
F11  = Go to the "Back-Office" step
F10  = Hide or show the TOWeb top toolbar after 2 consecutive presses
F12  = Preview the site locally in your web browser

CTRL  + F  = In the "Topics" step, open the fast search field in order to directly enter a text to search for on the page
CTRL  + F1  = TOWeb Support (Help + Technical Support Request Form)
CTRL  + F3  = In the "Topics" step, set the focus to the search field in order to directly enter a text to search for on the page

CTRL  + F8  = Web Hosting Setup Wizard
ALT  + F8  = Publish only changes
SHIFT  + F8  = Publish the entire site
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TOWeb doesn't start or stays frozen

Using Windows 7/8/10/11

Important note when installing TOWeb

For Windows 10/11 users

Using Mac OS X

Site disappeared and TOWeb starts to create a new one

Using Windows 7/8/10/11

Important note when installing TOWeb

Since March 2024, Microsoft changed the way MS SmartScreen interacts with Application certificates, they no longer instantly remove
SmartScreen warnings. So, if, during the installation of TOWeb, Microsoft Defender SmartScreen indicates that it has blocked the
application from starting, click on the "More information" link to force the installation.

For Windows 10/11 users

Following an installation of TOWeb (including an update) your Windows 10/11 may no longer fully authorize the application without notifying
you. In such a case, this generally manifests itself in TOWeb with one or more issues like for instance:
- the application no longer starts or may even crash
- malfunctions in the use of the software with for example empty control areas or all grayed out preventing any modification of your site
- the publication of your site no longer works.
In the event of an anomaly of this type, you will need to (re)authorize TOWeb by following the Microsoft procedure explaining how to allow
TOWeb to access controlled folders of your Windows 10/11 system .

If some feature of TOWeb (like publishing on the Internet) are not working or TOWeb does not start at all then check all the following advice :

Verify first that you have installed the latest update of TOWeb and if your installation is corrupted then delete the temporary internet files of your

web browser before to download it again and proceed to a new installation

If TOWeb still doesn't start or if some Internet action are blocked (like for instance when publishing your website or trying to contact our support

from TOWeb) this is generally due to your Windows firewall and/or a Internet security software installed on your computer (Norton,

Kaspersky, ...) and/or your antivirus. You may try to temporary deactivate these security protections to determine which ones are not fully

authorizing TOWeb on your machine. For more information read the documentation of your security protection to find out how to reset the default

options and manually add TOWeb to the lists of exceptions. Under Windows 10 & 11 you need to do it from:

"Start  > Settings  > Privacy & security  > Virus & threat protection > Exclusions".

The "TOWeb.exe" file of TOWeb V14 to manually add and authorize on your computer is located in "C:\Program Files\Lauyan\TOWeb V14". After

TOWeb is reauthorized, reboot your computer before to restart TOWeb

Use the Microsoft Windows Update to download and install the latest updates available for your Windows version

Make sure not to store the data files of your site(s) into a cloud (such as Google Drive, Dropbox, iCloud or OneDrive). The data of your site(s) are

by default placed in the "My Documents\TOWeb Sites" folder of your computer but should not be moved in a synchronized folder as this could

cause TOWeb crashes and corrupt your site data.

For computer using Window 7, Windows 8, Windows 10 or Windows 11 you may check the following points too :
Right-click on your Computer icon located on your desktop (or accessible in a Windows Explorer window) and select the Advanced system
settings", then click on the "Performance settings" and select the data prevention option for Windows' programs and services only

Make sure TOWeb is running with correct access rights. Make a right-click on the TOWeb icon located in your Windows Desktop an from the menu

select "Run as administrator"

Verify that you turned off the user account control (UAC) from the control panel.

In order to identify the third-party software that may be causing this problem, start by temporarily disabling all your security software one by one and
then restart your computer before using TOWeb. If TOWeb (re)starts correctly after that, then reactivate your security systems one by one in order to
identify the responsible application(s) and then refer to the documentation and/or technical support of your antivirus or security software concerned. 
Important: simply disabling a security system such as an antivirus may sometimes not be enough if its installation has been wrongly considered
dangerous for your computer. In such a case, uninstalling your antivirus may be necessary and if TOWeb works correctly after doing that, then reinstall
your antivirus and authorize again the "TOWeb.exe" file of TOWeb.

On some computers, Windows 10 may be installed by default in S mode (like Security). This mode prevents any installation of software that is not
part of the Microsoft Store, which excludes many software such as TOWeb but also other browsers than Microsoft Edge (such as Chrome or Firefox)
and many free tools (touch-ups of images for example) useful for the realization of your websites.
To switch from "Windows 10 S" to "Full Windows 10" for free, do the following:

https://www.lauyan.com/en/internet-securities.html#rfa7dzrW
https://www.lauyan.com/en/internet-securities.html#D1JpGWsI
https://www.lauyan.com/en/internet-securities.html#windows-issues
https://www.lauyan.com/en/internet-securities.html#mac-issues
https://www.lauyan.com/en/internet-securities.html#AVmOTuRa
https://www.lauyan.com/en/internet-securities.html#rfa7dzrW
https://www.lauyan.com/en/internet-securities.html#D1JpGWsI
https://www.lauyan.com/en/internet-securities.html#windows-issues
https://support.microsoft.com/en-us/windows/allow-an-app-to-access-controlled-folders-b5b6627a-b008-2ca2-7931-7e51e912b034
https://www.lauyan.com/en/download-toweb.html


Click the Start Menu> Settings> Update & Security> Activation

Find the Switch to Windows 10 Home section, then select the Go to Store link

Once in the Microsoft Store, on the Cancel Switching to S Mode page, click the "Get" button.

You may also want to verify that the crash or blocking issue(s) you are experiencing are not caused by Windows Defender by doing the following:
open Windows Defender

go to "Protection against viruses and threats"

click on "Protection against RanSomeWare"

click on "Manage protection against RanSomeWare" and deactivate this function

then restart the computer to verify that TOWeb now works correctly.

Using Mac OS X

Resolving the "TOWeb V14.App is damaged and cannot be opened" issue on macOS

If, when starting TOWeb V14 on macOS you see the following message: "TOWeb V14.App is damaged and cannot be opened", then follow these
steps to resolve the issue.

Step 1: Open the Terminal

1. Click on the Spotlight icon (magnifying glass in the top-right corner of your screen) or press Command ⌘  + Space .

2. Type Terminal in the search bar.

3. Click on the Terminal application in the search results.

Step 2: Run the command to authorize the application

1. Once the Terminal is open, copy the following command to your clipboard:

xattr -dr com.apple.quarantine "/Applications/TOWeb V14.app"

2. And "Paste" this command into the Terminal (right-click > Paste or Command ⌘  + V ).

3. Then press the Enter key to validate the command.

Step 3: Launch TOWeb

1. Close the Terminal.

2. Open the Applications folder via Finder.

3. Double-click on TOWeb V14 to launch it.

TOWeb should now start normally.

Other important notes and advice for Mac users

As TOWeb is not available on the Apple AppStore but only from our site, its installation may require manual authorization from you. If Apple refuses to
download the TOWeb installation file on your computer, then click on the icon located in your Mac menu to open your "System Settings". Then in
"Privacy and Security", scroll down the contents of the right window to the line "allow applications from" and if the line "TOWeb V14 has been blocked
to protect your Mac" appears then click on "allow anyway".

If TOWeb does not start or if you seen a security message about an "unidentified developer" then, do a right-click on the TOWeb icon (located in
your Applications folder) and select "Open" from the contextual menu. This will force TOWeb to open correctly without displaying any
alert thereafter.

Compatibility:

TOWeb V14 and V13 requires at least MacOS 13 (Ventura) 

TOWeb V7-V12 require at least MacOS 10.9 (Mavericks) and works with MacOS 10.15 (Catalina) for versions 8.10 and 7.24

TOWeb V5 and V6 are compatible with MacOS X from version 10.6 (Snow Leopard) to version 10.14 (Mojave) but are not compatible with MacOS

10.15 (Catalina)

TOWeb is designed to work with data located locally in the "Documents" directory of your computer but not will not work correctly (if at all) if you
place them elsewhere, especially on a network drive such as OneDrive, Dropbox or your iCloud Drive. To turn off syncing on your iCloud Drive, follow
these steps:

From your Mac, choose "Apple menu > System Preferences". Click "Apple ID", then click "iCloud". On macOS Mojave or earlier, choose "Apple

menu > System Preferences", then click "iCloud".

Next to iCloud Drive, click Options.

Deselect Desktop & Documents Folders, and click Done.

 
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Then once this disconnection is made, your local directory does not contain what you had on the iCloud Drive, you will need manually copy the

"TOWeb Sites" directory from iCloud Drive to your "Documents" directory in order to retrieve the latest version of your site (or your sites if you

have several).

If TOWeb still can not start then try to disable SIP by doing the following:
Restart your computer in Recovery mode by pressing the ⌘ et R keys

Launch Terminal from the Utilities menu.

Run the command: csrutil disable

Restart your computer

Site disappeared and TOWeb starts to create a new one

By default TOWeb stores all your sites data into the "My Documents" directory of the current Windows user. If at the start of TOWeb you can not find
your sites and/or if TOWeb starts by asking you to create a new site then it can come from any of the following causes :

You have changed your computer. In this case it is normal that you can not find data from your sites as they are in the folder "My Documents" of

your old computer. To have them back present on your new computer you need a backup and follow the restore procedure.

You are logged on Windows under a different user account than the one you used when you created your site. As the "My Documents" directory is

personal to each Windows user account you must log into Windows using your previous user account to have access to your data.

A security software (like an Antivirus for example) may no longer allow TOWeb the access your folder "My Documents".

You or any third party software have changed the location of the "My Documents" directory. Again security software or system tools may be

involved, so check out this point by following the above procedure (disabling software one by one until you identify the one causing trouble).

As a last resort, if none of the solutions proposed above does not work, open a Windows file explorer to search for multiples "TOWeb Sites" directories
on your hard drive and there after use the browse button to open your site. Finally you may also consider at last to restore a backup .
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Backups & Transfers

Backups

Restore

I-Service Data of your Web space

TOWeb Portable

Backups

Data of your website are stored on your hard drive each time you use the Save button (  ) but in addition to that It's very important to regularly
backup your website because in case of data loss on your computer (crash disk, viruses, errors, ...) you won't be able to restart your website just
from the generated web pages published on the internet but only from a WGA backup file.

To create a WGA backup file you need to go to the "File" step (  ) of TOWeb and click on the Backup link. Then enter the name of your backup

file and any additional comment about your website version. You have the choice to let TOWeb save your backup file to its local folder or to any other
location. We strongly recommend you to save your backup file manually on a different disk than your hard drive (like for instance a external USB drive
or on CD) in case of a crash disk.
The backup files of TOWeb are of course compatible with all environments allowing for example transfer of your website  from a Windows machine to a
Mac using a backup / restore functions.

Restore

From the TOWeb's file step, click on the link named Restore located on the left side. In the "Restore a backup" screen you will be able to restore a
backup from a CD, an USB key or another directory or choose to restore a local backup appearing in the list of local backups. Then proceed to the
restore either as a new website or over the one you currently opened.
IMPORTANT : if you restore a backup over the site currently opened this will replace all your current site. So before to restore a site, make sure that
you don't want anymore you current site opened as it totally and permanently be deleted and replaced by the backup one.
For more information see also how to reinstall TOWeb .

I-Service Data of your Web space

Why and when saving the i-Services data ?
Some i-Services of tour web site can record data directly on your web space such as visitors' comments added to your website pages with the User
comments i-Service. The data information added by your visitors are only present in your web space, which means that in case of technical problems
or a change of host provider these information will be lost unless you've previously saved them.
TOWeb automatically backups and recovers data on your i-Services on your web space every time you are publishing your site or making a complete
backup of your site but you can also retrieve these data at any time by clicking the button: Backup my i-Services data located in Setting > i-Services
step.
You can backup your i-services data as often as possible in order to always hold the latest information of your visitors on your computer and be able to
restore them if it should ever be necessary.

Why and when to restore the i-Services data ?
Restoring data from your i-Services will erase all data on your web space you previously saved and kept on your computer. This substitution or
deletion of your visitors' data is generally not desirable as this operation is irreversible. The 2 cases where you may need to restore data i-services on
your website are :
if you have changed your host provider and want to transfer to your new hosting space the visitors data you had on your former host space
if for any reason your i-Services were lost or damaged on your hosting space like for example after a disk crash on the provider server or a mistake on
your part resulting in the deletion of files to your web space.

TOWeb Portable

TOWeb portable feature located in "File" step (  ) is not a backup but a way to work on your website(s) if you have a laptop computer by

transferring TOWeb and you site(s) on through a USB key or a mapped drive and synchronize back everything later on your desktop computer when
done with your laptop. Your laptop or computer must have a Microsoft Windows operating system to be able to run and use TOWeb portable on a USB
drive.

Advice: before any transfer and use of the "TOWeb portable" functions from your desktop computer to your laptop (or vice versa), we advise you to
make a backup of your sites' data using the "File > Backup" function in order to be able to restore them later in the event of problems or user
manipulation errors.
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Using Versioning in TOWeb

Enabling and Using Versioning in TOWeb

Use Cases

Step-by-Step Example: Working on Two Versions of Your Site with Versioning

Impact of Versioning on Site Backup/Restore

The versioning feature introduced in version 13 of TOWeb under Files > Versioning ( CTRL  + G ) allows you to create and manage multiple
versions of your website within a single project without having to merge modifications. Unlike using backup/restore or creating separate sites,
versioning offers several significant advantages:

Centralized Management: All versions of your website are contained within a single project, making it easier to manage and organize your

modifications and evolutions. There's no need to juggle between multiple backup files or separate projects.

Time Saving: Creating versions is quick and simple. You can instantly create a new version, make modifications, and switch between versions

without having to restore backups or duplicate an entire site.

Easier Comparison: You can easily compare the different versions of your site, preview changes, and even revert to a previous version with a

single click, without affecting the live version.

Reduced Risk of Errors: By using a single site with multiple versions, you reduce the risk of losing modifications or confusing different versions

during restorations or site duplications.

Enabling and Using Versioning in TOWeb

The versioning feature is managed under Files > Versioning ( CTRL  + G ) in TOWeb.

1. Enable Versioning on the Site

Enabling versioning on your site allows you to manage multiple versions of your website directly in TOWeb. When you enable this feature, TOWeb
automatically creates an initial version named "version-1", which corresponds to the current state of your site. This version becomes the starting point
for managing your different versions. It is recommended to immediately rename "version-1" to better identify its role, such as "production", for
example.

All modifications made in TOWeb are applied and saved to the active version.

2. Add a Version

Adding a new version allows you to create a copy of the active version of the site to make modifications or improvements. Before adding a new
version, make sure to activate the version that will serve as the starting point. The new version created will be an exact copy of the active
version at the time of creation, allowing you to test or prepare modifications without affecting the live site.

3. Activate a Version

Activating a version means replacing the current site content with that of the selected version. This action switches the entire site to the state of
the chosen version, making it visible and active for site visitors. Use this action with caution, especially in production, to avoid displaying
unfinished or untested modifications.
You cannot change the active version while there are ongoing modifications: you must either save them or cancel them with the "Undo" (   ) function
introduced in TOWeb 12.

4. Rename a Version

Renaming a version allows you to modify the name of the selected version without any impact on the site content or state. The active version
remains unchanged, only the version label is modified. This helps you better identify the different versions of your site, such
as "production", "development", or "archive". This action is particularly useful for organizing and clarifying the management of your versions.

5. Delete a Version

Deleting a version permanently removes the selected version from TOWeb. This action is not reversible, so be sure you want to delete the version.
It is impossible to delete the currently active version. If you wish to delete the active version, you must first activate another version and then
delete the old version. This action is useful for freeing up space when the number of versions is limited by your license.

6. Disable Versioning on the Site

Disabling versioning deletes all existing versions of the site except the active version. The currently active version will be preserved, but all
other versions will be permanently lost. Before disabling versioning, make sure that the version you want to keep is active, as there will be no
way to recover the other versions after this operation. This action should be used with caution, especially if you want to revert to simpler site
management without versioning.

Use Cases

Here are some examples of how to take full advantage of this feature:


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1. Create Versions for Seasonal Events or Promotions

You can create a new version of your site dedicated to specific events, such as Christmas, sales, or temporary promotions. This allows you to prepare
appropriate content while keeping the main version intact.

Example:

Main version: "site-official"

Event version: "site-christmas" with graphics and content specific to the holiday season.

2. Prepare the Next Major Version of Your Site

Work on a new version of your site (redesign, adding new features) without affecting the live version. This way, you can test and preview changes
before they go live.

Example:

Current version: "site-v1" (live)

New version: "site-v2" (with new design, new sections, etc.)

3. Create Versions for Tests or Experiments

Create versions of your site to test specific modifications, such as adding new sections or changing the theme. This allows you to experiment without
risking your main version.

Example:

Main version: "site-official"

Test version: "site-test-theme" to try out a new theme.

4. Manage Versions for Different Languages

Create a distinct version of your site for each language, simplifying translation management and ensuring each version is independent.

Example:

French version: "site-fr"

English version: "site-en"

Spanish version: "site-es"

5. Create a "Restore Point" Before Major Changes

Before making major changes to your site, create a backup version. This way, you can easily revert to the previous version if needed.

Example:

Main version: "site-official"

Backup version: "site-official-backup"

6. Manage Multiple Projects or Clients

For users who manage multiple websites or projects from a single site model, each version can represent a separate project, allowing you to keep all
your work organized.

Example:

Client A version: "site-client-A"

Client B version: "site-client-B"

7. Archive Old Versions of Your Site

Create archived versions of your site at different times to keep a history. This way, you can view or restore an old version if necessary.

Example:

"site-2023-Q1": archived version of the first quarter of 2023

"site-2023-Q2": archived version of the second quarter of 2023

8. Experiment with New Ideas or Concepts

Create separate versions to test new ideas, such as a new layout or adding an online store. Easily compare these experimental versions with your
main version.

Example:

Main version: "site-official"

Experimental version: "site-experiment-1" (testing new concepts)



9. Create Region-Specific Versions

Create versions of your site tailored to different regions, with content customized for the target audience.

Example:

Europe version: "site-europe"

USA version: "site-usa"

10. Create Tutorials or Demonstrations

Create versions dedicated to demonstrations or tutorials without affecting the main version of your site.

Example:

Tutorial version: "site-demo"

Main version: "site-official"

Step-by-Step Example: Working on Two Versions of Your Site with Versioning

You want to manage two versions of your site: a live production version and a development version for preparing future updates. If you have a TOWeb
license that does not offer unlimited versions (STUDIO version), we will illustrate this example by rotating between only 2 versions to work efficiently
on your site.

When you enable versioning for the first time, TOWeb automatically creates an initial version called "version-1". This is the current version of your
site, which becomes the production version.

Select "version-1" and rename it to "production" to clearly identify that it is the live version.

Add a new version to start working on the future modifications of your site. Name this new version "development" or "future-version".

Activate the "development" version to make the necessary modifications. All changes you make will be saved in this version, while
the "production" version remains unchanged and visible to your site visitors.

Once the modifications are complete and ready to go live, you need to replace the current "production" version with the "development" version.

First, activate the "production" version. This prepares it to be modified or replaced.

Delete the current "production" version to free up space, as your license only allows two versions. Warning: Make sure that all necessary
changes are ready in the "development" version before deleting the current production version.

Rename the "development" version to "production" to indicate that it is now the official live version.

Add a new version based on the new "production" version you just created. Name it, for example, "new-updates" to prepare for future changes.
You now return to the initial configuration, with a "production" version and a "development" version.

With this workflow, you can always maintain your site in production while preparing future updates. You can repeat these steps whenever you want to
update your site without disrupting the version visible to your visitors.

If you have a STUDIO license with unlimited versions, you can adapt this example to keep/archive as many versions as you need.
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Impact of Versioning on Site Backup/Restore

Free TOWeb License

Versioning is not available in the free version of TOWeb.

PREMIUM and e-COMMERCE Licenses

You can create a maximum of 3 versions per site/project. This allows you to handle most of the scenarios mentioned above, and notably to work

by rotating between a production version and a future version of your site, for example named "production" and "future".

Site backups and restores systematically include versioning information for your sites.

STUDIO License

The number of versions is unlimited.

Two additional options are available for backup/restore for sites with versioning enabled:

1. Backup Only the Active Version: When creating a backup (WGA file) of a site with versioning enabled, a checkbox allows you to choose to
back up only the active version of the site. This option generates a standard WGA that excludes versioning-related files and folders. This
is a very partial backup (only one version) that should only be used in specific cases, for example if you are creating sites for third parties and
want to send them a backup of their site without including versioning information.

2. Restore a Site in the Active Version Only: When restoring a WGA file, a checkbox allows you to restore its content only in the active version
of the site, without overwriting or deleting other existing versions. This option excludes any versioning files and folders present in the restored
WGA file, to preserve the existing versions in the target site and limit the restoration to the active version only. With this option, you
can aggregate previously separate sites into a single project. For example, if you had three variants A, B, and C of the same site managed
separately, enable versioning on site A, rename "version-1" to "site-A", and create versions "site-B" and "site-C", then restore the WGAs of sites
B and C. You now have a single project with three versions/variants of your site, which is much more convenient.
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Navigation & Structure of your website

Text Links & Buttons

Bookmarks

Protection of email addresses

Links on Pictures

Menu of your website

Mega menus

Additional links to the main menu of your site

Footer, Fatfooter or Sidebar as a menu alternative

Publicize the web addresses of your paragraphs

Articles

Groups of topics

Topics with no navigation

Back to top button

Social Network Buttons

Local menu of a Topic

Text Links & Buttons

When editing a text use the link button (  ) to create a link inside a button or just a text link by selecting the "Link style". A link can be one the
following type :

a link to another website : where you need to enter the URL (http:// or https//:)

a link to email address : this will open the mail software of your visitors if any mail software installed

a link to topic of your site that can go to the start of the page, a specific paragraph, a specific picture (if your topic is an album) or a specific

product (if your topic is a catalog)

a link to a file : using this function your file will come available for download by this link for any of your visitors. All download links from

your site are using a script that directly saves the downloaded files in the download folder users' computer. You can also have statistics on the

number of downloads of your files (Options> i-Services> Download Counters). If you wish that your download links do not behave like this but

instead directly opens the file into the user's web browser or in side another software (if the user has one on his/her computer that can open the

types of files you propose on your site), then you just need to disable the i-service file download from step "Options > i-Services". For more

information on how to create a link to file please watch the video tutorial : create a file download link

a link to a phone number so that a visitor using a smartphone can directly dial the number by clicking on it.

an SMS link allowing mobile users to reach you directly by SMS with a simple click . You can also enter any predefined message like for instance

"Request about product information X" by placing such SMS link into your product page X

Whenever you create a link you can define the relation between the targeted page and the page where your link is placed. The most commonly used
values, as exploited by internet search engines such as Google for SEO of your site are:

next : indicates your current page is a subset of a document/topic/article and that target link is the next part

prev : indicates your current page is a subset of a document/topic/article and that the target link is the previous part

nofollow : indicates that you (the author of the site or topic) do not condone the content of the targeted link. By assigning the value "nofollow"

to the property "rel" of a link, you are telling the search engines like Google not to follow certain links on your site or not forward the popularity of

your page to this other linked page/site in order not to be associated with this site and/or you do not condone any possible remarks or contents

of this third-party site that you specify in your link (for example because this site may be a spam site or disreputable and you do not to be

associated to that). The "nofollow" relation is automatically and obligatorily applied to a link when it points to a page that you have indicated as

not to be referenced by search engines (but also to some internal pages of your site such as for example your terms of sale)

author : a link to the author of the current topic or document

By default your link appears automatically for all users, but depending on your needs you can specify whether you want it to be visible only on mobile
devices (eg. smartphones and tablets) or, conversely, never seen on mobile.

Note : to add a new line after a link and especially a link place inside a button just move the cursor after the last character of your text (but still inside
the button) and type a character like for instance a space key to get "out" of the link (button) and then press the Enter key to create a new line. On the
opposite if you want to add a new line before a button link move the cursor just before the first character of your text link (but still inside the button)
and press the space key.

Bookmarks

A bookmark is a name (generally a short text) to directly access a paragraph inside a page. By giving a bookmark with an appropriate name and
meaning related to the content of the paragraph, this will allow users (and you too) to remember more easily the URLs of the most important parts of
your site and this may also contribute to a better referencing of your pages at the level of the search engines.
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By default, TOWeb assigns a random alphanumeric bookmark name to a paragraph. You can leave like that or change it by clicking on the icon (  )
accessible from the "paragraph layout" options of each paragraph but also available when adding a new paragraph. The name of the bookmark you
assign to a paragraph must be unique per page (no duplicate allowed).
It is particularly advisable to specify a bookmark name in the following cases:

when you use a local menu in your topic or additional links to the main menu of your site

when you want to communicate to people (for example by email) a direct link to a specific paragraph of a page of your site. Assuming, for

example, that you have a site www.mywebsite.com and that you set a bookmark "services" to a paragraph of a page named "prices.html" then

the direct address to this paragraph you need communicate will be this one: 

https://www.mywebsite.com/prices.html#services

when your paragraph does not necessarily have a title and adding a short additional text as a bookmark will provide more sense and help search

engines such as Google to better under its content.

An option to display link buttons with bookmarks when hovering over the title of a paragraph so that your visitors can know and keep the precise web
address of a paragraph of a page that interests them .

Protection of email addresses

Spam robots analyze the content of sites looking for email addresses and mainly those contained in your links more reliable than anywhere else.
TOWeb protects and encrypts the href links of your addresses to make them unusable by spam robots and other search engines.
However, if you enter your email address also in the text of the link (i.e. its label) or even as plain text inside a paragraph, this text will be readable,
unprotected and exploitable by all. To reinforce your protection against spam, you may then want to follow our important advice and remarks:

in an email link, you may prefer the use of a text link such as "Contact Me " rather than re-enter your email address in plain or possibly indicate

the text of a "falsified" email address which will remain humanly intelligible like for example by adding additional space characters: c o n t a c t @

y o u r s i t e . c o m  

or use not  just 1 email link but 2 email links placed next to each other. This way you will have 2 links having the same (protected) email address

but using different texts: the first link containing just the first part "contact" of your address, the second link with the text "yoursite.com" but also

using the @ icon (and no longer the "@" character). This icon can be added from the button (   ) located in the TOWeb link window and it can

be placed to the left or to the right of the link text, as for instance here on the left of this example: contact yoursite.com

or prefer the use of a contact form protected by captcha . This way you will keep your email address completely secret from everyone (it will only

be known to users or robots if you reply to messages sent from on your website's forms)

and if you enter your email address not in a link but inside a paragraph text then use the button (   ) located in the edit bar to add the @ icon

(available in the list of symbols proposed by TOWeb) in order to replace the @ character.

Finally, there is no absolute protection over time against spam robots, some may even go so far as to analyze the content of images of your site
looking for email addresses sometimes displayed inside them. But to make this risk "almost zero", the best practice is to display as little as possible
your email address in plain text on your site (nor even not at all, including in images) because if a human can read it then a robot will also be able to
do it someday...

Links on Pictures

If you have added a picture into a paragraph, from the TOWeb sidebar select link from the click action list

Menu of your website

The edit menu button (  ) located in the top toolbar opens a window from where you will be able to organize your topics and your website menu.
The list one the left side is the one of the topics that will appears in your menu. The list on the right side the topics that will not be displayed in your
menu. A topic not displayed in your menu does not means it doesn't nor wont be accessible. In fact this topic will exist and be published but you will
need to add links on it somewhere else inside your web pages the access to make it accessible by visitors.
You can change the order of your topics in the list or move them from one list to the other by drag'n drop and/or by using the move up/down
arrows and hide/show buttons.
To create a submenu in your menu use the "Add submenu" button and then drag'n drop the desired topics into it.
Finally if you have multiple sections that link between it and dealing with the same subject then you can group them into groups of topics or articles .
As for customizing the display of your menu it must be made from step "Theme" by clicking in the preview of your menu to access its styles
properties, but also:

to set the folding behavior of the menu based on the screen width (especially for smartphones/tablets) with the ability to eventually let it always

or never folded

to present a folded menu either as a text or an icon

to automatically open submenus mouseover without the visitor having to click

Mega menus

A mega menu allows you to display an image with a title and text, as well as lists of links presented in different columns. Adding and modifying a
mega menu is done from the main menu management window of your site, now accessible at any time via the shortcut CTRL  + M .
You can define a first column (optional) containing a presentation (i.e., title + image + text) followed by lists of links in columns. Each column can be
given a name representing its category (for example brand or type if containing links to products).
The display styles of mega menus are customizable in the CSS editor under the "Menu" tab, allowing you to customize the main colors, column widths,
and spacing.
You can have multiple mega menus on your site.


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Additional links to the main menu of your site

Since TOWeb V7 it is possible to add additional links in the menu of your site, links pointing directly to paragraphs of a topic by activating the option
"Additional links" (option only available for topics of "Page" type, this does not apply to albums or catalogs). By choosing this you can activate or
deactivate the additional direct links to the paragraphs of your choice to make them appear or not in the general menu of your site among all the other
links. A double-click on the names in the list of the paragraphs will allow you to edit them and changes the default names given by TOWeb. Also
remember to assign bookmark names at the paragraph level to which you put links in order for your URLs to appear clearly in web browsers.

Using additional links can be particularly useful:

if you want to create a single-page website (a page that can have a fairly long content) but still have a menu to directly access the main sections

of your page

if you have a website with few topics and want the navigation to be done mainly thru your home page (by adding by yourself buttons/links to

other pages)

Note: if you want to do a single-page site (or have a home page that gives your site the looks of a single-page site), you may also consider the
solution of using a local menu on your topic.

Footer, Fatfooter or Sidebar as a menu alternative

Menu of your website will only have a one level of submenus. If you need more you might consider either :

to use a sidebar and add panels (  ) on it that a specific topic will contained links buttons to other topics (not visible in your menu). This way

you sidebar will become a submenu specific to your topic.

to add a list of links inside your footer or fat footer. These will be visible on every pages of your website (like your menu) but at the end of

every web pages. You can then use the footer and/or fatfooter as another way to present your menu or a complementary way by placing for

example the most important topic in your menu and the less important ones in the footer or fatfooter.

to add articles or groups of topics to your menu.

Publicize the web addresses of your paragraphs

Websites visitors may sometimes be more interested in a specific paragraph on a page than the rest of it. In order to help your visitors know and keep
the direct link to some paragraphs and thus be able to quickly return to what interest them by using the option located in: Options > Website
navigation > Button "Paragraph link".
By using this option, a link button (   ) will appear when hovering over the paragraph titles of all your website pages. Your visitors will therefore only
have to click on this button to either copy to their clipboard or display the complete address of the paragraph (including its bookmark ) in their web
browser in order to keep it or add it to their favorites.
If you wish, you may also deactivate this feature only for certain topics of your site by unchecking the option "Show the paragraphs' link button"
located in the topic options. 

Articles

An "article" in TOWeb is a set of pages that are ordered and linked by a navigation system. TOWeb offers several automated navigation systems that
can be used in the pages of an article: a navigation summary with a list of links, a drop down list of the pages or a simple page navigation thru
previous & next buttons. The navigation system of your choice can be placed at the beginning of each page and/or can be placed at the end of each
page if you like too. The creation of an article can be done manually from your menu management window by drag & drop of your pages inside your
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article or take them out or change their order. An can also be created using the TOWeb assistant accessible from the button (  ) "create a new
topic". In TOWeb, when editing a topic that is part an article, a toolbar appears over the navigation system to allow you to edit or delete the article but
also directly add a new page into your article or perform a complete or partial removal of your article directly from there.

Groups of topics

A group (or group of topics) is a front page automatically created by TOWeb containing a brief summary of all the desired topics with links to them.

A group can be created and modified manually from the menu of your management window by performing drag'n drop of your topics to add or remove
or change them into the group. Add a group can also be carried out in an assisted way from the button (  ) "add a new topic".

A group (with customizable text) can help you quickly create web pages of type "portal" thus preventing you from having to create all the links
yourself, helping you to have a basic content (images & texts) already pre-filled to present your topics and prevent you from having to manage their
invisibility in the site menu (as topics part of a group will not be directly displayed in the menu of your site). Only the name of the group of topics
appears, which can help you to reduce and simplify your menu if it ever become too important.

From version 11, the possibility of using dates, authors and keywords but also more presentation options allows you to create portal sections for
blogging as well as filtering their content.

Topics with no navigation

This option, located in the settings of each topic, you can view the contents of your entry without any navigation elements of your site (no menu, no
search box, no footer). This function can be used for example in case you want to create a front page with a navigation only restricted to the links you
have placed into the paragraphs of this topic or if you wish to create an agreement/introduction page of your site .

Back to top button

Enabled by default on your site, this button is automatically displayed superimposed in the lower right corner when the user performs a significant
scroll down inside a page of your site, enabling him/her to quickly return to the beginning of page and the menu of your site. You can disable or enable
this function on your site from the step "Options > Site Navigation" and customize its options (the trigger level, the selection of the button icon and its
size).

Remark: the style of the "go back to top" button that you choose will also be the same as the one allowing to "scroll down" when using a local menu on
a topic and if the first paragraph of this topic also has the "full height" option activated. In addition, if you disable the display of the "go back to top"
button on your site then you will also automatically disable all buttons to scroll down (and vice versa if you activate it).

Tip: For the triggering threshold, it is advisable to set it to a value that corresponds to the height where the content of your topics start. In such a way
when the user will scroll down on your page, as soon as the menu of your website becomes no longer be visible, this button will be displayed.

Social Network Buttons

TOWeb provides 2 types of social network buttons

the ones displayed on every pages of your website located in your Theme

the ones that can be placed on paragraphs of your topics using the "Social buttons" located in "topic settings". By activating this option or

clicking on its "configure" link, you will be asked to configure them.
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IMPORTANT : Social media buttons will only display and/or function properly for your visitors if they accept cookies both in their web browser and
in your site's cookie consent. In addition, concerning the "Facebook Like" button, this button also requires your visitors to be connected to their
Facebook account before visiting your pages in order to be able to see and use the "Like" button.      

Note: using the %TW-SHARE% predefined field allows you to add your social buttons in a specific paragraph of your topic rather than at the end of the
page.

Local menu of a Topic

A local menu is a menu only containing links pointing to the paragraphs it contains. Applying a local menu to a topic implies not using either the site
theme nor the main menu of your site. That's why in the options of a topic, you will have to activate the 2 options "No navigation" and "No theme" to
be able to use and configure it. The links to the paragraphs of your pages will appear next to the title of your page in a local menu bar with
customizable styles (differently and more basic compared to the possibility of the CSS editor for a site main menu, but easier to handle and configure)
.
Apart from the styles that apply to the paragraph content of a page, the only theme element that can be preserved in a page using a local menu is the
page footer (unless you check the "No footer" option). Keeping the footer can be useful if you want to be able to place on it for example links to other
of your topics or if you want to be able to display certain elements of your theme (such as social buttons, the search field of the site, links to the
different languages of your site, ...) provided of course to have moved these elements into the footer of your theme (if not already there).

Using a pop-up menu can be particularly useful:

if you want to create a single-page website (a page that can have a fairly long content) but still want a menu to directly access the main sections

of your page

if you have a homepage with a style completely different to the rest of your site

if you are not comfortable yet to use or customize your theme as you want from the CSS editor and prefer not necessarily to respect a very strict

and same presentation for all your pages but have some with their own styles (based on background images for example) or with a "page by

page" navigation using your own links / buttons instead of a menu

Note 1: If you want to do a single-page site, you may also consider the option of adding additional links to your site's menu. The 2 methods bring their

options and advantages, the main difference being that the additional local links will use the main menu and the theme of your site in its entirety while

the solution of a local menu will not use any global menu, or any borders, images, header of your theme.

Note 2: You can use a local menu without leaving any links to it. The title of your topic will then be alone and displayed in the local menu bar, with still

all it different options to configure it (choice of a background color with or without transparency, border with shadow, ...).
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Topics & Page content

Add a new topic

Add a paragraph

Add a sidebar panel

Paragraph display

Paragraph layout

Paragraphs in Tabs

Folding & Unfolding of paragraphs

Timestamping of paragraphs

Background Video & Image, Parallax Effects and Full Screen Height

User interface tips when editing Topics

Save as PDF

Add a new topic

By clicking on the Add a new topic button (  ) you can add different types of topics to your web site :

web pages (  ): when creating a page TOWeb proposes to start with a basic presentation in which you can select the number of paragraph to

start with as well as the number of panels in the sidebar. If you have images you can add them by checking the "use picture" option and they will

be automatically added (1 picture per paragraph)

Articles (  ) : sets of pages with a system of navigation links between them

Albums (  ) that you can directly start adding them to a list

Catalogs of products for sale (  ) that you can start either by providing a list of pictures (1 picture = 1 product) or from an XML or CSV

products database or just from scratch

Collection of web pages or items (  ) that will contain a navigation bar and page indexes to navigate among your pages or items

Groups (  ) : automated front pages containing a brief description and links to introduce several topics

Calendars to manage your events (events that can be linked to your topics)

Site introduction/agreement page (  ) : a page where all new visitors will be redirected to when accessing your site for the first time

To create a new topic you need to enter the short name that will identify your topic (name displayed in your list of topics) and will be the text link used
in your website menu to access your topic.

Add a paragraph

Use the Add a paragraph button (  ) from either the top left toolbar or using a right-click on your page to display the context menu. TOWeb will
propose you to start your paragraph with a title, a text, a background video/image/color, or one of the numerous additional object proposed by TOWeb
as well as end your paragraph with a link button if you want too. Once added just make a double-click on it to edit and modify its content using the
classic editor toolbar buttons (bold, italic, text colors, bullets, text alignment, ...).
If you want to display paragraphs in columns just change adjust their width and they automatically be displayed side by side (if your screen width
is large enough otherwise they will be displayed to you as they will appears in mobile devices). And you want to center a paragraph change both its
width and its offset.
With a right-click on your paragraph you may also move your paragraph before / after the other ones, duplicate it inside your topic (or another
topic), add or replace an object into it (a form, a picture, a video, ...) or delete it.

For more information see also how to :

Add pictures or multimedia object

Add links & buttons

Add a web form

You also have the possibility to export & import a paragraph. The "export" function is accessible from the "Edit" contextual menu of a paragraph. And
the function "import" can be used when adding a new paragraph or new side panel.
The export and import of paragraphs can be useful especially in the following cases:

if you have multiple websites and want to be able to transfer content from one to the other

if you want to copy / transfer a paragraph to a side panel (or vice versa)

if you want to delete a page but keep aside a few paragraphs in order to import them back later

if you want to build a base of several paragraphs to go faster when creating pages by reusing classic things you usually do (and this without

having to search in your site the paragraph(s) to duplicate neither to necessarily have to duplicate a whole topic)
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Add a sidebar panel

Use the Add a sidebar panel button (  ) from either the top left toolbar or using a right-click on an existing panel to display the context menu. A
panel is a small paragraph placed inside a sidebar of your page behave like a paragraph except that you can not adjust its width nor aligned them side
by side (all panels are displayed in the same column)

As a paragraph you can modify the content of a panel by double-clicking on it and from a right-click you can access to functions such as delete or add
another panel to your sidebar.

See also how to :

Add pictures or multimedia objects

Add links & buttons

Paragraph display

From the "Topics" step, when you select a paragraph in a topic, you have the possibility to change the "Display" property of your paragraph. Several
choices are then proposed:

 Visible : your paragraph will appear normally and will be visible to everyone (users visiting you page as well as Internet search engines).

 Not published : paragraph will not be published. This choice can be very useful in different situations, for example if have a paragraph on

one-off promotions or other events that happen only once a year. The choice of a paragraph "not published" can be used then if you do not want

to make it public now, this without having to delete your paragraph and recreate it later on when needed. This choice may also help you to

prepare some new content inside existing topics of your site and continue to publish your topics without paragraphs when they are not finalized

yet.

 Hidden : your paragraph will not be displayed by web browsers but its content will still be present accessible and visible in the source code of

your web page and also potentially usable by Internet search engines.

When you choose either "Not published" or "Hidden", your paragraph appears with a shaded effect inside TOWeb to remind you that it will not be seen
by your visitors.

 Display with animation effect : a paragraph effect (slide, zoom, flip, fade, ...) will display your paragraph with a short animation during its

first appearance.

By default an animation is done only once during the first appearance of the paragraph (meaning that if you to view again the animation you

will need to reload the page). If you prefer all the paragraph animations of a topic to be displayed not once but each time a page scroll down

is made then you will need to uncheck the option "Show paragraph animations once" located in the options of your topic.

If you use any paragraph animation effects on your site then it is desirable to disable these animations for all smartphone users .

The appearance effects of paragraphs can bring more dynamism and modernity to your pages but it is advisable to use these effects

sparingly in your site so that visitors are not too destabilized by too many animations and/or less focus in reading your content.

Paragraph layout

By default a paragraph occupies the full page width available and this full width in TOWeb is 12 units. Therefore, if you want to obtain a paragraph
occupying half a page you will have to set its property "width" to 6. And if you want to center it you will have to apply its "Offset" to 3 (because
3+6+3=12).
Furthermore, by reducing the width of several consecutive paragraphs, you can align them together. The total width of your paragraphs must therefore
be 12 units to fill a complete line, like for instance : 3 paragraphs of width 4 (= 12), 2 paragraphs of width 6 (= 12), 4 paragraphs of width 3 (= 12), 1
paragraph of width 6 and 2 paragraphs of width 3 (= 12), etc ... For more information please watch the "Paragraph layout" video tutorial on our
YouTube channel .

With or without spacing between your paragraphs

By default your paragraphs are aligned with a spacing for better reading of each column. Nevertheless, depending on their content and/or their
formatting (especially if you have set different background colors) and/or presentation desired, it may be desirable to display them next to each other
without any spacing thanks to the option "No margin". Using this option not only applies no margin to the selected current paragraph but also do the
same to all other paragraphs before and after it, as long as they are not in full page width.
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With margin

Without margin

If you do not want to propagate the effect "no margin" but only apply it to the selected paragraph, you will have to hold down the CTRL  key when
clicking on this option.
Note: Mixing paragraphs with and without margins will not give correct alignments. If you want to keep several paragraphs correctly juxtaposed on the
same line, they must all the same, that is to say either all with margin, or all without margin.

Paragraphs aside background images

You can choose the positioning of the content of each paragraph background image by using the "Position" button located next to the green "New!"
label in the screenshot below where you can also see an example of 2 paragraphs using this feature.
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In addition to the positioning parameters (left or right, margins and width of your choice) you may need to adjust the level of transparency as well as
the background color to make sure your texts over your backgrounds always remain readable.

Paragraphs in Tabs

Ideal for reducing page length and improving the readability of essential information compared to secondary information (such as product technical
specifications).
Tabling (and removing) paragraphs is done via the new icon located among the paragraph layout properties, next to the two arrows for moving a
paragraph.
The paragraph navigation keys allow you to change the order of the tabs, but not to remove a paragraph from the tabs (for that, you will need to use
the "remove paragraph from tab" button). Conversely, if a paragraph is before or after tabs, the navigation keys will not move it into a new tab, but
rather place it before or after the tabs that follow or precede it.
Each tab must have a name and can also have a title (the paragraph title).

Folding & Unfolding of paragraphs

If you want paragraphs of a page to be folded by default (ie. all their content hidden) and be simply unfold by clicking on their title, then you will need
to activate the Allow the folding/unfolding of paragraphs option of your topic from the "Topics" step.
The "configure" button offers a choice of behaviors between "Allow the folding/unfolding of paragraphs" or "Automatically fold all paragraphs except
the last unfolded".
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By default, paragraph folding/unfolding applies to all paragraphs of a topic (except its sidebar panels if any), but by selecting a paragraph (or a sidebar
panel) it is possible to activate (  ) or deactivate (  ) its folding behavior by using the appropriate button located in this paragraph layout
options.

From the "Theme" step, after clicking on the title of a collapsible paragraph, you have the opportunity to customize the styles of the folding/unfolding
status icon (choice of icons, color and size).

Finally, if you want to add a new topic containing one or more collapsible paragraphs, you may want to choose the "Page" type and then select the FAQ
(Frequently Asked Questions) template which is particularly suitable for this type of use.

The ability to fold/unfold a paragraph:
can only apply if the title is not empty
can not be used at the same time as a timestamp which has priority.

Timestamping of paragraphs

After selecting a paragraph in step "Topics", you can click on the icon (  ) "Date of paragraph" located in the section "Paragraph Layout" of the left
side panel of TOWeb. You will then have the possibility to change the date and time of your paragraph but also to enable the display of a timestamp.
The title of the paragraph must not be empty for the timestamp to be applied.
The former blog of TOWeb  is an example of page using a datestamp (created with TOWeb) that use a compacted display style called "Bubble"
(displaying only the day and month with custom colors).
The customization of the colors and styles of the datestamp of your site is done from the step "Theme". To access its different options of
customization, you need to click first on a paragraph title, and then activate the tab "Date" located below the treeview of the CSS editor. From there,
you can select the styles, the size and the colors that will be applied to all the topics' title of your site that have a datestamp activated.

See also how to :

https://www.lauyan.com/en/topics.html#XyHZGrJo
https://www.lauyan.com/en/topics.html#yKPNcvWt
https://www.lauyan.com/en/topics.html#yKPNcvWt
https://www.lauyan.com/en/toweb-blog-2021-2022.html


Add pictures, widgets & multimedia object s

Add links & buttons

Background Video & Image, Parallax Effects and Full Screen Height

In addition to the global styles of your theme ("Default", "Panel", "Highlight" and the 5 from "Custom 1" to "Custom 5") that you can apply and reuse

for any paragraph of any page of your site (and that need to be customized from the CSS editor of the TOWeb Theme's step) there is a the

"Background / Parallax"  style that no longer uses global styles related to theme but has specific display possibilities applicable to make a paragraph

different with full screen height, colors & background as well as transparency and parallax effects.

Full height

The full height option extends the display of the content of a paragraph to the full screen height of the device or web browser used. The content is

then centered in the middle of the screen. The full height function is responsive meaning that it will fit the maximum available height of the

smartphone, tablet or computer web browser used even when resized or switched to landscape/portrait view.

This feature often requires that you put only very few information in a paragraph so that all its content can also be seen on the reduced screens of
smartphones. If you notice that all the content of your paragraph in full height is only partially or badly displayed on smartphones then you will have
to consider applying one or more of the following tips :

try to reduce the content of your paragraph to the minimum and check the result every after every changes by resizing your web browser and/or

using the TOWeb smartphones & tablets display simulation buttons in order to find the "best compromise"

use the theme editor to reduce the font size specific to smartphones in the titles/texts of your paragraphs and/or find a size a little smaller that

will satisfactory for both smartphones and large screens

adjust the option to disable the full screen display for smartphones

Note: If you use a topic with its 1st paragraph at full screen height and this topic also uses a local menu , then a scroll down button will automatically
appear at the bottom of this 1st paragraph.

Background videos

By selecting "Video" as background of your paragraph you have the possibility to add a video that will be played in the background behind all the
content of your paragraph (its text, links / buttons, object, ...). In design mode in TOWeb only displays a background image of your video with a video
icon on top in the corner as a reminder. To see the real and complete result of your page with its background video, you can request an external
preview by using the F12  key and/or publish your site to watch it online. The videos can be either in MP4, OGV or WEBM format but the MP4 format
is the one preferred because it is recognized by all web browsers (including MS IE11) and all systems (including iOS). Royalty Free and reusable
MP4 videos as background of your sites can be downloaded from multiple websites such as for example https://www.pexels.com/videos/ and
https://coverr.co/ .

With a video in the background of a paragraph, you can also choose which image will represent your video (by default it is the first image of your
video that is chosen). This image will be the one displayed if the web browser of some of your users not supporting or blocking background videos
(especially on smartphones for which a deactivation option is also provided in TOWeb step : "Options > Smartphone").
Depending on the background video used, your texts may not be readable. If this is the case try checking or unchecking the option "Black text" and/or
place object on top such as images or buttons.
Finally, when creating a new "Page" heading being "Parallax", TOWeb will also offer you the choice to start your topic with a video of your choice. And
a "background video" option to test or start quickly a page with a default video will also be available
- when adding a new "Page" with type = "Columns"
- as well as when adding a new paragraph in one of your topics too.

https://www.lauyan.com/en/multimedia.html
https://www.lauyan.com/en/menu-links.html
https://www.lauyan.com/en/topics.html#background
https://www.lauyan.com/en/smartphones.html#tY9PjsFX
https://www.lauyan.com/en/menu-links.html#uhuJ8X0A
https://www.pexels.com/videos/
https://coverr.co/


Note: in order not to delay the display of your page or penalize the "data" of some users when loading your videos (especially user with mobiles
and/or having a low speed internet connection), it is advisable to use videos of small sizes (less than 10 MB) and avoid using several videos on the
same page.

Image & background colors

By selecting "Color" for the background you have the possibility to specify 1 color or 2 colors depending on if you want to have a color gradient or not.
To remove a color simply select the "Auto" choice from the color picker.
By selecting "Image" for the background you have not only the image but in adding to that you can also apply colors that will appears by playing with
the Opacity parameter by transparency. Then you will eventually be able to use a parallax effect and "magnify" it according to your tastes.
Depending on the background image used, your texts may not always be fully readable. If so, try checking or unchecking the "Black text" option. And
if that is not enough then reduce the value of the Opacity parameter.

Parallax effect

The parallax is effect occurring during a scroll down or scroll up of a page that consist in moving different elements of your page at different speed,
especially between the wallpaper/background image and the content in the foreground (texts, images, buttons, ...), giving an animation and an
illusion of depth. The effect can also be amplified by using the "Magnify" option, but not all web current browsers are supporting it and ignore it.
Important: parallax effects are not always supported or can be incompatible behavior with some touch devices (especially old smartphones) that is
why TOWeb allows you to disable parallax effects on mobile touch devices .

User interface tips when editing Topics

In the “Topics” step as well as in the Smart editor of "Theme", a simple click on the title of the different sections allows you to alternatively fold (  )
 or unfold (  ) their content. The use of these functions can be useful for instance in the following cases:

when you do not use very often some options and therefore prefer to hide them,

if you use TOWeb on a small screen or in a small window and want  to avoid the display of a vertical scroll bar,

when you only work or rework specific parts of your site and want to focus only on these ones.

Note: On Mac computers, symbols that precede sections are different for folding ( > ) and unfolding ( + ).

Example showing some control sections of a topic which as folded and one unfolded (search engine optimization) : 

Example of a paragraph located in product catalog where the sections of its layout and image have been hidden in order to work only on that of the
Price & Stock:




https://www.lauyan.com/en/topics.html#IHBrXJxk
https://www.lauyan.com/en/smartphones.html#tY9PjsFX
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Example of the Theme smart editor where all the sections have been folded except for the Logo:

https://www.lauyan.com/en/_media/img/xlarge/toweb-ui-collapsed-panels-2-en.webp
https://www.lauyan.com/en/_media/img/xlarge/toweb-ui-collapsed-panels-3-en.webp


Save as PDF

In construction mode of a page in TOWeb, a "Save as PDF" button located at the end of its content (just before the page footer and next to the other
"Add a paragraph" button) allows you to convert your page into PDF file. You will first need to enter the name and location where you want to save it
before to select your preferences, like displaying the pages in portrait or landscape mode or using a cover page.

Note that if you use another page of your site as a cover page and that this page is only used for this purpose, then you will have to activate its
"Under construction" option in order not to publish it on your site.

By default, all the paragraphs of your topics appear in the exported PDF file. But if you don't want some of them to appear there, it is still possible by
using the small printer button located among the "Paragraph layout" properties.

Notes : 

the lauyan.com site is made with TOWeb and its downloadable online documentation in PDF format was also created using this feature

catalog products can be exported from a version 11 of TOWeb  

https://www.lauyan.com/en/topics.html#pdf
https://www.lauyan.com/en/download-toweb.html#jFMV2vzO


Blogging using group topics

How to create a blog

Enhanced group of topics

Date & Author of a topic

Keywords

Group  topics allow you create better blogs and improve the presentation of your "portal" pages. All these latest improvements and possibilities will be
presented here in order to explain how to : 

blog using a group, i.e. managing a presentation page for several other pages on your site that you feed regularly (a journal of your latest news

or events, cooking recipes, detailed reviews of different subjects, ...)

present all your product catalogs (or all your photo albums) in a single page

How to create a blog

The Cocktails page and the Blog page of the NONA template two possible examples that you can directly use if you create a new site from this
template. You can also directly add a predefined blog to your site by doing the following :

From the "Topics" step, click on the icon allowing to "Add a new topic"

Then select the topic type "A group / blog" click on  "Blog" or "Blog 2" depending on whether you want to start your blog from the predefined one
StoreStarter or BusinessStarter .  

Select the number of pages/posts with which you want to start your blog and then on "Create topic". That's it, you have your blog, all you need to do
is adjust the options of your new group and modify the content of the template posts with your texts and your images.

If, on the other hand, you do not want to start your blog from a predefined template but want to reuse topics that already exist on your site, then
choose "Group" or "Group 2" and select the topics you want to group by clicking + pressing the CTRL key. Then click on the "Create a section" button
and all you have to do thereafter is activate the Date option as well as any filtering by keywords to obtain your new blog.

https://www.lauyan.com/en/blogging.html#ctt-product-images
https://www.lauyan.com/en/blogging.html#Zfxff4Uj
https://www.lauyan.com/en/blogging.html#EfuGYAOg
https://www.lauyan.com/en/blogging.html#CiW2xSAE
https://www.lauyan.com/en/menu-links.html#WB1tdIca
https://www.lauyan.com/en/blogging.html#ctt-product-images
https://www.lauyan.com/download/toweb-templates/nona/html/nona-cocktails.html
https://www.lauyan.com/download/toweb-templates/nona/html/recent-news.html
https://www.lauyan.com/download/toweb-templates/storestarter/html/our-stories.html
https://www.lauyan.com/download/toweb-templates/bizstarter/html/our-stories.html
https://www.lauyan.com/en/blogging.html#Zfxff4Uj?twscroll
https://www.lauyan.com/en/blogging.html#EfuGYAOg?twscroll
https://www.lauyan.com/en/blogging.html#CiW2xSAE?twscroll


Enhanced group of topics 

To create or modify the content of a group , you can do this from the menu  of your site, but you now also have the option of using right-clicks to
move a grouped section before/after another grouped section or good to remove it from the group (cf. example in the screenshot below).

The image used in the summary of each grouped topic is the one you indicated in the Open Graph Meta for this topic (accessible from the "Section
<Head> and other Meta tags" button). If you have not specified any, then it will be the image present in the first paragraph of the topic which will
be used or the one of your theme slider (if your theme uses a slider with an image associated to this topic).

You can present your topics grouped in one or more columns, knowing that on a smartphone, on the other hand, the presentation will be more
compact in a single column.

The "Index pages" thumbnail you select allows you to display the summary of each grouped topic with more or less content and different new
layouts too (just a photo, a photo with title or text, title before or aside the photo, photo to the left or to the right of the texts, ...).

The title and the picture used in the summary of a grouped topic are clickable to allow access to it but if you wish you can also activate the "Link"
option to add a link/button at the end of each summary (the "More..." text proposed by default for these buttons can be changed from the "Options >
Languages > Translate predefined texts" screen). A "Gradient" option allows you to make the texts of the summaries less and less readable in order
to encourage visitors to discover the end of your sentence and the rest of each grouped topic.

Depending on your need you can also activate the two options Date and Author  if you wish to display the dates and/or authors that you have
previously entered in all your grouped topics.
Finally, if you have entered keywords in your grouped sections, you can activate the "Keywords" option. This will add a drop-down list to the top of
your group page that will allow your visitors to select/filter the grouped topics to display by selecting the keyword or category they are looking for. By
default, all the grouped topics are displayed and the drop-down list is therefore positioned on "All categories" (as in the screenshot example above). if
necessary, this predefined text can be modified from the "Options > Languages > Translate predefined texts" screen.
Keywords are displayed after the title of each grouped topic inside small colored bullets (in red in the screenshot of our example for the 2 keywords
"catalog" and "products" of a "Shop" topic) and also clickable to facilitate filtering according to certain criteria sought by your visitors.

Date & Author of a topic

For each topic, you have the possibility of specifying its date as well as is author from the "Keywords, date and author" button located in "SEO
optimization" . If you fill them in, these information will be displayed

at the top of the page, just after the title of your section

as well as by the group of topics when they have their "Date" and/or "Author" options activated.

The date can displayed in different format (see image below) adapted each time to the different languages of your pages.

As for the author, you can enter a name accompanied by a possible small photo (or icon/logo).
Each time you add a new author, it will be saved so that you can then reuse it (1) thereafter for other topics, thus avoiding not only having to re-enter
the author's name but also his/her photo and its style of presentation.

https://www.lauyan.com/en/blogging.html#Zfxff4Uj
https://www.lauyan.com/en/menu-links.html#WB1tdIca
https://www.lauyan.com/en/menu-links.html#K9t3hLZR
https://www.lauyan.com/en/blogging.html#EfuGYAOg?twscroll
https://www.lauyan.com/en/blogging.html#CiW2xSAE?twscroll
https://www.lauyan.com/en/blogging.html#EfuGYAOg
https://www.lauyan.com/en/blogging.html#Zfxff4Uj?twscroll


Keywords

Disappeared from TOWeb since version 5 then reintroduced with version 11, the main advantage of using keywords in the sections of your site is to
facilitate local searches on your site, particularly in your new groups . In fact, when a summary of each grouped topic appears, its keywords will be
displayed in clear text inside colored bullets to allow filtering of the content according to a keyword/category.
But in terms of Search Engine Optimization (SEO), be aware that indicating keywords is no longer of interest to the main search engines, such as
Google which has declared not using them since 2009. Even if certain sites such as the giant Amazon.com is still always using keywords in their pages
and even if some rare search engines like Yandex may find them a secondary use of them, it therefore remains very anecdotal and for purposes other
than SEO (like additional help to display or possible antispam consistency checks).
Finally, note that the local search engine of your site (which can be activated from the "Options > Search engine" screen) is not currently using
keywords either (but this possibility may not be excluded for a future TOWeb update).
In conclusion and unless things change in the future regarding search engines, our advice is therefore to use keywords only in topics that you
plan to group and this if you wish to allow your visitors to filter the display of your content according to your keywords/categories.

https://www.lauyan.com/en/blogging.html#CiW2xSAE
https://www.lauyan.com/en/blogging.html#Zfxff4Uj?twscroll


TOWeb Themes

Start or restart your Theme

Customize your Theme

Web, Local and Custom Fonts

Start or restart your Theme

When first using TOWeb you are asked to select among the list of theme & site templates the one you'd like to start with. Later on you may add or
remove topics of your site and change the content of your pages and layout of your paragraphs (from the "Topics" step) but also change and apply at
any time another theme to your website by using the load theme template (  ) button located in the left sidebar of the Theme step.

New themes will be regularly added and available for download (internet connexion required) so you may use the load theme template button to check
the latest ones (if you can't see any theme and/or if TOWeb seems blocked you may need to authorize TOWeb on your system ). From the TOWeb load
theme template window, you can select and open any theme : links inside the template do work so before to apply it to your site you can navigate and
see the different pages but also use the different preview buttons to see how the theme is displayed on smartphones ( ), tablets (  ) and the

full screen mode of your computer (  ).

You may customize to your needs the default theme templates proposed by Lauyan Software and then manage different versions of your theme(s), be
able to get back to them using the Save a local theme (  ) button and Load a local theme (  ) button located in the Theme EXPERT Mode
interface (see next chapter below for more information about the Expert Mode).

Customize your Theme

Smart Editor

This simplified screen allows you to easily and quickly change some main important elements of your theme :

the texts that appears on the top part your theme/site (left & right parts and slogan),

slides and their order,

social network buttons

colors adjustments of your theme

If you have made changes to your theme using the smart editor but want to undo them (due to mistakes or modifications you don't want to keep),
then use the Css Editor button and click (  ) undo all theme changes. On the contrary if you are satisfied with your changes you can Save
everything anytime using the CTRL  + S  shortcut.

CSS Editor

The expert mode interface allows you to modify your Theme and so obtain a different one. But depending on changes this may require expert web
developer knowledge (especially in CSS3) to be able to manage and perform all the necessary changes that will lead to the result you may want to
obtain. All layout possibilities and web developers' skills are not be described here but only basics on how TOWeb manages CSS theme styles.

First open the topic of your site where you would like to preview the changes of styles you are going to do. For instance open your homepage if you
want to change and see slides only displayed in your homepage or select a catalog if you want to change and see the color of your product prices for
example. You can select a different topic from the list of topics located on the top toolbar or from the TOWeb's Theme step by clicking on a link inside
your preview page (links of your menu for instance) while pressing the CTRL  key.

Then, in the page preview, select the element you would like to change. For instance if you want to change the link color of your website menu, click
on one menu link (or menu link button) and you will see the TOWeb left sidebar a treeview and tabs updated with the menu link styles properties.
The treeview list contains the structures of the different elements and actions you may change like for instance the for a menu link the hover effect or
the active link style (used to show in your menu which current topic is currently displayed). Below the treeview list, different tabs contains CSS
properties you may change like the "Color" of your link located inside the "Font" tab.

Open or close any nodes in this treview to display or hide structure element properties before to find and select the one you want to change. Elements
in the treeview list can be moved by drag'n drop. You may then move for instance the search box on the left or right part of another toolbar of your
theme. And if you have several elements placed inside the same location then you may change their order by drag'n drop too.
Theme elements of your site are divided inside 2 main categories in the treeview : "Site > General" & "Site > Page". Only elements located in "Site >
Page" can be moved by drag'n drop.

Remember that you can Undo all theme changes (  ) if do any mistake, but also Save (  ) & Load (  ) local themes to manage different theme
versions and do frequent backups of your website to be able to get back to a previous version of your website.

Web, Local and Custom Fonts

All editions of TOWeb offer by default a choice of 1000 fonts usable in the themes of your sites, the vast majority of them being Google Web Fonts.

But TOWeb also allows you to integrate any Web font files locally to your site (.woff, .eot, etc ...) whether they are those of Google or others. The
advantage is to be able to use local fonts on your website ( including Google Web Fonts that you can download from google-webfonts-helper ) rather
than load them systematically from another web server than yours every time you open a web page of your site. This is particularly useful in the
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following situations:

if you want to prevent your site and visitors from being "tracked" by Google by using the Google fonts locally stored on your own web

server instead of online access and use Google's servers.

if you want to work "offline" in TOWeb without systematically making online "https" access to Google fonts but rather use local fonts, present

on hard disk, and thus accelerate the loading/display of pages for a better comfort in using TOWeb,

if you want to make an intranet site that can be displayed correctly even without internet access (ie internal site of a company / organization) or

if you want to show a beta preview of your site to someone on a computer not connected to the internet,

if you want to use very specific fonts made by designers for your company.

To add a font in TOWeb, you first have to open the CSS editor of the Theme , then inside the "Font" tab click on the "+" button located next to the list
of available fonts. The Add Fonts Wizard will then guide you by asking you to copy/paste the CSS lines of your font and add the compressed ZIP file
containing all the files in your font.
The local/custom fonts you add are always placed at the very beginning of the list of available fonts with their name displayed in bold to distinguish
them from the others (standard fonts are shown in italics and online fonts of Google Web Fonts displayed without any formatting).
Once your font is added, you can select and apply it to an element of your Theme such as the global element "Site" (if you want it to be the default
font used for all content of your site) or only to a specific sub-element like "Title" (if you want to have a page title style different from the rest).
When you add a new font it is first added into TOWeb, meaning that if you have multiple sites you will not have to add it each time but will be able to
use it directly from the list of fonts available in TOWeb.
On the other hand, if your site uses a local/custom font, it will also be stored in your site's data, meaning for example that during a full reinstallation of
TOWeb on a new computer and a restore data of your site, you will not have to add it again but it will be automatically added and available in TOWeb.

https://www.lauyan.com/en/theme-creation.html#J7fwE0fg
https://www.lauyan.com/en/install-guide.html#YW555hcX
https://www.lauyan.com/en/backups.html#ZrhCv7Y5


Pictures, Widgets & Multimedia objects

Pictures in paragraphs

Image Optimizations and Formats

Icons inside your texts

Albums

Videos

Google Maps & Leaflet OpenStreetMap

Twitter/X Widget

Chart object

Countdown & time counter objet

Plan & Price

Card

Percentage

Key Figure

Note

Timeline

Rating

Other objects and widgets

Pictures in paragraphs

From the topics' step of TOWeb, select the topic and paragraph where you want to add your picture. If your paragraph does not have any object yet
then just select the Picture (  ) object from either the list in the left sidebar or from the contextual menu by using a the ( + ) button displayed
over your paragraph. If your paragraph already use an object that you want to keep, then add a new paragraph in which you will add your Picture.
Once your object is added to your paragraph you may change its position using the different text/object layouts proposed. And you may change the
alignment of your paragraphs too by changing their width if you want them to be aligned one next to the other, and move them one before or after the
other. And the offset allow to shift the paragraph inside the page (you may use it to center a small width paragraph in a page). If you need multiple
images inside a paragraph TOWeb also allows you to do that with different possible presentations.

Picture properties

On the left sidebar TOWeb offers you buttons actions to change your image, do a paste of an image present in the clipboard, use the image editor but
also the following properties for your image object

enter a description for your image (tag "alt"). This is important if you want your image to be best indexed by search engines such as Google

Images

optionally specify a title to your image (tag "title"). This title is not really taken into account for SEO. It is more likely to satisfy the user

experience by displaying your title in a tooltip when hovering your image (and possibly also as a replacement in case the image is not displayed

properly)

choose the width of your image among the list of sizes proposed by TOWeb

choose a frame effect that surrounds your picture

select a click action on image that can either be a zoom or a link to a web page

add a badge to your image (a small image displayed next your picture). Such image can be useful for instance on a product to show a -20%

discount, show that this is something new, etc.

add a ribbon : a short text displayed over the image on its upper right corner, for example to indicate a promotion or a new version

apply a zoom or a text overlay display effect when the mouse hovers your picture

add a badge to your image (a small image displayed next your picture)

add multiple pictures (see next chapter "Multiple images: mini-album & slide inside a paragraph")

Multiple pictures (grid, mini-album & slide display inside a paragraph)

Use the add multiple pictures (  ) button to add other images to the same picture object. This function is useful if you want to display different
pictures of the same subject (like for instance different view of a product), or create a mini album animated or not inside a paragraph. Pictures will all
need to have the same size if you do not want page content to move when navigating from one picture to the other. If you have a least 2 pictures
inside the same picture object you can select to display your picture object as :

a thumbail : the list pictures appears below the currently selected image and by clicking on a thumbnail image it will be enlarge into the picture

object.

a slider : a animated slide show with adjustable speed. You may define different links for each picture using the "Click action" link button if you

want each picture to redirect to different page or selected a "zoom" click action if you want your pictures to be zoomed.
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a grid : only for catalog product images, different grid presentations  are also possible from TOWeb 13.

To change the order of your images, you must press the CTRL  key while clicking the previous/next buttons

used to navigate through your multiple images.

Finally for each image you can set different links using the click action button and choosing link (if you

want to open for example another page of your site from this image) or by choosing a hover action so each

image enlarged to full screen and overlaid on your page.

Support for Retina images

Whenever possible, TOWeb adds into the source code of your pages, URLs with higher density images for the Retina screens (that is to say screens
having pixel densities greater than 1, for example 2x for many smartphones) to display these images "ultra-clean".
For an image of your site to be displayed with high density, you need to provide to TOWeb an image with a size at least twice bigger than what you
want to display. If for example in a paragraph you have an image with 300 pixels wide, then the original image that you need to provide have to be
larger than 600 pixels to be displayed in Retina mode. An icon symbolizing (  ) an eye ) is displayed in TOWeb next to the drop list of widths to
indicate whether it will be viewable for Retina screens or not.

Watermarks on your pictures

TOWeb offers the possibility to add watermarks over all the pictures of your site. A watermark is an overlay text that will contain for example the name
of your website or the author name in order to mention your copyright and thus prevent any reuse of your pictures by visitors or web engines.

if you want your watermark to be applied to all the pictures of your website you need to use the "Watermark your pictures" function located

in "Options > Security & HTML"

or on the contrary, if you only want to apply a watermark to pictures used by a specific topic then you need to do it directly from the topic

the following way :

if positioned on the index page of a catalog or an album, use either the button "  Watermark your images"

located in its "Security" options

if positioned on a topic page or album/catalog item page, then simply select a paragraph containing an image to directly use the button (

 ).

Adding a watermark to images is irreversible, meaning that once applied TOWeb, the only way to undo this action will be to quit TOWeb and close your
site without saving any of your changes. If you have saved your changes but want to return back to a previous situation without any watermarks on
your pictures, then you will either need to :

replace one by one all the images of your site using the button (  ) "Restore original picture " located near each image of your website

or restore a backup  that contains a previous version of your site without any watermark on your images

Please note that all images already watermarked can not receive a second watermark thereafter. So when you will reuse the watermark feature again,
only the last new images recently added to your site will be proposed for a watermark (those that do not have any watermark yet).

https://www.lauyan.com/en/multiple-images.html
https://www.lauyan.com/en/backups.html#ZrhCv7Y5


Image Optimizations and Formats

TOWeb allows you to add images anywhere in your site in the main standard formats such as jpg, png, gif and webp but also offers you automated
optimizations available in the "Publish > Performance" screen. Depending on the number of photos you have on your site, these options can
significantly reduce the size of your site (up to almost half) and also improve the display speed of your pages as well as the SEO of your site .

WebP images to speed up your web pages

Developed by Google, the WebP format allows you to compress images without loss of quality while significantly reducing file sizes compared to other
formats such as PNG or JPG. Recommended by Google, this modern format is becoming an essential standard for optimizing website performance.
TOWeb has supported this format since version 9 of 2020 by keeping by default your "fallback" images, that is to say the original versions of your
images (in JPG or PNG format, for example) to display them in the event of browser incompatibility with the WebP format.

Since this format is now supported by all modern browsers (Chrome, Firefox, Edge, Safari, Opera), TOWeb also offers (from a version 13.03 or
higher) a second option located in the "Publish > Performances" screen allowing you to convert all the images on your site exclusively to WebP format,
without keeping the "fallback" images. Here are the advantages and disadvantages of using this option:

Advantages of Using WebP Exclusively

By keeping only the WebP format, storing, publishing, and hosting all the "fallback" images is no longer necessary. Your site occupies much less

space, both locally on your computer and on the hosting server, and will publish faster (except the very first time because cleaning and deleting

all unnecessary fallback images on your web server may take time depending on their number).

The WebP format offers better compression than traditional formats like JPG, PNG, or GIF, reducing the size of images by 30-50% while

maintaining comparable quality.

A typical webpage containing several images will have significantly reduced loading times, improving both user experience and Core Web Vitals

scores.

Google favors fast websites. By using WebP, you increase your chances of achieving a higher ranking in search results.

Without fallbacks, all users see the same images with the same optimized performance.

Disadvantages of Using WebP Exclusively

Some outdated browsers (older versions of Safari or Internet Explorer) do not support WebP. If a significant portion of your audience still uses

these browsers, it may not be suitable to enable this option for now.

Once files are converted and original versions deleted, reversibility is complex. Therefore, make sure to back up your site before enabling
this option in case you need to revert later.

The creation of all necessary WebP files is processed as a background task so that you can continue using TOWeb and an animated icon in the
interface lets you know if the processing is still in progress or finished. If you exit TOWeb (or close your site to open another one) before the creation
of all WebP files is completed, the operation will be considered canceled and WebP files deleted.

Progressive JPEG

TOWeb allows you to convert all the images on your site to the "Progressive JPEG" format. This format not only allows you to obtain smaller files than
standard JPGs but also to display them progressively during their download (unlike the normal JPG format which requires the complete download of
the image before to be displayed). You can adjust the desired quality percentage, knowing that the smaller this value, the smaller the file size of your
images will be. A high value (around 90% or so) is generally recommended so that the sharpness of your photos is only very slightly degraded and
remains almost imperceptible to the human eye.

Lazy-loading

The Lazy-loading technique allows you to display a web page more quickly by only downloading images when they are visible. Initially, each page of
your site will load and be displayed faster by only displaying the first visible images, the other images being downloaded only when necessary, as
visitors scroll through your pages when they appear. We advise you to activate the "native" lazy-loading option to use the behaviour supported by
modern web browser, but depending on your needs or preferences, you can also deactivate lazy-loading or use the "script" option to have the same
effect regardless of the web browser used.

Icons inside your texts

When edition a Title or a Text use the icon button (  ) to insert, modify or delete any icon. TOWeb offers a list of icons with size proportional to the
font size used on your website that you can colorized but you can browse and add your own icon file if you have one. Icons can be add anywhere
inside your text including in link buttons .

Albums

To create an album click on the Add a new topic button (  ) located on the top toolbar and then the Album (  ) type of topic. Add and select
your images to the list, enter a short name for your album (used in your menu) before to click on the button "Add the new topic to my website".
Your album is made of an index page containing all your pictures and pages (1 per pictures) with pictures displayed in larger size and their titles /
comments.

 
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If you want to add, delete or change the orders of your pictures inside an album you can do it from the contextual menu "Modify" displayed when
hovering a picture. And the Arrange (  ) screen allows you move your picture by drag'n drop to easily change their order.
You can also create mini-albums or sliders inside a paragraph .

Videos

From the topic step of TOWeb select the topic and paragraph where you want to add your picture. If your paragraph does not have any object yet then
just select either the HTML5 Video (  ) or YouTube Video (  ) or Vimeo (  ) or a TikTok (   ) object from either the list located in the
TOWeb's left sidebar or from the contextual menu "Modify" displayed over your paragraph. 

For a TikTok video you need to use the "Embed" button located next to the video on TikTok.com and then click on the "Copy code" button. Once this is
done, then return to TOWeb to use the "Paste" button located next to the "Code" field of your TikTok object.

If your paragraph already use an object that you want to keep, then add a new paragraph (that will contain your Video object) and move it before or
after the other paragraph.
Once your object is added to your paragraph you may its position using the different text/object layout proposed. And you may change the alignment
of your paragraphs too by changing their with if you want them to be aligned one next to the other, and move them one before or after the other.
Then enter or copy/paste the URL of your video. In case of an HTML5 video, 3 different video formats are accepted (MP4, WebM and OGV) and you will
need to fill out at least one URL.

You can also use YouTube Shorts videos but due to the vertical format (format 9:16) of these videos, we advise you to integrate them into
paragraphs with reduced width and offset to center them in your page or to align several videos/paragraphs between them in order to obtain an
optimal display of your content on all types of screens.

Google Maps & Leaflet OpenStreetMap

From the topic step of TOWeb select the topic and paragraph where you want to add your picture. If your paragraph does not have any object yet then
just select the Google Maps (  or   ) Object from either the list located in the TOWeb's left sidebar or from the contextual menu "Modify"
displayed over your paragraph. If your paragraph already use an object that you want to keep, then add a new paragraph (that will contain you Google
Map object) and move it before or after the other paragraph.

Since June 22nd, 2016, Google requires the use of an API key for the maps. If your website is not correctly displaying your maps and/or if you

are not using any API key yet then you may want to check the Google Services .

The Google Maps service imposing constraints as well as problems reported by many users (such as that of a too limited operation in its free

version or the obligation to give its credit card number even for free use) you are advised to use the free alternative of Leaflet maps.

Leaflet OpenStreepMap

From the "Type" of map list, select "Leaflet OpenStreetMap". Then enter or copy & paste the longitude and latitude of your coordinates, expressed in

decimal degrees (with the "." as decimal separator). The latitude value must be between -90 and 90. The longitude value between -180 and 180.

To obtain the longitude and latitude of a place, proceed as follows:

1. Open the Google Maps  or OpenStreetMap  page and make a search for the desired address

2. Then click on the precise point of your address to display all the information of this place. The latitude and longitude in there are the 2 decimal

numbers separated by a comma. 

3. Manually enter or "copy" both the latitude & longitude before to paste" them inside the latitude and longitude fields of TOWeb.

Once done, if you want to add a marker on the map, just enter a title and/or a text. You will finally have to adjust the zoom level and if necessary

adjust the dimensions of your map too.

Google Maps

Once your Google Maps object is added to your paragraph you need to fill out the "Map center" and "Markers" fields.

Map center : enter an address as plain text or as latitude & longitude (comma separated). If you leave this field empty the map will be centered

on the first marker. For more information plaase check the Google Maps help page .

Markers : enter one address per line and optionally add a comment after the address with the colon ( : ) character (comments only work in

dynamic maps).

Examples :

Paris, Texas
Paris, Texas : I live here !
33.6608333 , -95.5652778 : I work here !

Then select the type of view and zoom level you want for your map as well as its width & height to best fit in your paragraph and page.
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Twitter/X Widget

Warning: Since the new 2018 version of the Twitter/X Widget arrived and its previous version is no longer displayed by Twitter, it is no longer necessary
to have a Twitter account to integrate timeline tweets into a web page but you will need to use the URL of your Twitter/X page.
From the "Topics" step of TOWeb, select the topic and the paragraph where you want to add your Twitter Widget. If your paragraph does not have any
object yet then simply select the object (  ) Twitter Widget either from the "Object" list located in the left sidebar of TOWeb, or from the context
menu "Modify" displayed over your paragraph. If the paragraph already has an object that you want to keep, then add a new paragraph (with or
without text) in which you will add your Twitter Widget and then move this new paragraph to the desired location and width inside your page.
You will be asked to enter the desired URL, meaning the Twitter web page (starting with https: /twitter.com/ + twitter account name) containing the
tweets feed that you want to integrate into your web page. Since Twitter messages are usually of secondary importance, it may be best to place your
Twitter Widget object in a sidebar panel rather than a normal paragraph of your page.

Chart object

The Chart object allows you to display data in different graphics and styles. From the "Topics" step of TOWeb, select the topic and paragraph where
you want to add your object (  ) Chart. If your paragraph does not have any object yet then simply select the Chart object either from the "Object"
list located in the left sidebar of TOWeb or from the context menu "Modify" displayed over your paragraph. If the paragraph already has an object that
you want to keep, then add a new paragraph (with or without text) in which you will add your Chart and then move this new paragraph to the desired
location and with inside your page.
Once your graphic object added to your paragraph, you can choose between 6 different chart types:

Line

Bar

Radar

Polar area

Pie

Doughnut

with for each chart, customization options such as for example the choices of colors, of displaying or not a grid, a legend or an animation (animations
only appear at first display when the page is loaded). Below are some examples of possible results you can obtain :

Exemple 1 : Bar

Exemple 2 : Radar

Tomatoes

Bananas

https://www.lauyan.com/en/multimedia.html#MjTZdmG1
https://www.lauyan.com/en/multimedia.html#y8QnJ3qX


Exemple 3 : Lines

Exemple 4 : Pie

Tomatoes

Bananas

Tomatoes

Bananas

65 Tomatoes
28 Bananas
18 Salads
10 Water



Countdown & time counter objet

TOWeb allows you to show inside your pages a time counter that either works as a countdown timer or as a counter of the elapsed time since the date
& time of the event you specify. Once the date and time of the event is reached you can either display a message, or leave the counter to run and
display the elapsed time since the event.
From the "Topics" step of TOWeb, select the topic and the paragraph where you want to add your object (  ) Time Counter. If your paragraph does
not have any object yet then simply select the Time Counter object either from the "Object" list located in the left sidebar of TOWeb or from the
context menu "Modify" displayed over your paragraph. If the paragraph already has an object that you want to keep, then add a new paragraph (with
or without text) in which you will add your Time Counter and then move this new paragraph to the desired location and with inside your page.
Once your counter object added to your paragraph, you can then set the date & time of your event, choose whether to show or not the counter in
days/hours/minutes/seconds, customize the colors, the dimensions and its behavior after the date of event.

Example 1 : coundown in days, hours, minutes and seconds until the 2023 new year day.

Example 2 : elapsed time in days and hours since November 1st, 2020.

Plan & Price

The Plan & Price (  ) object allows you to display one or more characteristics sheets with prices and possible links to your various products or
services. The presentation of cards is customizable (style, color, ...) and a specific enhancement can also be applied to highlight a particular card for
example to indicate it as recommended.

Example:

https://www.lauyan.com/en/multimedia.html#4KqInawB
https://www.lauyan.com/en/multimedia.html#planpricing


Card

The Card (  ) object allows you to highlight one or more photos with the possible presence each time a title and/or description and link. Its use can
be multiple and varied as needed, for example for the display of a trombinoscope (as below) or a page for presenting photos, albums, product
catalogs, etc.

Example:

An "Overlay text" option allows you to show your text no longer beside the images but superimposed over your images when hovered. An animated
appearance effect of your text can also be chosen in this case.

https://www.lauyan.com/en/multimedia.html#To5pJyoU


Percentage

The Percentage (  ) object allows you to display one or more percentages with a gauge in order to highlight them. This object can be particularly
useful for example when you want to highlight certain characteristics of your products, or the progress of different aspects of a project, or the skill
levels achieved in different areas, and so on.

Example:

Key Figure

The Key figure (  ) object allows you to display one or more key figures of your company or project to highlight them.
You can add a unit next to each value (for example: %, °C or °F, mph, ...) and set animation that increases each values by indicating the duration of
the animation upon the first appearance of your key figures on the page.
It is also possible to choose another presentation that "Horseshoe" by selecting the style: "Icon". Using this style will allow you to add an icon of your
choice (either among those predefined or your own image) to each key figures.

Example: Key figures using the "Horseshoe" presentation

Note

The Note (  ) object allows you to display a message in a colorful "Post-it" way inside a page of your site. Depending on your needs you can enter a
title and/or text and/or author using different display options (inclination, colors, pins, ..). This object can be particularly useful for example in these
cases:

when you have quotes

when you want to highlight an essential point of your page such as an important tip, a help text, a conclusion, ...

or by using several "Notes" placed next to each other and below the others in order to "simulate" the view of a desk on containing all the

important things to know about a product, a project, etc.

Examples:

15
PROJECTS

124
EMPLOYEES

97%

SKILLS
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Timeline

The Timeline (  ) object lets you display events linearly and chronologically in a vertical chart. The timeline can contain "milestone" to
classify/group your events according to your needs (for example by day, month, project, etc) and your messages can be displayed with different styles
depending on where they are placed on the left or on the right. Depending on your needs, TOWeb also offers you various predefined choices for
formatting the date/time of each event or the possibility to enter your own personalized text, which can be useful especially in the following cases:

when you do not want to display dates but for example project names especially for your milestones or have a subtitle to your events instead

if you want to display not a date but a period such as "Holidays from March 9 to 19" or "Renaissance Period" or display any kind of

customized date such as "Yesterday", "D-1", "2000 years BC.", etc

if you want to use the chronological timeline just to present the different steps of a procedure (step 1, step 2, ...) without necessarily showing

any notion of date but a simple timeline procedure to follow.

Note: if you want to create a Timeline from an iCalendar (ics) file you can do it by adding a new topic to your site with a "Calendar / Schedule" type.

Example #1: Daily events chronologically sorted and delimited by monthly steps  

https://www.lauyan.com/en/multimedia.html#timeline


Example #2: Exchange of messages chronologically displayed by hour



Rating

Te Rating (  ) object allows you to display one or more reviews with comments & rating stars as a list or in a slider for automatic scrolling. These
comments can be yours for example in the context of an article you wrote about a product you tested or user reviews previously collected and selected
via a form on your site.
The "Max." parameter allows you to specify the maximum rating value among the following choices: 3 stars, 5 stars or empty. If you choose Max = 5
stars and set a value of 4 stars you will have 1 extra "empty" star displayed (see example 1 ) and same principle applies of full+empty stars also
applies for Max = 3. On the contrary, if you do not want any extra empty stars to be displayed at all, you will need to set the Max field to the empty
choice.
The "Quote" parameter allows you to change the style of parenthesis of your messages / comments. If you choose not to use it you will have more
freedom in the content of your text (for example if you want to add another information like a date and so place your own parenthesis exactly where
you want) and you will also obtain a different display style by using a 2nd color.
For each evaluation, you have the possibility to add an image (like for example a photo of the author like in example 2 ). If you use images, the left or
right alignment will show your images as icon (ie small and square format) but if you choose a centered alignment then your image will be displayed
as thumbnail (ie small size but larger than the icon and respecting the original proportions of your image).

Example 1: Column display (260px) with stars at the end

Example 2: One-line display (100% width) with images and large stars

 Jane Smith  John Doe

 Dolores Kilgore

«Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor incididunt
ut labore et dolore magna aliqua.»



«Officia deserunt mollitia Ipsum dolor sit amet,
consectetur adipisicing elit, sed do eiusmod tempor
magna aliqua ut labore et incididunt.»



«Mauris vitae bibendumLorem ipsum dolor sit
amet, consectetur adipiscing elit. Ut non libero
magna psum. Officia deserunt mollitia»



  -  Jane Smith

"Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua."



https://www.lauyan.com/en/multimedia.html#ratings
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Other objects and widgets

See also the i-services for objects such as blogs, web forms, polls and mailing list .

For other objects not proposed by TOWeb as well as for adding scripts and HTML lines of code inside your page,
you'll need to use the TOWeb Scripts Field s.

  -  John Doe

"Officia deserunt mollitia Ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor magna aliqua ut labore et incididunt."

  -  Dolores Kilgore

"Mauris vitae bibendumLorem ipsum dolor sit amet, consectetur adipiscing elit. Ut non libero magna psum. Officia deserunt mollitia"





https://www.lauyan.com/en/multimedia.html#VKsMk9Vh
https://www.lauyan.com/en/i-services.html
https://www.lauyan.com/en/scripts.html


Displaying Multiple Product Images in a Grid

The "Grid" Mode

The "Grid 1/2" Mode

The "Grid 1/2+" Mode

The "Grid 1/3" Mode

The "Grid 1/3+" Mode with alternation between 1 and 3 images

Fonctionnement responsive adapté aux smartphones

With previous versions of TOWeb, the multi-image mode of a paragraph offered only two display modes:

A classic display with a main image and a selection bar of thumbnails beneath it for switching images.

An image carousel with a more or less rapid scrolling speed.

TOWeb version 14 introduces grid display modes that are particularly well-suited for product sheets on e-Commerce sites. Additionally, these
display modes transform into modern carousels with swipe handling on smartphones, making your e-Commerce site much more user-friendly for
customers!

Here is a presentation of the new available display modes, illustrated here with the "WAND" template. The selection of new "grid" display modes is
possible on a paragraph with multiple images in TOWeb.

The "Grid" Mode

This mode displays images one below the other.

https://www.lauyan.com/en/multiple-images.html#gBJwQ7wy
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The "Grid 1/2" Mode

This mode displays the first image normally and the subsequent images in two columns.

https://www.lauyan.com/en/multiple-images.html#PIsDQabj
https://www.lauyan.com/en/_media/img/xlarge/product-grid-display-example.webp
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The "Grid 1/2+" Mode

This mode alternates between displaying one normal-sized image and the next two side by side.

The "Grid 1/3" Mode

This mode displays the first image normally and the subsequent images in three columns.

https://www.lauyan.com/en/multiple-images.html#pZ9AjRao
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The "Grid 1/3+" Mode with alternation between 1 and 3 images

This mode alternates between displaying one normal-sized image and the next three side by side.

https://www.lauyan.com/en/multiple-images.html#dQFsVbQP
https://www.lauyan.com/en/_media/img/xlarge/product-grid-display-example-4.webp


Fonctionnement responsive adapté aux smartphones

Tous ces modes grilles se transforment sur smartphone en un carrousel moderne qui gère les swipes (défilements tactiles)

https://www.lauyan.com/en/multiple-images.html#BPyz4b5E
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https://www.lauyan.com/en/_media/img/large/product-grid-carousel.webp


Send your emails by SMTP

Using an SMTP server

Using Google's SMTP server

Using Yahoo's SMTP server

Using PHP mail

Using an SMTP server

Using SMTP improves the reliability of your site's emails considerably compared to the PHP mail method used by default. This reliability is
important in order to properly receive all emails sent by your site's forms but also all online orders from your store. Before that, make sure that your
site works well online and if you have not yet published it to your host then refer to our advice in order to publish your site  for the first time using PHP
mail .

In order to be able to send SMTP email from your site you need to have all the necessary
information to connect your email server, that is to say:

your email address

your password
the SMTP server name to use (*)

the SMTP port to use (*)

(*) = if TOWeb recognizes your email this information will be
automatically pre-filled for you, otherwise you will have to contact
your email provider to find out.

Once you have this information, you can add your email account in TOWeb and use SMTP
email sending on your site by following these steps:

1. click on the   button located in step 4/5 of the host configuration wizard (accessible

by CTRL  + F8 )

2. enter your email address and password (as well as the server name and port if these

fields are not automatically filled in by TOWeb). Unless your email provider has advised you of a specific encryption mode, we advise you not to

worry about this option and to leave the choice on "auto"

3. then click on OK

4. your message account thus created can then be selected in TOWeb to be used on your site

5. click on the test button to ensure that you receive the test email. If this does not work, then make sure that you have not made any mistakes in

the information you have entered and then update it before doing a new test. Also check that no security system on your computer is blocking

TOWeb

6. then go to the last step of the wizard to validate your changes.

Note: if the email account you want to use to send your messages is a Gmail or Yahoo address, then you will need to enable the "SMTP OAuth2" option
and perform additional security configuration steps by referring to the SMTP with Google and SMTP with Yahoo procedures.

Using Google's SMTP server

Google allows you to use the Gmail SMTP server to send emails from your site for free (up to a maximum of 500 emails per day) and requires a
minimum of PHP version 8 on your hosting. The procedure to follow consists of 2 major steps which are as follows:

1. create a Google application that will allow you to connect to the Gmail SMTP server via the Google API (instead of just entering the SMTP

details). This step requires following many mandatory security configuration steps (count between 30 minutes and 1 hour if it is your first time)

but that you will only have to do once in order to obtain the Gmail OAuth2 SMTP credentials of your site

2. use your GMail OAuth2 credentials in TOWeb.

Note: if you have just created your site and have never published it before, we advise you to start by publishing your site for the first time by sending
it via the PHP mail function of your host.

1) Create your Google App

To get started, open your web browser and sign in to your Google account from the Google Developers Console . If this is your first time signing in to
the Developer Console, Google will ask you to create your first project. If you already have projects, you can create a new one by clicking the drop-
down menu in the upper-left corner.


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Once in your project, click the button to enable the APIs and services (see screenshot above). In the next screen, search for “Gmail” and choose the
Gmail API result to enable it. Once this is done you should be in a dedicated interface for the Gmail API from which you can do the following:

1.1) Click the button to create your credentials
1.2) Then fill out the form using the following information:

Which API are you using?

Gmail API
Where will you call the API from?

Web browser (JavaScript)
What data will you have access to?

User data

1.3) Then click the “What credentials do I need” button. Google will ask you to create a consent screen. This is the same type of authorization screen
you see when you use Google to sign up or log in to a site. You need to do this to meet Google’s requirements, but you don’t need to worry about
what information you enter because you (and only you) have your information for your own site.

1.4) Next, use the button to Set Up Consent Screen. This should open a new tab where you can set up an OAuth consent screen (keep the original
browser tab because you’ll need to come back to it). Under "User Type", select "External".

1.5) Next, click "Create". On the next screen, enter your site’s basic details. Again, you don’t need to worry about what you put here because you’re
the only person who sees this information. Once you’ve added the information, click "Save" at the bottom of the page.

1.6) Go back to your project credentials page and enter the following information:

Name
your website name

Authorized redirect URIs
the following web address, replacing "xxxx.xx" with your website domain name:https://xxxx.xx/_iserv/sendmail/PHPMailer/get_oauth_token.php

1.7) Then click the "Refresh" button (located at the end of the page) to update your credentials and then Create OAuth Client ID to complete the
process. Once done, you should see a section for OAuth 2.0 Client IDs in your project's Credentials tab.

1.8) Finally, click on the name of the site that you have just created (here in our example "Website 1") in order to view and keep the following 2
identifiers (because you will have to copy/paste them into TOWeb in the next step):

your client ID
and your client Secret

2) Use your OAuth2 IDs in TOWeb

Once you have the OAuth2 credentials of your site previously obtained from your Google account, you can add and use your Gmail email account by



following these steps:
1. click on the   button located in step 4/5 of the host

configuration wizard (accessible by CTRL  + F8 ) to add

your email account

2. then enter your Gmail email address. TOWeb will then

automatically fill in all the other fields (server, port,

encryption) that you normally do not have to modify

3. activate the SMTP OAuth2 option (entering your password

may not be necessary when using SMTP OAuth2)

4. copy to the clipboard each client credential (previously

obtained in step 1.8) and use the paste buttons [1] to fill

both TOWeb form fields

5. check that the redirection URI address that you previously

indicated to Google is the same as the one displayed by

TOWeb. If necessary, use the button [2] to copy and paste it

into your Google account to correctly update this

address (previous step 1.6)

6. then click on the button [3] which will redirect you to the

page of your site containing a form to fill out in order to

obtain the latest security identifier "Refresh token" allowing

the use of your Gmail account from your website. Once this

form is filled out and validated, you will then obtain this

"Refresh token". Do not close your web browser window

because this "Refresh token" is very important and must be

kept very carefully. In addition to copying/pasting it in field

[3], we advise you to also keep it elsewhere (such as in your

usual password management tool) in order to be able to

reuse it in the event of a problem (such as losing your site

data)

7. then click OK to finish adding your email account to TOWeb

Your Gmail account thus created can then be selected in TOWeb to be used in your site after having previously clicked on the test button to ensure
that you receive the test email. If this does not work, then make sure that you have not made any mistakes (in your copy/paste in particular) by
repeating all the steps and also check that no security system on your computer is blocking TOWeb.

Using Yahoo's SMTP server

Yahoo Mail allows you to use their SMTP server to send emails from your site for free with a sending limit of 500 emails per day (exactly like Gmail).
However, Yahoo Mail is not always compatible with sites and hosting, and you may encounter problems when setting it up. This is mainly due to the
fact that Yahoo Mail has quite strict firewall rules to combat spam sending. For this reason, we recommend that you preferably use another free SMTP
server, such as Gmail's SMTP server , which is often easier to operate but also more durable and less problematic over time, especially if you are one
day forced to change hosts.

If you want to use Yahoo Mail's SMTP server, the procedure will be exactly the same as Google's, that is to say, create an App from your Yahoo Mail
account by following Yahoo's instructions (in English) in order to obtain your two OAuth2 identifiers which will allow you to add your email account in
TOWeb and obtain your "Refresh token" security identifier which is necessary for sending emails from your site via SMTP. And just like for Google, you
will need your site to be published on a web server using at least version 8 of PHP.

Using PHP mail

If you have never configured or published your site to your host server, we advise you to make at least one publication by first using the PHP mail()
function of your host. This will not only ensure you that everything works well on your site without PHP incompatibility or errors detected by TOWeb at
the level of your server, but also that you have not made any mistakes such as for instance a bad subdirectory name in step 3/5 of the host
configuration wizard CTRL  + F8  or OAuth2 errors.

For the sending and receiving test, you must use the email address of your site (and not a free one like @gmail or @yahoo) as it may be refused
by your host and no email will ever be sent. In other words, if your site has for example the domain name "mysite.com", you will have to use your
email address "@mysite.com" (and in the same way if your site is published on a free hosting or personal web space such as for example Free then
you will have to use your email address @free.fr).

Once your site is perfectly functional on the internet, you can then add an SMTP account in order to increase the reliability of sending your emails or
return at any time to using PHP mail if any problem.


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Web Forms in paragraphs

Captcha

File attachments

Email reception problems

Select an existing paragraph with no object on it or add a new paragraph where to add your (   ) form object . Below the field list use the add,
modify, delete buttons and change the order of the form fields you want to use. Different types of fields are available (text, selection list, email, date,
...) and you can change their properties to your needs (name, size, if field is mandatory or not, ...).

Remark : TOWeb allows you to make your forms compliant with the GRDP (General Regulation on Data Protection).

Then select the type of form to use with the "Form settings" button. From there you will be able to activate or deactivate a captcha on your form.
In order to receive the form content by email you must setup a form action. We advise you to turn and use the i-Service Form of TOWeb ( Settings >
i-Services screen ).

 Mailing list : subscription form and list of contacts)
 Polls : create surveys on your website to get feedback from your visitors
 Comments : authorize visitors/customers to post their comments to a paragraphs, photos or products

Captcha

All email addresses displayed in the text of your website can be viewed and used by internet robots scanning the content of your web site and your
email could by used and spammed thereafter. To avoid receiving spams from malicious robots or scripts or even some visitors, it is first preferable to
use web forms instead of just showing your email address but also to activate visual codes called captcha on your web forms so that only human
beings can send you emails and no web robots. This protection level forms can be activated from screen "Settings > Security & HTML" by using then
option Add a "captcha" code verification to your forms.

TOWeb offers you 3 choices:

1) TOWeb's personalized captcha automatically generates images for you containing a sequence of characters that visitors will have to read and
enter in your forms. In order to ensure that spam bots cannot decode them, you can alter their readability by playing on the different criteria that are
offered to you (sharpness, color, etc.) and use the button to regenerate them.

2) Cloudfare Turnstile service is a free, fast and efficient service, which does not require the transmission of personal information and its use
therefore does not impose any cookie consent for your visitors. To use it on your site, you will need to have a Turnstlme account to be able to enter
your Site Key and your Secret Key in TOWeb.

3) Google ReCAPTCHA service is a free service widely used on the internet that requires visitors' cookie consent  on your site. To use it you must

have a Google account and need to connect to your admin ReCaptcha page . From there, use this "+" button:

and then:
1- enter a label for the name of your site
2- select the "reCAPTCHA V2" option
3- add the domain name of your website where this ReCaptcha will be used (be careful not to put a web address starting with https: // or http: // but
only the name of your domain)
4- accept the terms of use of Google
5- and click on "Submit"
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Once created, you just need to click on the "COPY SITE KEY" button to do a "paste" into TOWeb and proceed the same way with the "COPY SECRET
KEY" button.

Note: if, for a particular form on a topic of your website, you want to disable this you can do it by checking the option "Disable the captcha security
form" located in the properties of the web form you added to a topic paragraph.

File attachments

If you wish, you can add a "File" field to your form so that your visitors can send you a document, photo or other type of digital file.
However, pay attention to the size limit you indicate as it is not because you choose 100MB for example that this will work. Indeed, on the one hand
the maximum size for sending a file via form on a web server depends on that fixed by your host but also on the maximum size per file authorized by
the provider of your electronic mail that you indicated in email reception.
Other tips and recommendations on file transfers between your visitors and you via form:

From version 13 of TOWeb, a form can allow you to send several files as attachments with a single "Attached files" field. Your visitors will

be able to add them dynamically using the "+" button according to their needs, within the maximum limit that you have set. By default, only one

file field is displayed in a form, but if you wish, you can display several file fields (always within the maximum limit that you have set).

In order to reduce the size of the files sento to you by mail (or stored on your web space) you may want to recommend your visitors to send their

files in a compressed format such as ZIP for instance (which is the most common format natively supported by most systems).

For very large files but also for more security (both for your hosting server but also for Internet users who send you their documents) it is best to

inform your visitors to use a cloud or online transfer service (such as https://wetransfer.com for example which is free) in order to provide you

with the direct download link of their files. By adding your instructions in your form as well as a URL field and a password field, your visitors will

be able to communicate to you the download link of their compressed ZIP file as well as the possible password if their file has been protected for

added security.

Email reception problems

Sending your forms is done by default using the PHP mail function of your host but for more reliability it is strongly recommended to send all

emails by SMTP from your site

First, check that you have correctly created your form and entered your email address without typing a typo (character instead of another, space,

...)

Then check that you do not have an active spam filter either in the email software installed on your computer or in your email account by

connecting directly to the website of your email provider (this is the case for most of them such as Hotmail, Yahoo, or GMail). Some spam filters

not only take into account the sender's email address but also analyze the content of emails to determine if it is a spam or not and can

sometimes wrongly consider some email issued from your site as spam. In general, such filters simply place these emails in a special folder

(spam, junk, ...) to allow you to consult them and correct any errors if some email should not be placed there. If your anti-spam is configured to

systematically delete unwanted emails then deactivate this option in order to keep them.

Also check that no internet security software is blocking the sending of data over the internet. To do this, try to place a test order from your

computer as well as another from a computer other than yours (by asking for example a friend or a person of your family to make a test). If you

receive the content of the form via another computer then the problem comes from the configuration of your internet browser or a security

software responsible for blocking the sending. In this case check the internet security options of your browser and restore the security options to

normal or default level. If this still does not work, temporarily disable your computer's security software (antivirus, firewalls, etc.) in order to

identify which one is responsible for the blocking, and refer to their documentation to authorize sending form data from your site.

Check that you have activated the i-Service Form .

IMPORTANT : If you are using a version 4 or older of TOWeb, as announced in May 2020 in the TOWeb blog and effective since July 2020, the
emailing service of lauyan.com is now stopped for orders and forms as well.
To be able to continue receiving emails from your site with your old TOWeb version, you will need to select the "form to mail i-service" option
(indicated as being the recommended one) located in the "Options > e-Commerce > Submitted orders configuration" screen, and then republish your
site.
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TOWeb e-Commerce functions

Shopping cart

Shipping Prices & Deliveries

Online Orders

Click and Collect

Tracking status of your orders

Customer accounts

Payments

Payments updates

Taxes & VAT

New VAT rules in Europe since 2021

Terms of Sales

Coupons rebates codes

Back office

Shopping cart

The shopping cart function allows your customers to add different products to their shopping cart before to order. A shopcart button is present on
every pages of your website (generally on the top of your page depending on your theme), The shopping cart of your website is also accessible from a
text link placed in any of your product pages. The functions of the shopping cart are only used if you both activate the price and shopping cart options
of your catalog from the Design and layout tab.
If you do not have TOWeb e-Commerce Edition (or a TOWeb Studio Edition) but activate the shopping cart on your catalogs then your site will
operate in demonstration mode (order email notifications without customers information, shopping cart limited to 3 items per order and demo
messages displayed in your shopping cart and payment pages to indicate that this is a demonstration).

e-Commerce main parameters

The main parameters of your website shopcart can be modified from the "Shopcart button (  ) located in the TOWeb e-Commerce step. This screen
contains different tabs where you will be able to :

customize the shopping cart buttons displayed on your site : icons and texts of order steps

set a the minimum & maximum amount per order (leave value to 0.00 if you do not want to set a limit)

specify the name or symbol of the currency (USD, $, EUR, €, ...) shown in the products pages of your catalogs and during the checkout where

prices appear. select where to display the currency (before or after the amount values) and the decimal precision of all prices that can be 0 (eg

for Yen) to 3 decimal places (eg for Tunisian Dinar). The currency set by default to your shopping cart is USD but you can change it any symbol or

any name. This is only sued for display on your web pages. If you use online payments such as PayPal for instance (if you use it) you may verify

that the currency you want is supported by each payment and that it is the expected one that is selected

customize the symbol or name of weight unit displayed in the orders (if you use this option) and a possible minimum & maximum weight to
your commands (leave value to 0.00 if you do not want to set a limit)

use one or more delivery modes on your site with shipping price rules set according to the weight, the quantity or the amount of the order as

well as countries

use a real time stock  and directly update the quantities of your products from the back-office of your site

display or not information & icons about the availability of your catalog items ("In Stock", "Available in 7 days", ...) shown in both your catalog

items pages as well as in the shopping cart. If you choose to disable this option, the availability will not be shown except for the items "Out of

stock" with a stock of 0

enable or disable the option "Notify customer every time a new item is added to the cart". This message appears only if the item is not already in

his basket, if it already exists its quantity will be increased but without any other message. The items quantities may be increased, decreased and

deleted later by viewing the contents of the shopping cart

use discount coupons
apply decreasing prices depending on the quantities purchased

sell digital product to download

Your Organization

From the button (  ) About your store located in the e-Commerce step you need to enter the name, the address and contacts of your company.
These information will be displayed in the order and you can also reuse them inside the instructions of your online payments.

How to install a shopcart ?

You just need to have or add at least one catalog on website with the shopcart option activated on it. And that's it. For more information please see
how to add & manage catalogs of products .
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Shipping Prices & Deliveries

Configure the Countries (and States) where to sale
You first need to select the list of countries/states where all your catalog products can be sold from the Country management button located in the "e-
Commerce > About your store" screen. And thereafter, if needed, at the product level you will also be able to select among your countries selection in
which countries /states a specific product can not be sold using the Excluded shipping countries field located in sidebar panel of you catalog product.

Configure shipments & fees depending on weight, amount or quantity
The management of shipping fees require to activate and create at least one shipment. TOWeb offers some predefined shipments from the USA (UPS)
and from France (Chronopost Collissimo, Fedex) that you can add and change thereafter to adapt them to your delivery zones and shipping fees
schedules. You can also start a new shipment from scratch and then let yourself be guided to its creation.

For each shipment you can add a new delivery zone so you can then establish your shipping fees schedules depending on the country of your
customers (and more precisely states & provinces for the U.S. & Canada). A delivery zone may contain one or more countries & states and each zone
has its own shipping fees schedules which may depend on the :

the total weight of the order

the total amount of the order

the number of products of the order

In either weight, quantity or amount mode you need to set shipping fees schedules by entering all the its different limits and amounts.

IMPORTANT: If you decide to use multiple shipping fees schedules such as based on weight but also based on the amount of the order, the lowest fees
who always be the one applied to your costumers' orders (and not the sum of the fees like it was in previous versions of TOWeb). It thus becomes
possible to define such standard shipping fees based on weight and simultaneously indicate that the shipping costs are free from a certain amount
ordered.

For example, suppose you want to apply different shipping charges depending on the total amount like this : free shipping fees for any purchase over
$50. And a $10 shipping fees for any purchase lower than $50. To enter this in TOWeb will need to begin to add your first amount: 10. And then enter
your limit price of 50 and the amount of 0 (zero) before to click the "Add" button. In the end you will get the following result displayed in TOWeb :

If the order amount is > $0 then shipping amount is = $10
If the order amount is > $50 then the shipping amount is = $0

To update the values you added, you must select the line in the grid and change the values before to click the "Modify" button or use the "Delete"
button to remove it. You can also fix a maximum which means your shipment will not be used and will therefore not be proposed on your website
among the possible shipments when orders are above this maximum. For example if your carrier does not allow deliveries over 50 pounds you need to
specify this value at "Maximum weight". And if in contrast starting from 30 pounds the shipment costs is for example $3 per extra pound then you
need to entered this value in the "Additional linear price" field (30 pounds will then no longer be a limit but the threshold from which your shipping
costs will become linear). In addition to these limits specifics to deliveries, you can also set the weight and price limits on your shopping cart .

Finally, if you want you can also :

Apply multiple Taxes to each delivery zone defined in your site. Creating and modifying your e-commerce taxes of your website can be done

from the button "Taxes (VAT, sale taxes,...)". Taxes are predefined in TOWeb for all ECE countries (VAT), Canada (GST, PST & HST) and the USA

(Sale Tax) which allows you a quick start. The price of your e-commerce site can be entered and displayed with taxes included (B2C) or taxes

excluded (B2B).

You can manage multiple taxes rates, in % or fixed and then apply to each product of your catalogs its own taxes. Once created you can also

apply different taxes to your different shipments.

Manage products with no shipping fees ie items whose prices will not be included in the total amount of the order when calculating shipping

charges, by indicating a weight of 0 in level their "Stock & Price" tab if you only defined shipping fees schedules otherwise by setting them as a

"service".

Defining modes of delivery which will not concern the total order but a separate delivery mode for specific products. For example, a user "TV

delivery carrier" that can apply to the sale of an TV product, which will therefore not be taken into account to calculate shipping costs of the order

but will be delivered separately from the rest of the order. To do this you must first select your shipment and assign it the "separate delivery for

specific products" option and then, under the "Stock & Price" of your product, select this shipment in the "Cust. Shipmode" list.

Incorrect Shipping prices in your Orders
Check the following points :

if you set shipping fees based on weight then make sure the weight values you have specified in your products (and any sub-products) are

correct in particular that the decimal "." is correctly placed and consistent with the weight unit you set in the shopping cart,

you do not set different fee shipping schedules in one or more deliveries zones because if this happens the cheaper rate will be the one applied to

the customers' orders,

that limits and amounts you listed in your fee schedules do not contain wrong values and that they comply with the recommendations and

examples previously listed on this page.

Online Orders

Configure email orders
If your host supports PHP scripts and sending emails (which you can test from step 3/5 of the hosting configuration wizard accessible by CRTL  +

F8 ) then we advise you to activate and use the i-Service Form at the "Options > i-Services" level in TOWeb and then simply indicate the email
address for receiving your orders (which will also be the one used to send them). A script will then be automatically generated on your web space and
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used to email all the orders coming from your e-commerce site.

Orders & Customers information fields displayed in your payment texts
You will find below a list of all field names that you may need to reuse insinde the payment instructions :

{OrderID} : order number
{OrderTotal} : total amount of the order
{OrderDate} : order date
{ClientName} : fullname of your customer
{ClientEmail} : email address of your customer
{ClientPhone} : phone number of your customer
{ClientFirstname} : firstname of your customer
{ClientLastname} : lastname of your customer 
{ClientAddress} : address of your customer (number and street name only)
{ClientAddress2} : additional address information of your customer
{ClientCity} :  city of your customer
{ClientPostalCode} : postal code / ZIP code of your customer
{ClientCountryCode} : 2 characters code of your customer's country (code ISO 3166-1)
{ClientStateCode} : the 2 characters code of your customer's state/province (if countries is USA, Canada or Brazil)
{SiteLang} : language of your website used by your customer

As well as information about your company/organization for use in any text of your site, like for instance in a paragraph of a topic but also in your
payment instructions :

{ARTICLES} : the list of articles contained in the order
{OrganizationName} : name of your company/organization (editable from Settings>e-Commerce>Your organization)

{OrganizationAddress} : address of your company/organization (editable from Settings>e-Commerce>Your organization)

{OrganizationContact} : contact information for your customers (phone, email, fax, mobile, ...)

{SiteUrl} : the URL of your website

Click and Collect

The Click & Collect is managed in TOWeb as a delivery method and works in conjunction with the new Backoffice order status tracking system. This
delivery method includes a single free delivery zone by default as it is generally the case in the majority of businesses but if necessary, you can apply
or not additional cost rules for example depending on a certain weight or amount of the orders.
To add Click & Collect to your e-Commerce site, you need to click on "e-Commerce > Shipments" then on the "Add a new shipment" button. From
there, select the "Pickup / Drive" choice from the list of predefined delivery methods and just confirm with OK.
Then you will need to customize

the information of this delivery method, i.e. the icon and the name which will be displayed to your customers when ordering from your site

information about your delivery area (Our store), that is to say essentially the description explaining to your customers how your Click & Collect

works (ie. your opening hours, that they will be notifications by email, ...)

Once your click & collect has been added and your site published online, all Click & Collect orders placed by your customers will appear directly as
"Ready to pick up" in your Backoffice from where order status changes can be made to keep track of your orders .

Tracking status of your orders

From the backoffice of your site you can monitor and modify the status of each order with the
possibility also of informing your customers by email upon the change of status of their orders.
To do this, you just have to click on the caption of the order status and choose its new status
among those available (awaiting payment, payment accepted, in preparation, ready to collect,
sent, ...)
By leaving the text of the notification message empty, only the change of status of your order
will be made but if you add a notification message then it will be sent to your customer for
example in order to communicate the tracking number of his/her package during shipment or
to inform your customer that his/her order is ready and can be picked it up at your point of sale
if your e-shop supports Click & Collect .

Customer accounts

When shopping from your e-commerce site, your customers can now create or connect to their customer account. The creation of an account is not
obligatory for your customers in order not to lose sales with possible users reluctant to this. The advantages for your customers are in particular to be
able to have a history and a follow-up of all their orders, to be able to cancel them or to notify you upon their good delivery, not to have to fill each
time their names, contact details of deliveries and/or billing when they return to your site but also to be able to benefit from individual rebate coupons
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that you can offer them. The use of individual coupons is a way to retain your customers by
giving them discounts that only they can use such as a credit note, a loyalty discount coupon, a
discount voucher on their next purchase and thus encourage them to come back and buy from
your site again. 

From the Back-Office of your site, you can view the total amount of the purchases of your
different customers, you connect as administrator to a customer's account to add one or more
individual discount coupons (can be used only once), delete active accounts as well as those
that have not yet been activated. The size of the button in your theme can be adjusted in the
"size" field located in the "Font" tab and its margins in its "Box" tab to better adapt to your
theme.

Logging in to your customers' accounts as an administrator
By clicking on a customer account from your Back-Office you are redirected to the customer accounts login page with a pre-filled email address
starting with "admin! =" where you will need to enter your own administrator password (which can be viewed in TOWeb from "e-Commerce >
BackOffice" if ever you have forgotten it) to be able to connect as administrator to the account of this customer, for example to add an individual
discount coupon.
Notes:
- by default "admin" is the administrator login name of your Backoffice, but if you have changed it, it is your login name that you will need to use
followed by the two characters "! ="
- If you create and use a test account yourself, remember to disconnect from your test account beforehand, otherwise it is this one that will be
displayed.

Payments

PayPal is the payment proposed by default in TOWeb which also accepts credit cards (Visa, Eurocard-Mastercard, American Express, ...) in addition to
money from PayPal users accounts. If you do not have yet a PayPal account, you will need to sign up for a new PayPal account from their website.
Then indicate in TOWeb the information of your PayPal account , verify under the "Mode" tab that the currency otherwise update it and that's it, your
website will then be ready to go with the PayPal payment service ! If you want to customize this payment, you may change its description (displayed
among the list of payments available on your website), the instruction message (displayed before the payment button) and the payment button.
By clicking on the "Payment return" tab you may also the return addresses to your website if you want your customer to be able to return to your
website after proceeding to their payment or canceling it.

From the "Payment modes" link you you can add other payment modes to your shopping cart like check or wire transfer with the (   ) button located
below the payments list in the shopping cart payment configuration dialog box. If the off-line payment you are looking for is not present in the list
(check, wire transfer, Western Union, MoneyGram), you will need to add one (the closest to your needs) and customize it like for instance starting with
the Cash or Western Union template and update the instructions for your new payment mode.
If you want to use another online credit card payment service than the ones predefined in TOWeb (Stripe, PayPal, MoneyBookers, Ogone, Paybox,
PayZen, WorldPay, PagSeguro, Klik&Pay, SystemPay, PesaPal, JamboPay) like for example the credit card payment service of your bank, you need to
add a "user payment script" and copy/paste your HTML redirection form into the field located under the "Payment script" tab. The creation of your own
payment scripts requires advanced web programming skills on which no support will be made by Lauyan. The development of your payment script is
not assisted by TOWeb and such script adapted to your needs will NOT be provided by the Lauyan support. To obtain such payment scripts, ask them
to your payment service provider and have them customized to your needs by their services or by yourself. More information about other payments.

For each payment method you can also assign additional fees that can be systematic or based on customer's country. This may be necessary if for
example your bank applies additional charges for some type of payments such as checks coming from foreign countries.

Payments updates

Payment methods can evolve and be updated regularly across the different versions of TOWeb. If you have created and added a payment with an older
version of TOWeb and this payment is updated later on, then you must use not only the latest version of TOWeb but also remove this payment and re-
create it by adding the new one to your site.
Sometimes payment improvements are either optional or concerning a feature you may not use on your site. If this is your case and if your payment
is still perfectly working on your site, then it is not necessary nor required to update it.

Taxes & VAT

Creating and modifying your e-commerce taxes of your website can be done from the Taxes button (  ) acessible from the e-Commerce screen.
Taxes are predefined in TOWeb for all ECE countries (VAT), Canada (GST, PST & HST) and the USA (Sale Tax) which allows you a quick start. The price
of your e-commerce site can be entered and displayed with taxes included (B2C) or taxes excluded (B2B).
You can manage multiple taxes rates, in % or fixed and then apply to each product of your catalogs its own taxes. Once created you can also apply
different taxes to your different shipments and for each product select which taxes will be applicable to it.
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New VAT rules in Europe since 2021

Since July 1, 2021, European Union (EU) companies that sell services or goods in the EU must apply the VAT rate of the customer's country and no
longer apply the rate of their country store. For example if you are a company based in France and you sell items in Germany, the customer will have
to apply the VAT of his country, therefore German of 19% and no longer the French one of 20%. And you will then have to declare online to the OSS
"one-stop-shop" (an online tax service available for each country) your VAT per country.
Micro-enterprises established in an EU country whose annual sales do not exceed € 10,000 over the last two years are exempt and can continue to use
their local VAT rate and remit VAT to the local tax administration.For all other sellers in EU you will need to :

1. complete a single VAT return through the OSS one-stop shop . Registering at this one-stop-shop facilitates the declaration procedure and avoids

having to register with the tax authorities of several countries,

2. create as many VAT rates as there are EU countries to which you are selling. That is to say that if until now you used for example a tax rate of

20% applied to all the countries of the euro zone and sell in Germany and in Spain, then you simply need to create the VAT rates applying to

these 2 countries from the "e-Commerce > Taxes" screen of TOWeb.

If the impact of these changes is not clear, we advise you to contact the European Union or a tax advisor.

Terms of Sales

Among the topics of your web site appears in the last position of the list a special topic that may contain your terms and conditions . If in the order
form of your e-Commerce website you want your customers to read and accept your terms of sales then a link to that topic will be created
automatically to display your terms of sale in overlay so that your client can read them before to continue their order. A link to this page is placed by
default in the footer of your site.

Coupons rebates codes

You can create and manage rebates and coupons from the Rebates button accessible from the e-Commerce step. By enabling this option and adding
one or more rebates you will be able to enter any code that you will communicate to them so they can have price rebate on their purchase. The rebate
can be either a fixed amount (eg $5 discount on a purchase) or a percentage of the amount (eg. 5% rebate) or a quantity offer (eg. 1 item free for 3
purchased). And if you want a coupon to be no longer valid you can specify a validity period (with a starting date and/or an ending date), enable or
disable it before republish your site to make your changes effective on Internet.

A reduction may be either "global", meaning applicable to the total amount of the shopping cart or "local", meaning applicable to just a product or
several products (by entering several references). Depending on the coupon, its "value" and its "minimum" shall have the following constraints:

a rebate applicable to the total amount of the shopping cart may have a value amount or a % (but no quantity) and its minimum is always an

amount.

a coupon rebate applicable to one or several products can have a value amount, a % or a quantity and its minimum is always a quantity (not an

amount).

A rebate can be automatic or with a coupon:

an automatic rebate is always applicable to your shopping cart and your customer doesn't have to enter any coupon (just leave empty the field

"coupon code" to have an automatic rebate). If you enter several automatic rebates they will be cumulative, meaning they will all be applied to

your shopping cart

a coupon rebate applies only if you specify a coupon code and the customer has entered it while ordering from your site. Only one coupon can be

applied during an order.

Tip : Share your coupon with your visitors by sending a promotional email to maximize your revenue !

Back office

You receive all the orders of your customers by email but TOWeb also allows you to use a back office, that only you as an administrator can use to
view and manage your orders of your site. To use this back office, you will need keep your orders on your web space meaning that you have to

activate the option called "Save an order copy to your web space" accessible from the Back-Office (  ) button of the e-Commerce step. From this

screen where you can set / change the administrator user name and its associated password and click the link to " view, retrieve or delete the latest
order files saved on your web space". Once connected to your back office , a summary of each order is displayed and you can retrieve your commands
in text format ( if you ever encounter a problem with the e-mail and your email account for instance) as well as in HTML format (if you ever want to
use the links to a printable version and/or as a reference to use when contacting your customers or if you simply want to reuse the HTML page of
these orders) .
Note: If you make a configuration change in TOWeb at this level such as enabling or disabling the orders to be saved on your web space or a change
of admin password, then you will need to republish your website to make this changes effective in your backoffice.

From your backoffice your can see the list of all the orders of your shop with a summary of each one, like in this example :
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From there, by clicking on the "TXT" link you will open the text version of the order (the one you also receive by email) and by clicking a line it will open
the html version of the order, like this one for example :



If you sell digital product you may need to also see the backoffice of your e-commerce downloads . 

For more information see also :

Online Stock in real time and/or manually managed

Sale of digital products

Catalogs, products and sub-products

Cross selling / Up selling

https://www.lauyan.com/en/download-file-sales.html
https://www.lauyan.com/en/catalogues.html#stock
https://www.lauyan.com/en/download-file-sales.html
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Products & Catalogs

Add a catalog of products

Manage products & sub-products

Cross selling and up selling

Update your Online Stock

Predefined texts such as "Lorem ipsum" in products of catalogs

How to update the descriptive summary of a product?

Add a catalog of products

From the Topics screen top toolbar click on the Add a new topic button (  ) and select the catalog option. Then choose how to start your catalog,
give it a name (that will be displayed in your menu) before to start to create it.

If you have numerous products it is advisable to try to place them into several catalogs rather than using only on large catalog. All catalogs will use
the same shopcart of your website so you may create as many catalogs as needed to best organize your e-commerce website. You can duplicate a
product into a catalog or even into another catalog (which can be use to move it elsewhere) and also duplicate a catalog (from the "Add or duplicate
an topic" button below the list of site topics).

Enable catalog prices

If the option "Enable prices for the catalog items" is activate for your catalog prices will be displayed. For each product you can enter : its price, its
strike out price (former price) and its reference. This information will then be displayed in each product page of your site. The reference can be hidden
or displayed from the "Design and layout" tab of your catalog. If you only activate price for a catalog, you will only have the functions mentioned
above, meaning that the products shown in your catalogs will not be ordering from your site, that you will not be able to manage or display their
availability nor create sub-products. Doing this will need to activate the shopping cart and use the e-commerce functions.

Activate the shopping cart

If the option "Use a shopping cart for this catalog" is activated then visitors will be able to add products use the shopcart and order the products of
this catalog. If you do not have an e-Commerce license of TOWeb then your e-Commerce website will then run in demo mode (not operational). By
enabling the shopping cart on a catalog, you can customize all the following information for each product :

the product type which can be either a product (with its potential by-products) or a service or a file. A service or a file for sale will have no

stock and will not be subject to shipping delivery when the product will be

taxes & VAT applicable to your product

the stock of your product and the status to display on your site (out of stock, available in 7 days ...) when the stock is 0 (zero)

the maximum quantity per order for your product (if you have not specified a limit but specified a number in stock, this value in stock will

become the limit per order)

the weight of your product if you manage shipping prices and delivery modes as well as its potential personalized delivery (Cust. shipmode)

the list of countries where your article will not be available for sale otherwise. By default it for sale in all countries you designate in "Settings >

e-Commerce > Country management".

Manage products & sub-products

Once in your catalog you can access main catalog function from either the PRODUCTS menu or a right click inside your catalog, The Arrange (  )
button for instance displays your catalog products into a grid to facilitate the update of their information. You can view and easily change their prices,
references, stock status indicators, fixed shipping fees as well as their quantities.
To edit and modify any information in this grid you can either select and click on the cell or press the F2 key.

The catalogs of your e-commerce website can contain 3 types of product :

product : a object or item for sale for which you may need to define for example its stock, weight and shipping prices

services : a product with no stock, no quantities and no shipping prices

file : a digital product for sale

The name of your product is present in your product page and is mandatory. Presentation and information related to your products are accessible from
on left sidebar containing 3 panels : "Paragraph Layout" containing presentation options to display your product or current paragraph, "Picture" to add
one or several pictures of your product and the "Price and stock" containing all your product information : type of your product, its reference and
price, an optional strikeout price, the applicable tax of the product, its quantity (leave blank if unlimited), any limit per order, its weight as well as
excludes countries (countries where the product will not be sold).
A reference codes of your catalog items are automatically generated by TOWeb with a number according to the catalog position in your site and
position of your product in the catalog. If you have your own references or don't want them to change when a product is moved that you will need to
enter your enter you own product reference, a unique reference code per product.
See also shipping prices & shipments

Sub-products
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On the left sidebar click the Sub products button to add and customize all the different subproduct categories of your products (colors, sizes, ...).
There is no limit to the number of categories that can be added nor the number of their possible values. If you specified a price and a weight for your
product then you can specify a price offset and a weight offset for your sub-products. You may also activate the "Customize the information of the
item" option to specify for each sub-products its own stock, reference and name. If no value is specified (if you leave a field blank) the value defined in
your main product will be the one used for your sub-product.
In addition to the button to "Edit category" and "Delete category" another button lets you duplicate a category. To do this click the button "Copy
category to clipboard" and then click the "Add a Category..." button (the one of the same product or another) and among the menu selection that
appears select "Paste from the clipboard".

Cross selling and up selling

Related products (also known under the names "cross selling" or "up selling") are automatically generated and displayed at the end of a product page
in order to offer your visitors suggestions of other products that may interest them. The use of related products requires having at least an edition of
TOWeb e-Commerce. Relations between your products should be defined from the related products' window accessible either from the button located
in the "Price & stock" section of a product, or from the screen "Options > e-Commerce > Related products". By using the related products you can
make "cross selling"  (suggest additional product than the current one, for example proposing the article "memory card" on the sheet with a camera)
and "up selling" (other products suggested that are more expensive than the current one).

Update your Online Stock

The quantities of products available for sale in your catalogs can be:

automatically decremented in real time on your site upon each order of your customers and then updated online directly from the "Stock" back-

office page of your website (accessible from any computer, tablet or smartphone connected to the Internet using your admin login and password)

or managed manually from TOWeb (which requires republishing every time your site after each update) according to the orders you received by

email.

Real-time stock & online updates

Real-time Stock can be activated from the "e-Commerce > Stock" screen.
The initial quantities used by your site will be those you have defined in TOWeb for each of your products and which can also be modified manually
from this wizard. Your site will therefore need to have been published at least once with initial quantities defined and the "real-time stock" option
activated to allow you to make stock updates not anymore from TOWeb but directly from the Internet using your Back-Office Stock page.

Overview of the "Back-Office Stock" page to update the real-time product quantities of an e-Commerce site:

If needed, the "Reset" button will allow you to restart with the product quantities you have defined in TOWeb. The "Stock (TOWeb)" column displays
the values corresponding to the values present in TOWeb ( the last time you published your site) and the "Stock (online)" column to the current
quantities on your site. The "Filter" option allows you to reduce the displayed list to a selection of products by entering for example a product
reference or a word present in the name of your product.
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Finally some orders may not always lead to a sale (customer making errors several times the same order without finalizing the payment, orders sent
but payment by check or bank transfer never received, etc.) so you will have to make the updates Online from your Back-office Stock web page based
on the actual payments you received (by check, credit card or bank transfer).

Manual update of your product quantities

If you choose not to use the "real time stock" option on your site but prefer to manually manage the quantities by yourself exclusively from TOWeb
and republish them when you want, then the stock update wizard allows you to update the quantities you have defined for your items by
copying/pasting each order received by email.
Suppose for example you have 2 products in your catalog: an item A with a quantity of 10 and a item B with a quantity of 20 and order from your site

2 items A and 4 items B. In the order email you received make a "copy" of the entire content of your email and paste it in the wizard. The wizard will

then show the new decreased quantities of your items A and B (to display a quantity of 8 for item A and 16 for B in our example) and ask you to

validate or modify these quantities.

Note : since version 13 of TOWeb, the stock update wizard no longer offers manual updating of your quantities by catalog, which can now be done
more quickly and easily from the "e-Commerce > Products" screen.

Predefined texts such as "Lorem ipsum" in products of catalogs

You use catalogs of products for which you see text such as "Lorem ipsum ..." appearing in related products as well as in the results of the local search
engine of your web site? This is because you have not filled yet any descriptive summary for your products but still use some predefined default text.
To fix this you need to update the summary description of each product .

How to update the descriptive summary of a product?

From the step "Topics", Select your catalog and in its topic properties, change the display of "Index Pages" in order to see the descriptive summaries
of your products inside the page index. Once these texts are editable you can update them (or delete the ones proposed by default), before to change
back the display of your catalog page index. The descriptive summaries of your products you define from the index page will be those appearing in
your related products and will also be taken into account by the local search engine of your site.

For more information see also :

The Back-Office of your e-Commerce site

Shopping cart & e-Commerce features
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Sales of digital files

Add a download file for sale

Online order process for digital downloads

Configuration of the digital download sales

The backoffice for the orders of download files

Delivery of the download files

Tests of download files on your e-commerce site

Add a download file for sale

A digital product available for sale in your e-shop is a product that can be added in any catalog of your site but for which you must select the option
"File" for its "Type" (located in the section "Price & stock" of the product).
Then you need select and add the digital file you want to sell and eventually re-select it to update it when needed by using the "Browse" button. The
name of your file will be added and used as "internal" meaning that the file that will be published in a secure directory of your web space using this
name. But the name of your file as it is seen by your customers when then will download can have a different name (and this is recommended to
strengthen the safety of downloads on your website).
The choice of the "internal" name of the "Download File"  you add into TOWeb is important and keep it always the same if you need to update it with a
new version  of this file. Because if you ever change the internal file name of a product then all your previous customers (those who bought it just
before your changes) will no longer be able to download this product. So once you have create added a new download file be sure to always update it
later one with the same name otherwise it will be considered as a different product with a different filename on your web space. However the file
name "as seen by customers" it can be changed later at any time and without consequence.

Online order process for digital downloads

The purchase process works the same way as a normal product unlike there are no shipping costs applicable to a product file. Your buyer can therefore
add to the shopping cart one or more digital files available for sale on your site, but also other hardware products if you sell both types of products.

Configuration of the digital download sales

The configuration of e-Commerce downloads can be done from the screen "Options> i-Services> e-Commerce Download: online sales of files to
download". The main options there are:

The possibility to be notified by email if any problem occurs

The ability to set or not the maximum number of times a buyer can download a purchased file on your site and/or set the maximum download

period for any purchased file from your site

The "convert each download file to a ZIP file" can be used to reduce the size of your files on your web space. This can be advantageous for you as

well as your customers, but they will need a file decompression tool in ZIP format (usually present on most systems including those Microsoft

Windows). But beware, because if you use this option then you will have to always keep it and never change it later on, otherwise your previous

customers (those who purchased uncompressed files) will no longer be download the files they had purchased at the time your site was using

non-compressed files

The ability to customize the title and text of the email that will be automatically delivered to your customers. This email will contain the specific

download links to every customer for his order. Following field names may be used inside text & title of your delivery email and will be replaced by

their value as defined below

{OrderID} = Customer order number

{ClientName} =  customer name

{DLFILES} = the list of digital files purchased by customers with their specific download links

The possibility to access to the backoffice of your files in order to edit the digital orders, delete or disable the download of a particular order or to

process to a manual delivery of digital orders.

The backoffice for the orders of download files

The access to the backoffice of digital file orders can be done from the screen "e-Commerce > Backoffice". When access is made from this link inside
TOWeb no user name nor password will be requested. However, if you try to access by yourself directly to the URL of this backoffice inside your web
browser, then your administrator name and your password will be requested.
Once connected to the backoffice of your site, the orders containing file products will be displayed a list, where each order has :

either a state "off" symbolized by a red cross (  ) indicating that the payment of the order has not been received and therefore its downloads

are not possible/not authorized

either an "on" with a green marker (  ) indicating that the payment of the order to been received and that your customer can download the

purchased files. When the downloads are possible the name of the file is displayed inside a link and this link is the download link to communicate

to your customer (each link is unique to each order). If a customer did not receive your email with his/her download links then simply do a right-


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click from the file links of his/her order at this level to perform copy/paste to deliver them again to your customer. For more information also see

the delivery of digital products .

The possible "actions" are the following :

use the buttons (  ) and (  ) to change the download states respectively "on" or "off" on each order.

use the button (  ) to edit a command and be able to

update its download counter. This counter lets you know how many times your customer has downloaded the file that he bought. So you

may decide to disable his/her download links at this level if you ever see an abnormally high number of downloads due to a fraud (if your

buyer has communicated to others persons the download links).

update the expiration date of the control downloads in order to prevent any risk of fraud in the malicious buyer with a shorter download time

period and/or to reapply the download possibility of a purchase orders that was expired.

use the button (  ) to delete commands. Attention because the suppression of the order will be final, meaning that the person who placed this

order can no longer perform the file downloads, it has purchased (in this case, your client will have to place a new order and / or make a new

purchase order to get back its download links).

Delivery of the download files

Delivery of digital products is done by communicating to your customers secure links on your site that will be unique and specific to their order. This
delivery can be performed automatically and/or manually from the back office depending on the type of payment used and/or depending on your
needs.

automatic delivery is only available for payments supported by TOWeb offering IPN capabilities (meaning that your payment system can notify

by calling script after payment) that is to payment systems such as PayPal , Stripe, PayBox or iDeal. For other payments, including any deferred

payments (check, wire transfer, cash, ...) the delivery shall be made manually via your backoffice.

manual delivery and consultation of all the digital purchase is made from the backoffice of your site accessible from the link located in the

screen "e-Commerce > BackOffice > Downloads". From your backoffice you can manually activate and proceed to delivery of an order but also

get the download links of any order, edit and permanently ban downloads or even permanently delete the order.

It is important to note that the download links are specific to an order, meaning that even if two different people are buying the same file, their
download link will not be the same. Therefore if you manually communicate by yourself a download link to a person make sure to communicate the
correct link of his/her order.Finally TOWeb does not handle the billing part of your business/company so you must therefore manage this yourself by
sending to your customers their bill either by post or by email.

Tests of download files on your e-commerce site

To test the digital products on your e-commerce website we advise you 

to put one or several products "file" in a catalog that you will protect with a password during all your testing time and/or not put any link in your

menu to this catalog so that no one can see nor purchase them while under development

to publish your site and access your test catalog from which you will order one or several of your digital products

and then connect to the backoffice of your site to view your digital orders, see and test the downloads links, proceed with manual delivery,

change or delete your orders.

IMPORTANT: if your files are unreadable/unusable once downloaded, make sure that file compression has been deactivated on your web server by
using the tools of your host provider and/or by asking your host to perform this verification and modification for you.

 




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Online Bookings

Adding an online booking system to your site

Configure the booking widget

iCal/ics import and synchronization

List of placeholders

Track your online bookings

TOWeb's booking system allows your visitors to reserve time slots, overnight stays, services, or resources directly from your website. Bookings are
automatically recorded, and confirmation emails are sent.

Main Features

⏰ Time Slots
Ideal for medical appointments, hairdressers, private lessons, and professional services

🌙 Periods / Nights
Perfect for hotels, vacation rentals, car rentals, and campsites

👥 Sub-resources
Manage multiple practitioners, rooms, courts, and vehicles within the same service

💰 Flexible Pricing (*)
Fixed prices, variable prices, weekend rates, and seasonal rates

📧 Automated Emails
Customizable client confirmations and owner notifications

🌍 Multilingual
Interface available in 12 languages (FR, EN, DE, ES, IT, PT, NL, RU, SV, NO, HU, BG)

(*) = Does NOT include online payment (price display and notification only).
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Adding an online booking system to your site

TOWeb version 14.00 or higher is required to manage a booking system on your site.
To add it, follow these steps:

From the "Sections" section, click the button to add a new topic (   )

Next, select the "Online booking system" category type, then the type:

either "Booking Date" for a booking system for a specific period (hotel rooms, equipment rental, etc.)

or "Booking Time" for a booking system for specific time slots
Give your section a name and select a template from the available options before clicking "Create your section". If none of the templates perfectly

match your business, choose one offering similar services, as you can configure and customize everything to your liking later.

A website can currently only have one booking system. If you need to start over (for example, if you had a booking period system and now want a
time-slot appointment system), then you will need to:
- either use the "Start from a template" button located in the first "INFO" step of your booking widget,
- or delete your booking topic and create a new one.

Configure the booking widget

Your "online booking" section in TOWeb contains a "  Configure widget" button (only present in design mode in the "Sections" step) that allows you
to modify its functionality and predefined text to suit your needs.
The widget configuration process follows the 6 steps described below.

Step 1: INFO
This step allows you to specify the name of your booking system, but also to delete it and start over from one of the predefined models via the "Start
from template" button.

Step 2: CONFIG
This step allows you to define the duration of your bookings, your pricing (if applicable), and specify whether entering your customers' phone numbers
is mandatory or optional during the booking process.
The configuration settings will differ depending on whether you are using a time slot booking model or a date/period booking model.

⏰ Time slot configuration
Appointment slot duration (Required)

Duration in minutes of each booking slot. All slots will be the same duration.

Examples: 15 min (quick consultation), 30 min (doctor), 45 min (hairdresser), 60 min (class), 90 min (spa treatment), 120 min (restaurant)

Price (Optional)

Base price for a time slot. Leave 0 if free or if the price varies depending on the resource (practitioner, room, etc.).

Useful for displaying the price in the widget. Does NOT include online payment (notification only).

Number of people (Optional)

If enabled, the customer will need to specify the number of people in their party.

Used, for example, for: Restaurants (number of covers), group activities, guided tours...

Minimum number of people (Optional)

Minimum number of people required for a reservation. Only available if "Request number of people" is enabled.

Example: Minimum 2 people for a group class, minimum 4 for a restaurant table

Maximum number of people (Optional)

Maximum number of people allowed per reservation.

Example: Maximum 8 people per table, maximum 12 for a group class.

Capacity per slot (Optional)

Total number of people or reservations accepted simultaneously for the same time slot. Leave blank for unlimited.

Example restaurant: Capacity 50 = the restaurant can accept up to 50 covers per time slot (7 PM, 7:30 PM, 8 PM, etc.)

Example group class: Capacity 15 = maximum 15 participants per class

⏰ Date/Period Configuration

Minimum nights/days (Mandatory)

Durée minimale de réservation en nombre de nuits (hébergement) ou de jours (location).

Exemples : 1 nuit minimum, 2 nuits minimum (week-end), 7 nuits minimum (location vacances)

Note : Mettre 1 = le client peut réserver pour une seule journée (arrivée et départ le même jour)

Maximum nights/days (Mandatory)

Durée maximale de réservation autorisée.

Exemples : 30 nuits maximum, 90 jours maximum (location longue durée)

Check-in time (Mandatory)

Heure à partir de laquelle les clients peuvent arriver/récupérer leur location.

Exemples : 14:00 (hôtel), 16:00 (location vacances), 09:00 (location véhicule)


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Check-out time (Mandatory)

Heure limite à laquelle les clients doivent partir/restituer leur location.

Exemples : 11:00 (hôtel), 10:00 (location vacances), 18:00 (location véhicule)

Step 3: SCHEDULE
This step allows you to define the opening and closing dates/times for your reservation system.
Dates for exceptional closures (vacations, public holidays, events, ...) must be entered in YYYY-MM-DD format (ie. Year-Month-Day).
Examples:

2025-12-25 (for Christmas)

2026-01-01 (for New Year's Day)

2026-08-01/2026-08-15 (for the summer period from August 1st to 15th)

Step 4: RESOURCES
A sub-resource represents a specific element that your clients can book within your service, such as: a practitioner in a medical practice, a room in a
sports center, a vehicle from a rental agency, a type of room in a hotel, etc.

For each sub-resource, you can define:
Name: Resource identifier (e.g., "Dr. Dupont", "Room A", "Audi e-Tron")
Capacity (Time slot mode): Maximum number of people (e.g., a restaurant table for 6)
Quantity (Period mode): Number of units available (e.g., 3 double rooms for a hotel)
Price: Specific rate for this resource, with the option to also define different pricing for weekends and/or according to your seasons (maximum 4
possible)

Example of a doctor's office:
• Dr. Doe | Capacity: 1 | Price: $80
• Dr. Martins | Capacity: 1 | Price: $90

Example of a hotel:
• Single Room | Quantity: 5 | Price: $80/night
• Double Room | Quantity: 10 | Price: $120/night
• Suite | Quantity: 2 | Price: $200/night

Step 5: EMAILS
Emails use the same sending system as other TOWeb i-Services (forms, mailing lists, ...). If you have already configured email sending in TOWeb, it
will work automatically with the email account you defined as the default in the hosting setup wizard CTRL  + F8 . You can also define a different
sender email address, but this requires having previously configured an SMTP account.
The subject lines and content of the booking emails sent can be customized as you wish by adding placeholders , which are predefined field names that
will be replaced with the information for each booking before they are sent.
For example, you can add or remove the placeholder {CANCEL_URL} if you want your customer to have a link in their email allowing them to cancel
their booking, or you can omit it and leave, for example, your phone number and instructions for manual deletion that you can then perform yourself
in your back office.
If you leave all email fields blank, the system will automatically use multilingual email templates tailored to your industry. This is a good option if you
want to get started quickly.

Step 6: SAVE
This step is important because it contains a "Save configuration" button that you must use every time to ensure that all the changes you made
during the various configuration steps are saved (otherwise, these changes will be lost when you refresh the page or return to your booking page in
TOWeb).

Before saving your changes, you can double-check the summary of your configuration and also change the colors of your widget and test it. 

iCal/ics import and synchronization

The TOWeb booking widget allows you to automatically import your existing bookings from other rental platforms (Airbnb, Booking.com, VRBO, etc.)
through iCal synchronization.

How does it work?

1. Get your iCal calendar URL from your booking platform (Airbnb, Booking.com, etc.)

2. Paste this URL in the "iCal Synchronization (URL)" field in the widget editor (Availability tab)

3. Click "Test Connection" to verify the URL works correctly

4. Publish your site

Bookings from your other platforms will be automatically imported and the corresponding dates will be blocked in your booking calendar.
Synchronization occurs automatically every time the page is loaded by your visitors (and therefore without any intervention on your part either on
your site or in TOWeb).

Important:

✅ This feature works only in "Periods" mode (overnight bookings)

❌ It is not available in "Slots" mode (hourly bookings)

🔄 Synchronization is automatic - no manual action required after setup

🌐 Data is cached for 5 minutes to optimize performance

https://www.lauyan.com/en/i-services.html
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List of placeholders

The placeholders below can be used in the titles and content of sent emails.

Track your online bookings

You can track your bookings directly from your website's back office page by logging in with your admin username and password, or directly from the
link located in the "Back Office > Bookings" screen of TOWeb.

From the back office, you will be able to view your various bookings, change their status, or delete them.

{ClientName} Customer Name

{ClientEmail} Customer Email

{ClientPhone} Customer Phone

{OrderDate} Booking Date

{OrderTime} Booking Hour

{OrderID} Booking Number

{OrderTotal} Booking Price

{ARTICLES} Booking Articles/Resources 

{PARTY_SIZE} Number of people

{DURATION} Duration of the booking

{NOTES} Customer Notes

{CANCEL_URL} Link to cancel the booking

{SiteLang} Customer language on your site

{SiteUrl} Address of your website

{OrganizationName} Name of your organization (defined in "e-Commerce > About
your store")

{OrganizationAddress} Address of your organization (defined in "e-Commerce > About
your store")

{OrganizationContact} Your contact details (defined in "e-Commerce > About your
store")

https://www.lauyan.com/en/bookings.html#placeholders
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PayPal payments on your site

Accept paypal purchases on your e-Commerce website

Use PayPal Checkout V2

Operating issues during PayPal payment

Create a custom button PayPal "Donate" or "Buy Now"

Accept paypal purchases on your e-Commerce website

TOWeb integrates natively and by default the PayPal payment system so that your visitors can make purchases by credit cards on your e-Commerce
website.

The payment system PayPal accepts and offers different types of bank cards (Visa, Eurocard-Mastercard, American Express, ...). Using the PayPal
payment system for your e-commerce site, your visitors will have the choice to either pay by credit card or by their PayPal account if they have one.
Registration in the payment system PayPal is free, there is no subscription, fees are only levied on every purchase (see www.paypal.com site for more
information about the offers and conditions their services).

You can now create your PayPal account since www.paypal.com site and then indicate your email account TOWeb address at the "e-Commerce>
Payment modes" screen to use this payment system to your online e-commerce site.
See also other supported payments .

Use PayPal Checkout V2

PayPal Checkout V2 is the new version recommended by PayPal for all purchases made from e-Commerce sites and it is also the one now available by
default in TOWeb 14. In addition to offering more security as well as the choice between 2 purchase buttons (via PayPal or credit card), this version
will also allow your customers to make their payments in several installments. You will therefore be able to maximize the sales of your products to
your customers, including those with low budget and wishing to be able to spread a payment over several weeks.

If you previously used PayPal Standard on your site created with TOWeb 11 or a previous version, you will need to delete your PayPal payment and
then add it again with the latest TOWeb version. And if you were using a PayPal Personal account, you will need to migrate your account to a
Professional one.
Using PayPal Checkout V2 requires knowing and using your PayPal "Client ID", an identifier that you can obtain from the PayPal website by logging in
to your PayPal account and clicking on “Developer”. From this developer screen you can then use :

the "Sandox" mode which is PayPal's test mode which will allow you to simulate payments from your site to test it

the "Live" mode which is the normal mode allowing you to accept "real" payments on your websiteby PayPal or credit card

From there, go to the API Credentials page of your account to find your "Client ID" (or create a new one using the API APP options) that you will need
to "copy" (using the "Copy to clipboard" button located next to it) and then “paste” into TOWeb at the appropriate “Merchant Account” tab.

Note: if you previously had a PayPal account for personal use then only "Sandbox" mode will be offered to you to carry out your tests. To use "Live"
mode and accept real payments you will need to activate "Live" mode and upgrade your account, either by migrating your account to Professional, or
by creating and using a new Professional account with a different email address.

Operating issues during PayPal payment

If during the PayPal payment from your PayPal site you find an error check the following:

If you have activated the option "Upload customer information to PayPal", make sure that you have left ALL necessary customer fields on your

order form: Name, First name, Address, City, Postal code and Countries with both the options "Use" and "Mandatory". If you have

deactivated one or more of these fields, then you will have to activate them again from the "e-Commerce > Order form > Standard fields" screen

or you will have to deactivate the option "Upload customer information to PayPal" because PayPal does not accept incomplete information

Some security upgrades imposed by PayPal effective since 2017 may impact your site:

1. The first measure impacts only TOWeb e-Commerce sites when selling downloadable digital products (ie sales of music files, photos and

other types of downloadable files only). If it is the case of your site then PayPal obliges you to use the HTTPS protocol at the level of your

server.

2. The other PayPal measure concerns all e-Commerce sites hosted on servers that do not already use at least version 1.2 of the TLS protocol

and version 1.1 of the HTTP protocol.

What should you do ? contact your web host to determine if your web server has all the security updates required by PayPal and if you do

not ask him to do the necessary for your hosting.

Create a custom button PayPal "Donate" or "Buy Now"

You want to add a simple "Buy now" button (without any shopping cart nor order) or a "Donate" button using PayPal on your site? A button that can be
placed in the footer of your website or in any section of any topic and this perfectly integrated with your TOWeb theme? Here's how to proceed:
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1. You must have a PayPal account (and thus create it from www.paypal.com if you do not already have one). Once logged into your account then

open the PayPal button creation page .

2. Then click on the link "Create a new button" and select the desired type of button like for instance "Donate" or "Buy Now".

3. Complete the rest of the form fields, taking care to specify a name (this text will be the one displayed by PayPal during checkout) and if

possible leave the option "Use my secure merchant account ID".

4. Once completed the form, click "Create button"

5. On the result page, then select the "Email" tab in order to copy/paste the URL of your payment button. This URL should normally be of the form:

https://www.paypal.com/cgi-bin/webscr?cmd=_s-xclick&hosted_button_id=XXXXXXXXXXXXX

This is it, all you need thereafter is just to paste this URL into a link that you have created in TOWeb

either by creating a link on an image of your choice placed in a paragraph,

or by creating a text link that can also be placed into a button with a icon of your choice
and thus obtain a customized PayPal payment button fully integrated to the theme of your site and/or the content of your topic.
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i-Services

What's a i-Service ?

Which i-Services are available in TOWeb ?

Common i-services issues and solutions

What's a i-Service ?

The i-Services are either dynamical or interactive functions generated by TOWeb in your website. Configurable in the Settings > i-Services screen a
wizard allows you to verify if the i-Services are supported on your web space (it is necessary to publish your site at least once prior to perform this
test). In case of trouble or doubt contact your host to make sure you can use PHP scripts on your web space.

Which i-Services are available in TOWeb ?

User comments
The i-Service named "User comments" allows your visitors to post comments directly inside some pages of your website.
More information about User comments .

Forms
The i-Service named "Form" allows you to automatically receive by email the contents of all the web forms submitted by your visitors from your site as
well as the customers orders (if you have a e-commerce website) and bookings.
More information about FORMS .

Mailing list
The i-Service "Mailing list" allows your visitors to subscribe or unsubscribe to your list of email contacts.
More information about MAILING LIST

Poll
The i-Service "Poll" allows your visitors to vote to your polls and view the polls results.
More information about POLLS

Download
This i-Service allows visitors of your site to download your linked files (such as your PDF documents, MP3 music files, ...) by saving them directly in
the "Download" folder of their computer rather than leaving them opened by the web browser of their machine.
In addition, by activating this i-Service, you will also have download counters allowing you to know the number of downloads made by your visitors for
each downloadable files available on your site, that is to say created with a link to a download file . The monitoring of your counters and their eventual
deletion/reset is done from the backoffice page of your site (accessible from the "Configure" button of this i-service).

IMPORTANT: if your files are unreadable/unusable once downloaded, make sure that file compression has been deactivated on your web server by
using the tools of your host provider and/or by asking your host to perform this verification and modification for you.

e-Commerce features
Managed from the "e-Commerce > Backoffice > online orders" screen.
To save, see and manage the orders directly from your site as well as the downloads of your files for sale  and a real-time stock.

Online booking
By using a topic of type "Online Booking System " configured to your needs, you can track and manage your bookings directly from "Backoffice >
Bookings". 

See also how to save & restore your i-Services data .

Common i-services issues and solutions

You are experiencing problems with your site with error messages displayed on certain pages, such as:

ERR_SNE or ERR_MLV errors displayed when validating orders from your e-Commerce site?

creation or validation of your customer accounts that does not work ?

votes in your polls not taken into account?

an error 3 or 9 displayed when Internet users try to post messages in your comments or when you try to modify or delete a message ?

All these problems are generally due to insufficient access rights on your web space. Indeed the majority of TOWeb's i-services perform file
writing and creation operations and if certain files or directories of your web space do not have sufficient rights and/or have changed, then these
operations will no longer be able to work properly.

All the i-services of your site are grouped together in the /_iserv directory present on your web space. Each i-service X is located in its /_iserv/X/
directory and the data of each X i-service in their /_iserv/X/data/ sub-directory. And it is this "data" sub-directory that often does not have (or no
longer have) the necessary and sufficient rights to create & modify files.

To correct this you need to
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1. log in to your web space

- either by using an FTP client software such as for example FileZilla

- or the web admin tools made available to you by your host in your account

2. and then open each /_iserv/X/ directory in order to then apply all access rights to its /data subdirectory, i.e. generally you need to

assign the rights: 775

If you can't do it yourself or you don't dare or you're not sure that the rights are 775, then ask your host to perform these operations for you to allow
all the PHP scripts of your site with full authorizations for creating + reading + modifying + deleting in all the /data subdirectories of all your i-services
/_iserv/X/.

Furthermore, if you use customer accounts on your website, please also check that the root directory of your web space has 755 rights as well as
sufficient rights for the _accounts.php located there (and of course that your " data" located in "/_iserv/accounts/" also have creation + modification
rights).

Finally, also remember to check your PHP version and also perform a PHP support test again if this has not been done for a long time.

For more information see also :

Problems due to system protections (firewall, antivirus, etc) when publishing or performing PHP tests

Other solutions to common issues you may encounter on your website
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User comments

How does TOWeb user comments work on my site ?

How to configure user comments ?

How to edit or delete comments ?

How does TOWeb user comments work on my site ?

By activating the User comments i-Services you can choose thereafter in which topic and paragraph your visitors will be able to add their comments on
your web pages. This could be for example near the photos of your album, the products of your catalog or in one or several paragraphs of a web
page. This function is particularly useful in particular for blogs that you can create by using groups.

Activate the User comments i-Service for a topic will display 2 links to your paragraph : one to open and see visitors comments and the other to show
the form where to post a comment.

If no comments are added by your visitors only the link "Add a new comment" will be displayed. On the contrary, if one or more comments have been
added then another link will indicate how many comments are already present. A click on "Add Comment" displays (or hides) the comment form and a
click the comment link displays (or hides) all the messages already posted by visitors.

Predefined text of your site, like for example the "Add a new comment" text, can be modified from the step: "Settings > Languages > Translate
TOWeb's predefined text".

How to configure user comments ?

The user comments configuration step
If i-services are supported by your host, you can use and activate user comments on your website in Settings > i-Services> User comments and click
on the Configure button to access the configuration window. From there you will be able to select the icon styles you want to display next to your links
(add and view comments links) and indicate whether you wish to be notified by email every time a visitor adds a comment on your site. Note that the
email address of the visitors will not be displayed on your site. You will only be notified of his/her email address if you select this option: receive a
notification mail each time a comment is posted.
If the captcha protection is activated on your website forms then it will also be for the forms unless you check the option: Disable the captcha security
code. In order to avoid visitors to post twice the same message or spam with a lot of comments you can specify a minimum delay between 2
consecutive posts made by the same visitor.
Finally you need to enter an administrator login and password to edit or delete the comments of your site if needed.

User comments customization inside a topic of your website
Select the topics of your site where you want to accept comments from your visitors and check the option "Allow visitors to post comments". In your
topic is an album or a catalog comments will be allowed for each picture or each products. And if your topic is page then you will have the choice
between the option to either add comments in the whole page or for each paragraph.
Then "Edit the topic content" and you'll see a new tab named "Comments" inside your topic. This tab will display comments from your visitors and by
clicking on the Download the latest comments you will retrieve and backup on your computer the latest posts on your web space. In this tab you can
also prevent the post of any new comments with the option Close comments post on this paragraph for example if you receive too many "eccentric"
messages and want to block spammers.

How to edit or delete comments ?

Any modification or deletion of comments must be proceeded directly from the form of your website. It is not necessary to have TOWeb to do that so
you can make moderate your comments from anywhere and any web browser by just typing administrative commands in your forms. Verify first that
you have entered a admin login and password in the User comments i-Service configuration window (the login "admin" and a random password are set
by default). If you change the login or password don't forget to publish again your site thereafter to apply this change. If you want to moderate the
comment number x (number displayed next to each comment) you will to fill out and post the administrative command as explained below :

name : your login admin name (default is "admin" if haven't changed it)

email : your admin password

website : the administrative command MODx (to modify) or DELx (to delete) where x is the comment number to moderate. For example DEL9 if

you want to delete the 9th comment and MOD12 if you want to modify the 12th comment.

message : the new text message that will replace the one posted by your visitor. Only applicable if you modify a comment and use a MODx

command. If you use a DELx command then keep this message field empty.

Caution : the MOD and DEL commands are case sensitive so verify you use uppercase characters !

And do not forget to click on the Send button of your form to post and execute your administrative request.
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Mailing list

How does Mailing list i-Service work on my site ?

How to configure my Mailing list i-Service ?

The Mailing List i-Service of TOWeb allows your visitors to subscribe and unsubscribe to your mailing list from a topic of your choice but also via a
pop-up window displayed when visiting your site that can be activated and configured from the "Options > Email pop-up" screen.

How does Mailing list i-Service work on my site ?

The Mailing list i-Service or "Newsletter" is a form on your website from where your visitors will be able to give you their email address because they
want to be informed about changes or news on your site. With a Mailing list i-Service on your website, visitors will be able to subscribe or unsubscribe
to your newsletter and their email addresses will be automatically added or removed from your list of contacts.

Subscribe requests
A subscription form added to your site will allow your visitors to be added to your list of contacts. When they send their request from your site, your
visitors first receive an email requesting confirmation. This confirmation request is to :

check that the email the visitor sent is a valid email so you won't keep incorrect email addresses in your contact list,

make sure the email address provided is the plaintiff and not the one of a person who registers another person than him/her.

Once your visitor have received this email requesting confirmation, your future "subscriber" only needs to click on the link located in that email and a
confirmation message will be displayed to him/her. Once confirmed, the email address of your visitor will be automatically saved into the i-Mailing
Service data located on your website. And whenever your list of contacts to be updated with all the new email addresses of people who recently
subscribed to your mailing, simply click on the Backup my i-services data button located in the Settings > i-Service screen of TOWeb.

Unsubscribe requests
If you use the Mailing list i-Service, the TOWeb automatic adds an unsubscribe link to the end of every messages you send to your contacts from the
step: Publish > Inform my contacts . Persons receiving your messages will only have to click on this link if they want to unsubscribe to your mailing
list and by clicking on this link their unsubscribe request will be automatically recorded to the i-Service data of your website. And as for subscribe
requests, whenever you want your list of contacts to be updated with all the new unsubscribe request, simply click on the backup my i-services data
button located in the Settings > i-Service screen and their email addresses will automatically be removed from your TOWeb's contact list.

And of course you can always add or remove your own contacts manually using the "Add a contact" button located in the "Publish > Notify your
contacts" step if people contact you directly without using the i-Service Mailing list functions and links of your site.

How to configure my Mailing list i-Service ?

You need to activate the Mailing list i-service from the Settings > i-Service screen and click on Configure to open the configuration window of this i-
Service. You will then be able to configure your subscription form and retrieve the subscribe & unsubscribe requests of your visitors by following these
instructions:

Set up your subscription form
Select the topic and paragraph where to Insert the subscription form object Mailing list . Then select the Mailing list object  (if your paragraph
already uses an object then add another paragraph and/or place it elsewhere like in a sidebar panel of your page for instance).
Finally customize the subscribe and unsubscribe messages (located in the other tabs of the configuration windows) and then publish your site to make
subscription form available online to your visitors. The text and the unsubscribe link that you have stated will be added automatically by TOWeb to the
end of your messages send from the "Publish > Inform your contacts" step, so your contacts can unsubscribe by a simple click if they don't want to
receive your emails anymore.

Get the subscribe & unsubscribe requests to update your contact list
Each time you backup the i-Services data of your site, your list of contacts ("Publish > Notify my contacts") will be updated meaning that any new
confirmed subscription & unsubscription will automatically add or remove email addresses to your contact list.
The i-Services data backup (including mailing list data) is done automatically by TOWeb when you publish your site and every time you proceed to a
complete backup of your site from step "Start> Backup ".

Note : Your mailing list form doesn't need any captcha because it has its own protection system and way to manage your visitors requests to avoid
spams.

https://www.lauyan.com/en/newsletter.html#8B28xuIE
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Polls

Create a new Poll

Adding a poll in a topic of your site

Configuration and administration of Polls

The Poll i-Service allows your visitors to vote for your polls and view the latest votes results. To add a poll to a topic you need to selected an existing
paragraph or create a new one and from the addition Object list of your paragraph select "Poll". You can place only one poll per topic.

Create a new Poll

First verify that the i-Services Poll from the screen Options > i-Services > Poll is activated and create at least one poll. By clicking on the "Configure"
button you will be automatically offered to create a new poll (and if you already have at least one existing poll then use the "New Poll" button). Then
enter the title of your poll as well as his brief introduction text (usually phrased as a question) then the list of possible answers to your survey in the
"Poll choices" area by entering one choice per line. Then click "Add new poll" and eventually start to create other polls before you click OK and save
everything.
Once created, you will ne be able to changed it thereafter, meaning that you can correct the text of a choice (eg. if you made a typo or spelling in a
word) and change the choices display order but you will not be authorized to add new choice or delete existing ones because it would no longer be the
same poll. It is therefore important to think in advance all possible choices / answers for your poll because otherwise, you will have to delete it and
recreate it with your new list of choices.

Adding a poll in a topic of your site

You can choose which location(s) of your site you want to place a poll. This could be for example in a paragraph or an information panel of your home
page to make it more visible and encourage your visitors to vote. To do this select the paragraph or information panel of your choice and select the
Poll object  located in the proposed list of Objects for your paragraph a sidebar panel.
The poll form will appear on your site and your visitors will be able to vote. Their vote will be memorized so that next time they visit your site they will
no longer see the voting form nor have access to it but they will directly the latest results of your poll.

Configuration and administration of Polls

In the Poll i-Service Configuration window you can "Allow multiple votes per visitor" by checking this option. This is generally not recommended if you
want reliable results but can sometimes be useful in some cases such as tests to familiarize yourself with the polls or data loss if you recreate a
previous survey and would like to recreate the votes yourself.
In the "Options" tab of the Poll i-Service Configuration window you can set the graph bars colors and presentation. In all your surveys you can also
"Add a poll result link to the poll form" by checking this option. We recommend you leave this option unchecked if you want your visitors to vote before
to see the results.

Special administration functions for Webmaster
As the creator and administrator of the site, if your poll is configured not to allow a multiple vote per person, you can bypass this and vote again by
clicking on the link "Clear my previous vote and see my online website" located in the "Poll"tab of the paragraph where you placed your poll. Similarly,
if you set your poll as not possible to see its results before voting, you may see the results any time by simply clicking on "Memorize me to always see
results of this poll on my website".
Finally, to prevent any data loss or accidental file erasure in your web space, it is important to regularly save your site polls to be able to recover and
republish them in case of trouble.

Poll display errors
If you find that your poll is not correctly displayed on your website or shows the results of a previous poll that you could have published previously
then, from TOWeb, select the topic and paragraph where you added this poll and click on the link named: Clear my previous vote and see my online
website.

https://www.lauyan.com/en/polls.html#prYL8UTS
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Local Search Engine on your Website

There are 2 different search engines in TOWeb to allow your visitors to search for local information into the web pages of your website:

the classic text search engine (only available in Premium, e-Commerce and Studio editions of TOWeb) allows you to search one or several

words in the texts of your website topic and display results in the manner of a conventional engine (such as Google) with links to pages and sub-

links to paragraphs

The catalog products search engine (only available in e-Commerce and Studio editions of TOWeb) allows you to search and view as a list of

products catalogs into a table result containing the product information (picture, price, reference, description) and with the ability to sort and

filter by price

If you activate and use a search engine (from TOWeb step "Settings > Search Engine") a search field form will be automatically integrated and
displayed inside the design of your theme and usable from every pages of your website.

Note : if you do not want a topic of your website to appear among the list of the results you need to go this topic and activate the option "Ignore this
topic in local search engine" located in the "topic setting" sidebar.



Multilingual website

How to create a multilingual website with TOWeb

Other solutions

How to create a multilingual website with TOWeb

Define your website main language
From the "Settings" step of TOWeb click on the "Languages" button and select the main language from the list. Then translate or update the list of
predefined messages used in your website. If a language is displayed in gray this indicates that no default translation is provided yet. In such a case,
you may want to provide your own translation by clicking on the translate button and all default messages to your language. If you wish to, you have
the possibility to send us your translated text if you want them to be integrated into a future version of TOWeb.
Add another language
If want to add another language to your website you need to Activate the multilingual option. Then you will be able to add as many languages as
needed. A menu button automatically appears on your website from where visitors will be to able to selected languages of your website.

Thereafter on your website you will be able to change the language from the list when needed. For instance

when editing a topic to switch a another language and translate it or adjust it has desired like for instance adding different pictures depending

languages. In order to facilitate the first construction of your website, we recommended you to first finish the first version of your website in the

main language before to translate or modify web pages of your other languages.

when changing texts elsewhere like for instance the by pressing the "edit menu" you will change the texts of your menu buttons in the language

you've selected before. Same thing for your payments, shipments, etc.

Other solutions

This easiest way to manage different languages and have best results is to follow the "Add another language" method described in the previous
chapter. Nevertheless, depending on your need and especially if you don't want to translate your site or if your website in your main language as
nothing in common with one of the second language, then you may consider one of the other following ways :

Create another site for another language
To obtain such a result you will need to do different operations. Let's suppose you currently have your website ready in English and now you want to
translate it and publish it in French, then you will need to :

open the host configuration wizard (CTRL+F8) and from the "browse" button located in step 3/5 create a “french” directory on your web space

in your current English website, add the name of this “/french” directory to the list of “Special Files & Folder”. It's important to add this name

otherwise TOWeb will delete it and its content every time you will publish your English website

backup your current website somewhere on your hard drive or to any external media storage : CD, USB memory key, ...#create a new website

for your French website and restore the previous backup in this new website if you want to restart if you want to start it from your English

version. You will then be able to translate it in French and obtain a different website in another language

once your website is translated in French and ready, indicate the remote “french” directory where your French website has to be publish. This can

be done in step 3/5 of the Host Configuration Wizard where you can either enter manually or select it from the “Browse” button

Publish you website. Eventually you will need to add flags buttons with links in your homepage in order for your visitors to switch from the English

version to the French version of your website.

Online translation site
Several websites provide an automatic translation of web pages like for example the Google Translate service. Just select the web page of your website
and the language and you will automatically obtain a translation. All you need to do then is just to add a flag link to this Google URL to obtain a
website in another language.
Note : If this solution is solution is pretty fast and doesn't require you to do the translation by yourself the result is not professional, not only because
of a toolbar added on top of your website but also because the translation results will generally just give a rough idea about your web page content
with many mistakes.

https://www.lauyan.com/en/multilingual-website.html#n6m4aiKa
https://www.lauyan.com/en/multilingual-website.html#19DPZ6N0
https://www.lauyan.com/en/multilingual-website.html#n6m4aiKa
https://www.lauyan.com/en/multilingual-website.html#19DPZ6N0
https://translate.google.com/


Terms of Use, Sales and Cookies

Terms of Use / Terms of Sales

The introduction/agreement page of your site

Cookie and Privacy consent banner

Personalized consent of cookies (opt-in & opt-out)

Terms of Use / Terms of Sales

Even if your site is not a web shop, you will need to inform your visitors about the terms of use of your website. In TOWeb, a page is provided for this
purpose (located at the end of the drop-down list of topics your website) and should contain at least the following information:

your copyright notice and conditions about the reuse of your photos, texts and other information contains in your website

your terms of sales, conditions and/or legal obligations

your respect for privacy and the use you make of personal information collected and/or transmitted by your visitors (or customers) from your site

like for instance their email addresses and personal information transmitted via your contact form, or personal data collected on your site to

comply with the GDPR .

We recommend placing a link inside the footer or fatfooter of your site that will point to your terms of sales (or terms of use) of your site as well as
your privacy policy .

The introduction/agreement page of your site

A site introduction page is a page where all your new visitors will be redirected when they access your site for the very first time. This page may be
useful for example to inform your visitors about the content of your website before their visit (especially if your website is intended for an adult
audience for instance), to warn them and ask for their consent, to inform your visitors about major changes on your site, to put images and links to
sub-sites (if you have multiple sites), etc.
There can be only one introduction page for a site and this introduction page will not contain any menu nor footer (but only the capabilities to select
another language if your site is multilingual). The introduction page can be created by using the button (  ) "add a new topic"  and you can create it
by using or not these two options :

a mandatory agreement checkbox to enter your site : your visitors will need to check it and so accept your terms before they can access your

site. The text displayed by default in this box is a predefined text of your site that can be changed at your convenience (from step "Options >

Language > Translate TOWeb predefined text"). If you have not used the option during the creation of your introduction/agreement page but

want to add it later on, then simply place the name of the predefined field %TW-SITE-AGREEMENT% in the text of the paragraph where you want

it to appear.

a leave button as alternative to exit your site if you want your visitor to have the possibility to go somewhere else, like for instance to the

Google search engine page.

Access to your site has to be done by a link to the topic of your choice (usually your home page but it can be another topic such as that of all the
conditions of your site) and this link must use the mandatory button style (blue button). Other links located in your introduction/agreement page (like
for instance a link to leave your site and go elsewhere) will have to use different style.

Cookie and Privacy consent banner

A cookie consent is a script that will automatically add a header banner on your web pages to inform your visitors that cookies are used on your site
and ask for their consent. This feature has been added in TOWeb to comply with the Europa legislation on cookies. If your visitors are mostly located
in the European Union we recommend that you enable this option, otherwise this is not necessary. you can activate cookie consent on your website by
going to the screen "Options > Cookies & Privacy" and checking at least the option named "Prompt visitor for cookie consent" and if possible also allow
customized cookies on your site.
The cookie consent banner does not appear in TOWeb design mode but only on a local preview of your site (F12) or when viewed online. The text
consent proposed by default in this banner can be customized from screen  "Options > Languages > Translate TOWeb's predefined text" inside the
“General” tab. The text {OK} represents the consent button, you can modify it but retaining the curly braces.

You may also use the option to automatically add a link to your terms of use  for more information about privacy concerns on your site. The text
proposed by default for this link is “More…”  but it can be modified from screen “Options > Languages> Translate TOWeb's predefined texts”.

Once a visitor clicks and agrees to use cookies on your site, the banner disappears and will no longer be displayed thereafter for 1 year on further
visits. If you have already clicked the banner consent button but want to see the banner again (eg to retest it) then you will need to delete the cookies
from your web browser or visit your site using another web browser to perform a new test as a new visitor.
The use of cookies on a TOWeb site may be required when using :
- any site tracking services such as Google Analytics
- any advertising management scripts such as Google Adsense
- any social network sharing buttons such as those of Facebook, Google + 1 or Twitter.

We recommend you to list the features and cookies you use inside your terms of sales (or terms of use) and place a link to it inside the footer of your
site.

https://www.lauyan.com/en/site-conditions-cookies.html#LO2QQoOc
https://www.lauyan.com/en/site-conditions-cookies.html#pMsLswTh
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https://www.lauyan.com/en/site-conditions-cookies.html#opt-in-out
https://www.lauyan.com/en/site-conditions-cookies.html#LO2QQoOc
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https://www.lauyan.com/en/site-conditions-cookies.html#vH6QxnTA
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Personalized consent of cookies (opt-in & opt-out)

You can offer visitors to accept or decline the cookies used by your website in a personalized way. To do this, you simply need to activate the two
options "Prompt visitor for cookie consent" and "Activate customized cookie" located in "Options > Cookies & Privacy". If you only activate the first
option then only a consent banner with an "OK" button will appear. By activating the second option, a "Customize" button will be added, allowing your
visitors to either accept everything or refuse everything, or decide on a case-by-case basis which cookies they want to accept or refuse.

Example showing what is displayed in your pages integrating YouTube videos when visitors refuse the use of YouTube cookies :

Example showing what is displayed in your pages integrating YouTube videos when visitors accept the use of YouTube cookies :

https://www.lauyan.com/en/site-conditions-cookies.html#opt-in-out


You can also

force your visitors to accept or refuse cookies before visiting your site (this will directly show the cookie consent windows without your visitors

having to click on the customize button of your cookie banner)

customize your cookie consent banner (its position, its colors, the size of your texts, etc.). The consent message proposed by default in your

cookie banner can be modified from "Options > Languages> Translate TOWeb predefined texts". If you choose to personalize it, be careful to

keep the "{OK}" text in your message, because it is its presence which indicates where in your text the buttons should be placed in the banner.

Depending on the third party services you use on your site (Facebook, Twitter, Google Ads, etc.) and/or the level of customization you want to offer,
you will then need to activate all the cookies that you want to make customizable for your visitors. At least one cookie must be activated otherwise the
personalization button will not be shown in your cookie consent banner.

At the level of each cookie you have the possibility to 

define a default behavior of the cookie (authorized or not) when or if your visitor has not accepted anything yet.

modify the explanation texts of each cookie (TOWeb offering by default texts ready to use in more than ten languages)

The cookie personalization window is customizable both in terms of its text content (title, introduction and buttons) as well as its colors and size. Be
careful not to use too large dimensions if you want this window to remain usable on a smartphone as well.



General Data Protection Regulation

Site compliant with the European GDPR

Terms, Conditions and Privacy Policy

Your site uses a mailing list

Your site uses forms

The predefined field %TW-PRIVACY%

Your site uses third party services or partners

Site compliant with the European GDPR

The General Data Protection Regulation (GDPR) is the European directive concerning the processing and circulation of personal data. Since May 25,

2018, all the websites of the countries of the European Union must comply with it or face penalties.

Note : Even if your site or company is not part of the European Union, it is strongly recommended to comply with the GDPR to better inform and

reassure all visitors of your site, including those in Europe.

TOWeb offers automation and assistants to help you make and maintain a RGPD compliant web site. To take advantage of these functions in TOWeb,

make sure that you use the "Site compliant to the European GDPR" option, enabled by default and located in the "File > General" screen or

available when creating a new site.

Note : by disabling this option it will not make any changes to your site but only the behavior of TOWeb that will no longer offer any automation nor

assistant related to GDPR.

Terms, Conditions and Privacy Policy

According to your site, TOWeb systematically offers a last page dedicated to your terms of use or conditions of sales  but it may be necessary to create

an additional page on your site only dedicated to your privacy policy . If this is the case and you have created one, then you will need to indicate it to

TOWeb in "Options > Security & HTML > Users' personal data".

Your site is not a sales site

Unless you need to add objects (images, tables, ...) or need to place your privacy policy on a different page than your terms of use/sales, you can use

the "terms of use" page already present on your site for this purpose (choice by default) by giving it the title of "Privacy Policy" and a content

appropriate to the users' personal data your site/company collect and process.

Your site is an e-commerce site with online sales

it is recommended to distinguish the rules related to the respect of the private life from those of the general conditions of sales of your site also we

advise you to proceed as follows:

1. create on your site a "Privacy Policy" page dedicated to all your explanations on the use of cookies, third-party services as well as your processing

related to the personal data of users/customers you collect from your site

2. in your "Terms of Sale" page, include at least one link to your "Privacy Policy" page

3. in the purchase order form of your e-Commerce site (e-Commerce > Order Form) check that you have activated the option to force the buyer to

accept your terms and conditions

4. if you use an online payment X on your e-Commerce site for which you have activated the option "Upload customer information to X" then

you will have to mention it in your Privacy policy and/or Terms of sale

Privacy policy

When creating a page dedicated to your privacy policy:

it is not normally necessary to display it in the general menu of your site, so you may want to tick the option "Do not display this topic in the

menu". However, as this page must be easily accessible by your visitors/customers at any time, we advise you to add a link to your privacy policy

in the page footer of your site, if possible not far from the one pointing to your terms of use or conditions of sales

remember to specify which topic is containing your privacy policy in the "Options > Security & HTML" screen of TOWeb

to allow the consultation of your heading, use the field %TW-PRIVACY% in your texts

Finally, depending on your activity and the content of your site, you may also be required to:

add a banner of consent to your cookies and/or acceptance of your privacy policy

add a page of introduction and consent prior to the consultation of your site.
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The content of your privacy policy depends on your activity, the different data you may collect and subsequent treatments that you perform with them

therefore you will have to follow the guidelines of the European regulations  but below you will find important information that you need to include to

your privacy policy:

The physical location of the collected data

Data retention time

Services with access to personal data files within the company and resell or transmit of any personal data to third parties

A clear consent explained to the user when completing a form and checking the box for validation of the use of his personal data

How a user may consult personal data that you stored about him/her 

The process to modify his/her subscriptions (mailing list )

The process to request the deletion of his/her data (right to be forgotten)

Your transparency will put your customers in trust so do not hesitate to be very clear and concise, not only regarding the different personal data that

you stored, but also regarding security spaces (for example by mentioning that your site is HTTPS secure if this is your case) and possible other

personal data processing used within your company (other than TOWeb for managing your website) if you have other tools on your computers that

may reuse personal users' information.

Your site uses a mailing list

To be in compliance with the GDPR , the person who gives you his/her email address through your subscribe form  must be informed in advance of the
use you will made regarding his/her email address: what type(s) of information will he/she receive precisely by email, how often, to which possible
third parties will his/her email address will be communicate to and why, which procedure to follow to unsubscribe, etc.
For this reason it is strongly recommended to apply at least 1 of the 2 recommendations below:

1. use the user confirmation required option located in "Options > i-Services > Mailing list > Configure" (or from the "Configure" button located

inside the paragraph using a mailing list form) to force the user to read and accept your conditions by a text that you will have written clearly,

concisely and positively (no negation in your sentences)

2. add a text next to your subscription form (for example just before and/or just after) to give more explanations, invite the user to consult your

privacy policy, explain the procedure to follow to unsubscribe and other important points depending on the treatments you may do with his/her

email.

Example of subscribe form compliant with the RGPD :

Remarks:

The presence of a mandatory confirmation by a check box may sometimes not be mandatory in a form (a single text may be sufficient) but it is

generally strongly recommended to be sure that the person has read and accepted your conditions

The acceptance text of your conditions can be lightened and moved before (or after) your form (as is the case above in the example to inform

about the unsubscription possibility) but this should not be to the detriment of the clarity of your message and, in a general way, it is better to

inform the user just before the validation button

A link to your privacy policy is strongly advised with an overlay opening so that users do not leave the form. For this you can use the pre-defined

field %TW-PRIVACY% .

Your site uses forms

If one or more web forms of your site allows to collect personal information of users (such as their name, address, email, date of birth, ...) then your
forms will have to request explicit consent from these people regarding the use you make of their data. This consent to your privacy policy should not
be implicit (do not put a check box activated by default for example) or formulated with a negation but expressed clearly, without ambiguity on its
purpose. Users should be aware of this at the level of your forms, if possible with a link pointing to your privacy policy placed inside or near your form
(usually at the end, before the submit form button).

https://eur-lex.europa.eu/legal-content/EN/TXT/?uri=CELEX%3A32016R0679
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Creation of a new form

Whether via the wizard to add a new paragraph containing a form or by adding a form object directly inside an existing paragraph or via the wizard to
add a new topic containing a form, TOWeb will systematically add by default a "confirmation" field at the end of your new forms to make them
compliant with the European GDPR (if this option is activated on your site)). Depending on the content of your form, your activity and your privacy
policy, you can modify them thereafter.

Modification and compliance of an existing form

If, in your TOWeb site, you have already existing forms you want compliant with the GDPR then you can click on the button called "User personal
data consent..." located below the list of fields of each form. TOWeb will tell you then the status of your form and offer you an option to make it
compliant by the automatic adding of a "Confirmation" field that you may customize (see the example of a subscribe form ). You can also manually
add one or more "confirmation" fields to your form via the add new field button located below the list of fields on your form.
TOWeb assists you and advises you but it is up to you to decide which status you want to set to each form of your site. For example, if your form only
collects anonymous data (an anonymous survey, a collection of improvement suggestions on your site from users, ...) then you can change its status
to compliant, even if TOWeb signals you that it is "may not be". And conversely, TOWeb "can" detect your form as seemingly conform to the GDPR but
if you know it is not (for example because you are not fully satisfied with the wording you used or because your policy confidentiality has not been
updated yet regarding some new fields) then in such case you can force his status into "not yet compliant".
Marking the status of a form as compliant or not is a simple indicator to help you in your compliance task; it has no effect on your website or its true
compliance with the GDPR. Here are different rules of good conduct you need to follow :

1. Clarify the consent act: no interpretation should be possible. The wording must be positive (no negation).

2. Distinguish consent from general conditions: consent can not be a prerequisite for registration to a service

3. Collect consent through positive action: The opt-in is mandatory. Pre-checked box (opt-out) is no longer valid

4. Facilitating the break-up of consent: It must be "as easy" to give consent as it is to withdraw it according to the RGPD. The right to be forgotten

(and personal data deleted) must be mentioned in the immediate vicinity of the form

5. When you add a new form to your site or when you change one of your forms to add one or more new fields, it is important to systematically ask

the question "does this change and new information I collect require any update on my privacy policy page ? "

6. The data you collect must be justified and the purpose of their collection clearly explained in your privacy policy (do not ask for eg a date of birth

if this information does not make sense with respect to the service or the request related to your form)

The predefined field %TW-PRIVACY%

By indicating the name of the field %TW- PRIVACY% inside the text of a paragraphs or inside labels of a form, TOWeb will automatically replace them
with a link to the privacy page of your site (the one you have defined in "Options > Security & HTML").
The text used by default for this link can be modified and replaced by the one you want, and this for each language of your site from "Options >
Languages > Translate predefined texts".
If your %TW- PRIVACY% field is placed inside texts located in your topics (forms, paragraphs, ...) then the link will open over your current
topic (meaning that users will be able to read your policy without leaving your topic). On the other hand, if your %TW-PRIVACY% field is placed inside
the footer of your theme (and therefore is common to all the pages of your site) then this link will open normally.

Your site uses third party services or partners

If your site uses third-party services that may collect personal information from your users (such as for example Google Analytics or via scripts that
you may have added to your site), you will need to list them in your cookies & privacy data consent and indicate how to disable them if users do not
wish them when browsing your site (like for example by user the private mode of their browser, disabling JavaScript or any other appropriate options
or plugins in their web browser).
In general, if you have scripts or partner services running on your site that use cookies or social networks then you should also be transparent by
listing them and indicating which user information you communicate to these third parties, for what purposes. Depending on your needs, the use of a
consent banner on your site or an introductory page of your site may also considered.
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Error pages & Rules of your site

Custom error pages

File .htaccess

File robots.txt

This page presents the manner and value of customizing a site error pages as well as the different important files that are defining the rules applicable
to your website, particularly their relation with internet search engines.

Custom error pages

By managing custom error pages, your visitors will stay on your website even when they encounter Internet HTTP errors returned by your hosting
server.
If you do not handled and customized pages for HTTP errors, then your visitors will only see a blank page containing a short text (generally in English)
with the name of the error displayed by your web server but as your visitors will not see anything else but that, they may wrongly think that your
website is not working or no longer existing.
In order to avoid that, TOWeb allows you to manage all HTTP these errors by displaying not only your own customized message per error (if you want
to) but also by automatically generating your message inside a full web page of your website that is to say a page containing the theme, page footer
and menu of your website so your visitor can directly go to any other page of your website when they encounter error.
We recommend you to activate all the HTTP errors on your site so that they can be automatically taken in account by your web server. The most
frequently seen errors are the HTTP 500 and HTTP 404.

HTTP ERROR 404 (NOT FOUND)
Most people are bound to recognize this one. A 404 error happens when you try to access a resource on a web server (usually a web page) that
doesn’t exist. Some reasons for this happening can be for instance a broken link, a mistyped URL, or a web page that you have moved, renamed or
deleted on your website.

HTTP ERROR 500 (INTERNAL SERVER ERROR)
This general-purpose error message appears when a web server encounters some form of internal error. For example, the web server could be
overloaded or needs to be restarted by you or you host provider because it is unable to handle all web requests properly. According to Google’s search
statistics, this problem is more than twice as common as 404.

Please note that the HTTP error messages are reported by your web server back to the visitor but if you can’t access a website at all, for example if
his/her network (or yours) is down, you won’t get an HTTP error back but your connection attempt will simply time out.

File .htaccess

The .htaccess file is a configuration file that will be used by your web server to configure for instance access rights, URL redirects or filename
extension associations with a MIME type.
The creation of a .htaccess file therefore requires web server administration knowledge and a great caution as an error on it may cause malfunction on
your web site or even crash your web server.
Finally be aware that the content of an .htaccess file may depend on the type of server you are using as well as any constraints or limitations from
your host provider. So we invite you to contact your host provider for more information if you ever have any specific rules or requirements to apply to
your web site or server.
Note: a .htaccess file can also be used to manage custom error messages but there is no need for that because automatically handled if you have
enabled the custom error pages for your site in TOWeb.

File robots.txt

A "robots.txt" file tells search engines whether they can access or not certain parts of your site. This file is automatically created and updated by
TOWeb in the root directory of your web space. We recommend that you enable the "Automatically add non-public pages and internal scripts of your
site to the robots.txt file" so that TOWeb update it automatically at every publication of your site based on its content and the features used in your
site.
You do not normally have to do more at this level unless you have specific needs, like for example if you publish sub-sites or if you have created
subdirectories & files of your web space that are not managed by TOWeb. In such cases, if you feel that your directories (or files) should not be seen
by Internet search engines then you can prevent the exploration of these directories and content adding your own robots.txt file.
Note that if you use the "Automatically add non-public pages and internal scripts of your site to the robots.txt file", TOWeb will use the content of your
robots.txt file, but also will append to it all the necessary exclusions of files useless for search engine that TOWeb has generated.
If necessary, you can also find on the website of Google Webmaster Tools robots.txt generator easy to use. Finally, if your site uses sub-domains and
you want to prevent exploration of certain pages from a specific sub-domain, then you will need a separate robots.txt file for each sub-domain
concerned. For more information about robots.txt files, you should also consult the guide of the Google help center for webmasters on the use of
robots.txt files .
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Scripts & HTML Fields in TOWeb

Script Fields

Text Fields

Predefined fields

Links and buttons with JavaScript actions

Script to open a popup window on your site

Risks and tips when integrating third-party scripts into your site

The source code of your web pages can not be deleted or changed as TOWeb automatically generates or regenerates all your web pages. But you if
you have some HTML code or scripts inside you can had them to your topics using TOWeb HTML Script Fields. Depending on your needs you may
also Use a TOWeb Text Fields. Both types of scripts can have additional files.

You can insert or edit TOWeb fields when editing a paragraph using the field button  but also create or manage all your scripts from the "Settings
> HTML" step.

Script Fields

The example of %DATE% for the current date in JavaScript.
1) From the Fields' Editor create a new field by clicking on the Add the new field
2) Its default name is NEW_FIELD. Rename it to DATE
3) Set the Field Type to "HTML Script"
4) In the Script Field Content replace the default script with a copy/paste of the following lines of JavaScript source code :

<script>
var d = new Date();
document.open() ;
document.write(d.getDate());
document.write("/");
document.write(d.getMonth() + 1);
document.write("/");
document.write(d.getFullYear());
document.close() ;
</script>

5) Inside one of your topic add the following text :
The current date is : %DATE%
6) Generate and you should see, instead of %DATE% the current date displayed on your web page.

This simple script is just a small example of a JavaScript code displaying the current date. You may create or copy/paste more complex scripts
containing HTML, JavaScript, PHP, applets, etc.
If you need to use additional files in the topic for your script (like for instance images, videos or applets) you can add them to the list of additional
files.

Where and how to add your Scripts ?

if your script (CSS, JavaScript, ...) has to be placed into the <head> section of your page, you can do that from the "head" button located in

the SEO properties of your topic (or from TOWeb step "Options > Security & HTML > HEAD" if you want that your script to be applied to all pages

of your site)

if your script (PHP and/or JavaScript) has to be added inside the page content and before the </body> tag then just add your TOWeb script

field inside the last paragraph of your topic (or inside the page footer if you want your script to be applied to all pages of your site)  

if your JavaScript requires to be called only when the page is fully loaded (eg for JQuery functions if you use this library) then you need to

declare a function named onTOWebPageLoaded in which you will copy / paste your code (the name of this function is case sensitive). Below is a

small script example that changes the link upon click on the logo of your site to redirect to the Google site instead of going to your home page:
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<script>
onTOWebPageLoaded function () {
$('#logo').click( function() { window.location = "https://www.google.com"; return(false); } );
}
</ script>

PHP scripts
If you want to include a PHP script you need to use the Script Field as previously described but also have rename the topic file name with the file
extension ".php". By default TOWeb gives to your topic an "Automatic" page name base on the topic title with ".html" extension. To set or change a
topic filename, just go to the "Topic settings" and inside the Search engine optimization type your filename with its filename extension before to press
the check button aside.

Text Fields

The example of %ADDRESS%

1) From the Fields' Editor create a new field by clicking on Add the new field
2) Its default name is NEW_FIELD. Rename it to ADDRESS
3) Set the Field Type to Text
4) In the Text Field Content replace the default text ("Enter your field text here") by your full address. You may enter it on several lines like for instance :

911 Easy street
94043, Mountain View, CA
USA

5) Click on the OK button and save your changes.

Now you have created a field ADDRESS containing your address. Every time you will need to use your address in a paragraph of your topics, simply
type %ADDRESS% (with % at the beginning and at the name) or insert it where you want with a right-clicking and by selecting ADDRESS from the
popup menu.
Then generate your website and this %ADDRESS% will be replace by the address you entered in all the web pages where you use it.

This example uses an email address but you may use text fields for any other purposes and text content you need (a copyright notice, the name of
your company, a phone number, your slogan, etc). In fact any text information (short or long) that you may use at different places in your web site but
do not want to update every time every where.

Predefined fields

If you want to place links pointing to the page of your site that contains your privacy policy , you can use the %TW-PRIVACY% field inside your texts.
If you use a introduction/agreement page on your site you can use the %TW-SITE-AGREEMENT% field.
In an e-Commerce site, the acceptance text of the sales conditions (modifiable from "Options> Languages > Translate predefined texts > Shopping
cart management") can use the %TW-TOS% field to create a link to your Terms of Sales .

If you have a multilingual site in which you use scripts (JavaScript or PHP), you may need to know the language of the page so that your script can
perform an appropriate action (such as displaying a message in the correct language, a price in the appropriate currency, a redirect to a specific URL,
etc.). To do this, you just need to add the %TW-PAGELANG% field to your script.

Example of use in Javascript

<script>
var lang = "%TW-PAGELANG%";
if (lang == "fr") {
  alert ("Bonjour !");
} else
  alert ("Hello !");
</script>

Note: the value contained in this predefined script is a 2 characters language code in lowercase letters (eg. en = English, fr = French, it = Italian, pt =
Portuguese, de = German, etc).

If the social network buttons are enabled in your section with the choice to use a personalized display then you can use the predefined field %TW-
SHARE% anywhere on your page.

You can use one of the 3 predefined fields below to add the year or date of the last publication of your site:

%TW-YEAR% = displays the year of publication of the site.

This field is particularly useful if you wish to display for example a "copyright 2025" in the footer of your site (as in this current page as well as all

the other pages of our lauyan.com website) to avoid having to update it every year
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%TW-DATE% = displays the site's publication date in short format.

If the pages of your site are in English, the date displayed will be for example "6/26/2023" (for June 26, 2023) and in French it will be

"26/06/2023"

%TW-DATEFULL% = displays the publication date of the site in long format.

If the pages of your site are in English, the date displayed will be for example "Monday, June 26, 2023" and in Spanish it will be "Lunes, 26 de

junio de 2023"

Note: for the English language, the default format "mm/dd/yyyy" can be changed to "dd/mm/yyyy" from the "Options > TOWeb > Date format"
screen.

Links and buttons with JavaScript actions

The buttons or links you create on your topics can directly call JavaScript code to add more animations, content processing, or interactivity to your
pages.

Example 1 - Display a message

The example shown in the screenshot is the link below to display a "Hello!" message in the web browser when clicked.

Display a message

Example 2 - Show or hide content
The example shown here is of a button using JQuery to alternately make a paragraph content visible or hidden on each click with the following line of
code:

p=$("#jsbtnex1").parent();h=p.css("visibility")=="hidden";$(this).html(h?"Show":"Hide");p.css("visib
ility",h?"visible":"hidden")

The paragraph to show/hide here being the previous "Example 1" which uses a bookmark named: jsbtnext1

Hide

Note: if your JavaScript code is quite important, we advise you to use an HTML script field in order to place it in a function. Your function code will then
be easier to maintain and can also be reused elsewhere if needed. For example in our previous example all the code could be placed in a
ChangeVisibility() function in the following way, less compact but also more readable on several lines 
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<script>
function ChangeVisibility(e) {
    var p = $("#jsbtnex1").parent();
    if ( p.css( "visibility" ) == "hidden" ) {
        p.css( "visibility", "visible" );
        $(e).html("Hide");
    } else {
        p.css( "visibility", "hidden" );
        $(e).html("Show");
    }
}
</script>

and then you just have to enter the line ChangeVisibility(this) in the JavaScript code feld of the button.

Script to open a popup window on your site

When major problems or changes occur on your website, it is important to be able to immediately inform your visitors as soon as they return to your
pages. Displaying your information in a popup window overlay can be the ideal solution, especially if you don't want to harm the SEO of your site.

The script we offer here allows you to do this in just 5 small steps :

1 ) Add a new paragraph at the very end of your topic with a content that will be the one you want to appear in a popup window.
2) Modify the Display of this paragraph to Hidden ( ).
3) Then, in the properties of this paragraph, click on the bookmark ( ) icon in order to know its identifier. Note this name by taking into account its
case sensitivity because you will have to use it later on. If necessary, you can select and copy/paste its name to temporarily store it for example in the
Notepad application on your computer.
IMPORTANT: The name of the bookmark must be the one originally assigned by TOWeb. If you have modified it, then you need to 
- delete the bookmark name that you entered by leaving its name empty and pressing the OK button
- then edit it again to see the original bookmark name you need to copy and use.
4) At the end of your "hidden" paragraph, add TOWeb field  ( ) that you will name for instance %POPUP% and set its type to HTML Script with the
follow content :

<script>
function onTOWebPageLoaded() {
    var popup=$("#fLNWusuK");
    popup.attr("title", "Popup Information");
    popup.removeClass("span12");
    popup.dialog({
        modal: true,
        buttons: { "OK": function(){$(this).dialog("close"); } }
    });
    $(".ui-dialog-titlebar-close").hide();
    $(".ui-dialog-buttonset").find("button").addClass("btn");
    return false;
};
</script>

5) in the code of this script, finally make the following modifications :

replace the name fLNWusuK with the one of the bookmark  ( ) your previously get in step #3

replace the text "Popup Information" with the one of your choice (it is the title of your popup window)

replace the text "OK" with the text of your choice such as "Close" if you prefer (it is the label of the button used to close the popup window).

Warning: the script of this example will systematically display the popup window each time the page is opened, which means that if a user visits
your page and just a few moments later returns to it, the popup window will be displayed again.

If you want the popup window to appear only once (temporarily or permanently) you will have to modify the script using:
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either a cookie (if you want this duration to be kept only for a specific period in days, months or years)

or a "localStorage" if you ever want the window to appear only once and never again

or a "sessionStorage" if you want the window to appear only once during the duration of the user's visit but reappear again the next time this

person will return to your site.

The second version of script below has additions indicated in bold using localStorage. You may prefer this version if you want your visitors to see the
popup window only once during the duration of their visit but to see it again in the next visits for instance few days or weeks later :

<script>
function onTOWebPageLoaded() {
    if( sessionStorage.getItem("popmsg") == "1" ) return;
    var popup=$("#fLNWusuK");
    popup.attr("title", "Popup Information");
    popup.removeClass("span12");
    popup.dialog({
        modal: true,
        buttons: { "OK": function(){sessionStorage.setItem("popmsg","1");$(this).dialog("close");
} }
    });
    $(".ui-dialog-titlebar-close").hide();
    $(".ui-dialog-buttonset").find("button").addClass("btn");
    $(".ui-dialog-titlebar").css("background-color","red");
    $(".ui-dialog-titlebar").css("color","white");
    return false;
};
</script>

By default, the popup window is displayed with a  title text in black on a gray background  but in the next example below, the two lines indicated in
blue have been added to allow the change of a title color in "white" and its background in "red". So if you need to, you can modify with these color
names or replace them by the html color values of your choice.

To see an example of a popup information window, click on this button:  Test the script

This script can be added for example only on your home page.

But if you want it to also appear on the other pages of your site, you will need to use the "duplicate" function to duplicate this hidden paragraph at
the end of the other desired pages (and possibly also readjust its content each time to each page concerned if necessary).

The close window button of our examples use the class "btn" (which is the button style defined by default in the Theme  of your site) but in your script

code you can replace this name there by another one if you want to change its color. The different choices are:

"btn"

"btn btn-primary"

"btn btn-info"

"btn btn-success"

"btn btn-warning"

"btn btn-danger"

"btn btn-inverse"

or put nothing if you want a button with a basic style.

Finally, if you want your hidden paragraph not to be displayed systematically in a popup window each time a page is accessed, but only when the user

clicks on a very specific link or button (like our previous "Test the script" button in green) then you will need to proceed like this:

1. do not use the function name onTOWebPageLoaded() in the script but replace it with another name of your choice such as

popupWindow() for example

2. add in another (visible) paragraph of your page the link or button that will open your popup window.

For this, you will need to add wherever you want in your page another HTML script field containing:

https://www.lauyan.com/en/theme-creation.html


either a text link by using the following line of HTML code 

<a href="https://www.lauyan.com/en/scripts.html#" onclick="return popupWindow()">Text of the
link opening the popup window</a>

Example : Text of the link opening the popup window

or a button by using the following line of HTML code

<button class="btn" onclick="return popupWindow()">Text of the button opening the popup
window</button>

with the button class name "btn btn-xxxxx" of your choice (see above for the list of possible choices) if the default "btn" does not suit your

taste or has not the most appropriate style for your situation.

Example :   Text of the button opening the popup window

Risks and tips when integrating third-party scripts into your site

TOWeb allows you to add scripts to your site by using the HTML script fields . But unless you have knowledge of web programming and have developed
your own scripts, you will probably use third-party services from another site. And if this is when there can be a big danger, not only for you and your
website but also for all your visitors!!!

A classic example, the "scam" of web counters

Very popular before the 2000s, web counters have since fallen out of use for more than a decade. All webmasters or web professionals know this but
not beginners, which can make you the ideal victim of a scam because such  "so-called free and innocuous" service 

1. often hides and includes malicious features like for example the appearance of unwanted messages or advertisements on your site, 

2. or the spying of all the people who visit your site, or other malicious actions without their knowledge 

3. and even the installation of virus/malware on your web server.

How to do things well

Before integrating a third-party service into your site, it is important to read the conditions of use of the service you intend to add to your site and
search the internet for some user reviews. This will allow you:

1. avoid the majority of unwanted surprises that you may not have even considered,

2. determine the possible cookies and other data collected by this service that you will report to the level of the privacy policy page of your site to

comply with the GDPR ,

3. and in a general way but also for the previous example about "web counters", rather prefer the use of services much more powerful and well

known by choosing first those your host provider may offers (if ever they provided web tools/scripts you can use on your account/web server) or

by using Google Analytics or other competing alternatives already famous that will bring you much more useful for the SEO of your site thanks to

the numerous information and statistics, like for example to know how long the Internet users remain on your homepage (and any other pages),

where they come from before visiting your site, or obtain more information on the profile of your visitors (country, age, men/women, ....).

How to proceed if you already used a malicious script

If you have used third-party scripts and notice the presence of completely abnormal behavior of your site when visiting it on the internet (such as the
appearance of messages or unwanted advertisements) then:

1. Browse through all the topics on your site in order to find and remove all the %SCRIPT% fields that you added to various places and then publish

your site entirely. This will verify and confirm that the problem you have comes from there (if it is not the case then you will be able to put them

all back and you will have to contact your host for more explanations on the problem you notice.

2. If the problem disappears from your site after removing all your third-party scripts then add your script fields again in your pages but only 1 by 1

and republishing your site each time to identify which ones are problematic/undesirable. Remember also to delete the temporary internet files

from your web browser after each new publication of your site to be sure that your web browser does not reuse pages/scripts stored in its cache.

3. Then contact the company or website responsible for the service (or services) you used to ask them for explanations (without forgetting to re-

read the conditions of use of their service).
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4. If applicable, depending on the answers (or non-responses) of the third-party services that you have used, report the possible fraudulent practice

to the authorities that you consider advisable, such as for example certain government agencies/institutions of your country, user forums,

antivirus/malware editors, ...

5. Make sure you have an up-to-date antivirus to eradicate any spyware and/or malware from your computer before republishing your site.

6. Contact your host provider to ensure that absolutely no virus/malware/spyware/trojans has been installed on your account or web server.



Web programming with TOWeb

This page is not an initiation guide to web programming but contains examples allowing users with good knowledge of web programming to
learn how they can modify and enrich both the display and behavior their TOWeb web pages by adding their own lines of HTML, CSS and
Javascript source code.

Links and buttons with JavaScript calls

The ClaudiaMinton template uses 2 buttons located at the top of its homepage. One of them allows you to download the PDF version of the CV (this
using the function of adding a link to "a file to download") and the other allows you to directly print the web page, which is a function not offered by
default by TOWeb but which we will explain here.
The window.print() JavaScript function is used to open the print window in order to print the current page displayed by the web browser. But how
to call this function from a link or button?
To do this, simply create a link to "a website" but instead of indicating a site URL, you need to enter the name of the JavaScript function you want to call
by prefixing it with javascript: this way:

If your script is not just a simple call to an existing JavaScript function but several lines of code then you will have to create your function in an HTML
script field that you will name for example myFunction() and the following the following line into the URL field of your link or button:

javascript:myFuntion()

Example of a function that can be used on a button or link for a confirmation request to leave your site and go to Google:  

<script>
function myFuntion() {
    if( confirm( "Do you want to leave this site ?") ) 
        location.replace( "https://google.com" );
}
</script>
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Use the JQuery library

JQuery  is a very popular and widely used JavaScript library because it is very small, very powerful and feature-rich. As this library is systematically
included in all the pages of your TOWeb sites, you can therefore use the JQuery functions anywhere in your web pages.
For example in a link or button using JavaScript (seen in the previous chapter) if you use the following JQuery code

javascript:($this).hide()

this will have the effect of making your link/button disappear as soon as it is clicked.

Be careful, however, if you ever want to use JQuery functions as soon as the web page is opened by the web browser (for instance to perform
initialization or content modification operations). In this case, you have to make sure that JQuery has had time to be completely downloaded before
being used. And to guarantee this, if you have lines of code or initialization functions to call and these use JQuery, you will have to place them in the
predefined function onTOWebPageLoaded() which is called once all the content of the web page was downloaded by the web browser (JavaScript being
case-sensitive, be careful to respect the lowercase and uppercase characters of this function name when you use it in your code).

Add your own JavaScript libraries

If you wish to add other JavaScript libraries than JQuery, depending on their use, you will have to either add them in the <head> section or in the
<body> section of your pages and as you may want to do that only in a specific page or in all the pages of your site, you will find above the
explanations relating to the 4 different possibilities of adding your own scripts with TOWeb:

either in the <head> section of your topic only concerned.

To do this, you must use the "<head> section and other Meta tags..." button located among the "Search Engine Optimization" properties of your

topic.

either in the <head> section of your site from the "Options > Security & HTML" screen so that this is applied to all the pages of your site

either in any paragraph of a topic (the first one or the last one for example)

using HTML script fields of TOWeb

either in the footer (small or large) of your site if you wish to include it in all the topics of your site that use your Theme by doing this via the

HTML script fields of TOWeb.

Note: in the last 2 cases your script will be added after the <body> tag and before the </body> tag

Once you determined where to add your scripts, you can then

either directly include your lines of JavaScript code by copy/paste (don't forget to place all your code between the start <script> and end

</script> tags)

or include the JavaScript file containing all your lines of code (those you have developed or those of a third-party script that you wish to use).

If you prefer the latter choice of using scripts in ".js" external files, you can do it 2 different ways:
1) either the JavaScript file you want to use already exists on the internet
If your script is available on content servers (CDN) then you just need to include it in the classic way by indicating the full URL of the script and its
desired version, as for example below the use of version 3.2.1 of the anime.js script

<script src="https://cdnjs.cloudflare.com/ajax/libs/animejs/3.2.1/anime.js"></script>

2) or you want your JavaScript file to be placed on your web server in order to be used locally by your website. In this case, you must first create an
HTML script field with an empty "Field script content" but in which you will have add your JavaScript files from the "Additional script files" tab.
In our example we have created an HTML script field named MY_SCRIPTS in which we have added 2 additional script files: anime.js and gallery.js
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As you can see in the screenshot of our example, TOWeb indicates that our additional JavaScript files are placed in the "_fields" subdirectory of our
site. Therefore, to include and use our 2 scripts, we just have to add these 2 lines of code:

<script src="_fields/anime.js"></script>
<script src="_fields/gallery.js"></script>

IMPORTANT: your HTML script field containing additional files must be used at least once in one paragraph of any topic of your site
because if your script is not declared anywhere in your site, the additional files it contains will be considered as not used and will therefore not be
published.
In our example, this means that we must add the full name of the %MES_SCRIPTS% field somewhere in the text content of a paragraph on our site so
that our 2 additional JavaScript files can be published in the _fields directory of our web space and be used locally by all the pages of the site (and not
just the one where the HTML script field has been added).

Add your own CSS3 styles

Adding CSS styles is similar to adding scripts as previously seen above and must be done in the <head> section in one of this two ways:
either in the <head> section of your topic. To do this, you must use the "Section <head> and other meta tags..." button located among the

"Search Engine Optimization" properties of your topic,

or in the <head> section of your site from the "Options > Security & HTML" screen if you want your CSS styles to be applied to all the pages of

your site.

In the same way also if you have CSS files to include in your pages you will have to add them to your site via the additional files of an HTML script field
 in order to have them published in the _fields directory of your web space.
The ClaudiaMinton template is an example to illustrate a web page CSS customization so we invite web developers to create a test site from this
template to get the source code present in the <head> section of its CV home page.
The CSS programming aspects will not be detailed here but only the techniques presented in a global way to show how this page was made.

The CV page does not use a theme, nor any header, menu or footer so in order not to interfere with the styles of the theme (used by all the other

topics of this template), this topic is the only page to use a side panel and also to use paragraphs with "custom" CSS styles (defined in the CSS

editor and that can be applied to a paragraph of a section at the level of its "Style" property).

The sidebar is placed on the left (using the option of the CSS editor located in "Site > Page > Page Content > Topic > Sidebar") and various

additional styles are applied to it in our CSS code in order to apply some CSS "flex" display properties (not currently supported by TOWeb) in the

sidebar (with its id called #top-sb) for behavior appropriate to the needs of this page.

Finally, the main CSS modifications are made to the "twps-cst1" class (called "custom 1" style in TOWeb) which is the one used for the gray

horizontal paragraph displayed at the top of the page.

Because indeed, as you can see in design mode in TOWeb, the sidebar and the normal paragraphs of the topic are separated by a spacing that we

do not wish to have, in order to have this top gray paragraph "glued" to our blue sidebar, a displacement of its position as well as a resizing is

added by CSS.

In addition, in this paragraph we also have the 2 buttons (Print and PDF) placed in its title but for a better presentation a CSS code have been

added to align them in the upper right corner of the paragraph.

Note: some styles added in our CSS code could have been done with TOWeb's CSS editor but have been placed in the additional CSS code for a more
complete example.
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Dynamically add styles or HTML5 code

The modification of the styles of your web page elements can also be done dynamically in JavaScript or JQuery just like the rest of your HTML content
by adding your lines of code in an HTML script field placed in your page. The different ways to do this and all the possibilities will not be covered here
but you will find below a small example using JQuery to illustrate a change of CSS display style as well as a change of HTML content in a page of a site
created with TOWeb.

The following script example, when placed in a topic of your site, will be called as soon as the page loads via the predefined function
onTOWebPageLoaded() to perform both the following actions:

1) delete the page footer (if it exists) or more exactly replace its content with an empty HTML code using our deleteFooter() function

2) if the footer existed and was replaced, then all the buttons present in the TOWeb web page will be enlarged by 150% by calling our bigBtn() function

<script>
function deleteFooter() {
    if( !$("footer") )
        return false;
    $("footer").html("");
    return true;
}
function bigBtn() {
    $(".btn").css( "zoom", "150%" );
}
function onTOWebPageLoaded() {
    if( deleteFooter() )
        bigBtn();
}
</script>

Avoid conflicts with the TOWeb design mode

In design mode, adding your own CSS or JavaScript code can cause TOWeb to run slower or not display your content correctly or even cause crashes.
For these reasons we therefore recommend:
1) to uncheck the option "use your additional code in design mode" located in the "Options > Security & HTML > HEAD" screen in order to avoid
slowdowns, conflicts or even crashes when editing your topics in TOWeb
2) to use the external preview (F12 key from TOWeb) to test your pages directly in your web browser and check the display and the proper functioning
of your scripts. If your additions are not in HTML, CSS or JavaScript but in PHP , you will need to publish your site on your web server to test your
pages.

Other examples and functions

★ Multilingual websites
If you are creating a multilingual site, you can use one of the predefined script fields such as %TW-PAGELANG% which contains the language code of
the current page. Using this value in your script (JavaScript or PHP) will allow you to perform any processing specific to each language in your web
pages.

★ Alert popup window
The javascript alert() function allows the web browser to display a message in a window to visitors of your site, but its presentation is not very pretty,
it also differs depending on the web browser used and is not integrated into your site. So if you want an alternative to that, you may consider
displaying the content of an entire paragraph using a popup alert window fully integrated to your site.

★ Animation
At the end of the year, if you want to add a falling snowflakes animation above the content of your web pages, then you can add our falling hearts or
snowflakes animation script to your site.

★ Custom ordered list
Our CSS generator of custom ordered list  allows you to create different shapes, colors and styles for your ordered lists. The generated CSS code
is simply to be copied & pasted in the <head> section of your topic and thus allow you to highlight the different steps or important points of your page
content like for instance on our own site with the list of the 10 key points of TOWeb .
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Snowflakes animation script

To integrate this dropping objects' animation in a topic of your site you will to copy/paste the code below into an HTML script field that you will name
for example SNOW and add its field name like this %SNOW% inside the text of one of your paragraphs :

Animation of Snow flakes

<script src="https://www.lauyan.com/goodies/snow/snow.js?8" id="_x2"></script>
<script>
function onTOWebPageLoaded(){
  initSnow( 1, ["#b6d6f7","#90bfef","#2196f3"], 45, 0.6, 15, 40 );
}
</script>

Animation of Hearts

<script src="https://www.lauyan.com/goodies/snow/snow.js?8" id="_x2"></script>
<script>
function onTOWebPageLoaded(){
  initSnow( 3, ["#ea8888","#f44336","#aa0000"], 60, 0.6, 15, 40 );
}
</script>

Possible customizations

The "initShow" line of the script above contains different parameters that you can customize to your liking according to your needs or tastes.

1st parameter: the style of the flakes

In our snow flake example the value is set to
1 = star style (*) but you can also use:

0 = flake style (*) 

2 = flake & star style
3 = heart style ( ❤ )

2nd parameter: the colors of the flakes

In our example ["#b6d6f7","#90bfef","#2196f3"] is the list of 3 different colors possible for blue flakes (colors randomly picked up for
each flake) and 3 different red colors ["#ea8888","#f44336","#aa0000"] for the red hearts.

3rd parameter: the maximum number of flakes 

In our example we have defined 45 flakes. Be careful not to put this value too high: it could overload some screens (especially small ones like

smartphones) but also slow down the navigation of your visitors (depending on the power of their computer, tablet or smartphone).

4th parameter: the speed of the snowflakes animation

In our example the decimal value was set to 0.6 which corresponds to an average value

( 0.1 < very slow / 0.5 = normal / 1 = fast enough / other values > 1 = fast )

5th parameter: the minimum size of the flakes

In our example the value has been set to 15. This value must be greater than 6 so that the flakes or stars can be a visible and identifiable.

6th parameter: the maximum size of the flakes 
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In our example, the value has been set to 40. The maximum size must be greater than or equal to the minimum size.

Remarks about flake colors 

Our previous example uses 3 colors (shades of blue) but :

you can defined only one color if you want too. If you do so you will still need to frame your unique color with [" and "]

there is no limit to the number of colors you can set. If you use at least 2 colors you will have to separate them with commas ","

if the background of your page is not white (like in our page) but dark, you may want to use a brighter or whiter color for your flakes. By default

2 light colors from white to light gray are defined. If you want to use them you will have to replace the color list [...] by the value: null

How to set the animation in all the pages of the site

To place the snow animation in a single section of your site we saw previously that you had to add the script inside one of the paragraphs of your
topic. But if you want the animation to appear in every pages of your site then, from any topics, just edit a text located inside your page footer in
order to add your snow script there.
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Publish your website

Why do I need a Host Provider ? What's a FTP server ?

Advantages and disadvantages of the different host providers

Why and how to secure your site?

How to publish your website ?

How to deactivate or delete your site?

What is PHP?

Which PHP version to use on your web hosting?

PHP support test

Problems & Solutions to connect or publish your website

Publish on a local drive

Why do I need a Host Provider ? What's a FTP server ?

In order for your website to be accessible to everyone on the Internet you need to publish it to the web server of a host provider. Such a web server
accepting the file transfer of your website is called a FTP server and requires an account for your web space. There are 3 main types of host providers
you may use :

1. a web space coming with your Internet connection : some ISP (Internet Service Providers) offer a web space to their customers where you

can publish your website. Generally limited in size this may suit your needs. You may need to contact your ISP to determine if you have a web

space and to get the login and password of your account.

2. a free web space : many websites on the Internet provide free web space. But if this service is free, in general they add some popup windows

or ads to your website, so you'd better read their conditions before to create any account and publish your website. Conditions of free host

hosting sites may change anytime too but if you want to test and try a first version of your site you may consider for instance to use the biz.nf

free web hosting that accepts scripts and is with no ads.

3. professional host providers : more reliable than the other web space, they are not not free but provides many services depending on your

needs.

TOWeb provides a list of host providers of type 1 and 2. If yours is not available in the default list you will need to enter not only your login and
password but also the FTP address of your host provider. TOWeb supports the FTP protocol as well as the FTPS (also called FTP/TLS) secure protocol. If
you encounter any issue contact your host provider check the Problems & Solutions to connect or publish your website .

IMPORTANT : For your website to work correctly using all TOWeb features (such as e-commerce, forms sent by email and user comments) your host
provider must authorize you to accept PHP scripts on your web space.

Advantages and disadvantages of the different host providers

Free web space

the main advantage is to have this service for free. If it's a not a professional website or if you don't know your needs yet or if you are not sure to

keep your website for a long time, then you might first try this solution and see if it fits your needs.

depending on the number of the (numerous) persons connected at the same time, you may experience now and then some disconnections during

the transfer of your files to their server

you have limitation on your account on some free web hosts like for instance a maximum size per file or some type of files not accepted like for

example video, music files or scripts

many free web host providers place their advertisements on your web pages.

Web space offered by your ISP

advantages and disadvantages are pretty much the same as the ones of a free web space

and in general, when changing to another ISP you loose your previous web space. This means that you will still be able to publish your website

anywhere else with TOWeb but the address of your website will no longer be the same and all the people used to visit your website may never

know the new address of your website thereafter.

Professional host providers

with a professional host provider you don't have any of the ISP or Free web space disadvantages

they are not free but depending on your needs it's easy to find one on the Internet with cheap prices per month

you can buy your .COM domain in order to have your the "WWW" web site address of your choice, and this generally included to the price of your

web space. And if you are not satisfy with your host provider and want to change to another one, you will be able to keep your domain name and

publish it again so your website will stay at the same address and your visitors won't see any changes.

the file transfer is more reliable and you generally can upgrade to a better offer if your website needs are changing or growing.

If this is your first website we recommend to try a free web space or use the one provided by your ISP to see the result and determine if this is good
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enough for you. If host provider is not present in the default list provided by TOWeb you will need to manually enter the FTP address of your host
provider. If you don't know it, contact your ISP or host provider to obtain the FTP address you need to use as well as your login and password. If you
already have these information but still can't connect to your web host then check our advice about Problems & Solutions to connect or publish your
website .

But the choice of a host provider mainly depends on your needs and the type of website you create, like for example : the size of your web space, if you
want to use and run scripts, if you want to have your own WWW domain name, if have many large downloadable files on your website and need a
large bandwidth and other criteria. For more information see previous advantages and disadvantages listed below and contact some host providers
for advice to your case and see what they offer. We do not recommend any particular host provider as they are too numerous and they provide
different services and prices but your will find them easily in computer magazines or with a search in www.google.com like for instance these free web
hosting sites.

Why and how to secure your site?

What are the advantages ?

A secure site is a website accessible by HTTPS (unlike an unsecured website accessible only by HTTP) that can be identifed in web browser by the
display of a padlock (often green) next to the address of your site to report a "secure connection". Having a security site is an important asset
because:

this will reassure your visitors especially when they will want to use the contact form of your site to send you their personal information (name,

email address, telephone number, messages, ...) or when making online purchases from your e-Commerce store,

your visitors will also be assured that your site is the original one and not a modified version or a pirate copy,

last but not least, it will also promote the SEO of your website with a better position in search engines results such as Google that has officially

announced to promote HTTPS websites since 2016.

Also note that since 2017 many providers of online payments encourage or even require merchant sites to use HTTPS so that all their services can
work properly (especially for IPN) therefore if you use or plan to use an online payment this will be another good reason to secure your site.

How to secure your website ?

This requires the installation of an SSL certificate on your server and you will need to contact your host provider to know the procedure to follow from

the tools they provide on your account and/or if you want them to perform this technical operation for you. Once your SSL certificate is installed and

your web server is properly configured to work using HTTPS, you will just need to enable the SSL option located in step 4 of the TOWeb Host

Configuration Wizard before to republish your site.

Procedure for a smooth transition from HTTP to HTTPS:

1. Choose a serious supplier to buy your SSL certificate

2. Contact your host for the installation of your certificate and to perform the correct configuration of your server by using an HTTP Strict Transport

Security (HSTS) in your headers (*)

3. Enable the SSL option in step 4 of the TOWeb Host Configuration Wizard, then republish your site and verify that it works well in HTTPS

4. Register HTTPS version of your site in Google and Bing webmaster tools

5. Activate the option named "A SSL certificate is installed" from the TOWeb screen "Options > Security & HTML"

6. Renew your SSL certificate every year, before its expiration date

Note: the site optimizer of TOWeb can alert you before the expiration date

(*) If your host provider does not support it, you can add the 3 following lines of code into your .htaccess file (and then publish your site again
thereafter) :

RewriteEngine On
RewriteCond %{HTTPS} !=on
RewriteRule ^/?(.*) https://%{SERVER_NAME}/$1 [R,L]

Important: if after following all our previous advice your site still does not display as secure then verify that you did not add any scripts on your site ( if
so then you will have to update them by secure versions only using https:// calls but no longer http:// ) and then contact your hosting provider to
recheck and correct the configuration of your web server.
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How to publish your website ?

To publish your site you must provide your user name, password and FTP server name that you received from your host provider. Make sure you have
all these information before to use the Host configuration wizard  of TOWeb located in the "Publish" step or accessible with keyboard shortcut
CTRL+F8.
The host configuration wizard provides a list of free hosts and hosts included internet service providers that you may use. If your host is not that type
or not present in the list, then just follow our guide on how to configure a host that is not present in TOWeb default list .
Finally, if you TOWeb is blocked when trying to configure your host or during the publication, please verify that all security systems present on your
machine are all fully authorizing TOWeb (firewall, antivirus, ...). For more information see our advice about firewalls and internet security systems .

How to deactivate or delete your site?

During its life, your website will probably need to be temporarily deactivate or even permanently deleted. Below are advice on how to proceed in such
situations.

- Temporary deactivation : if you want to deactivate access to your site for all Internet users, you can do this from your TOWeb site's BackOffice. By
doing so, your visitors will then see a (customizable) maintenance message inviting them to come back later. But you (and only you) in the meantime,
will still be able to access your site online. This can be particularly useful for example when creating a new version of your site or adding new features
that need to be tested before making your site available again to everyone.

- Temporary and/or partial deletion : if you plan to close your site for several days, we advise you to do so by creating a new site that will be your
temporary and/or a partial version of your normal site. This temporary/partial site will only contain, for example, a single web page in which you will
give all the explanations relating to its temporary closure or, depending on the case, will be a clone of your normal site (using the "File > Save " & the
"File > Restore to a new site") in which you will remove some paragraphs or pages or features that should no longer be visible or usable for a while.
Once your second temporary site is been created, you can publish it (using exactly the same publication settings in the TOWeb host configuration
wizard) to replace your normal site. And later on, when you want to make your normal site available again, open it via the "File > Open" screen and
publish it entirely to put it back online.

- Deletion following a web host problem or for cleaning purposes : by deleting your site from your web space you will erase all your pages
including any old pages or data no longer used by the last version of your website. And then, by republishing your site again, this will allow you to
start from a "clean" site without any unnecessary files (or corrupted files) and save web space on your hosting.

- Permanent deletion :

In you plan to keep your hosting then you can create and publish for example a single page site which will explain the closure reasons of your site

and/or contain possible useful links to all visitors that used to visit to your site (or give the new address and a button pointing to your new

website if this is the case)

On the other hand, if you wish to definitively stop your site (for example following the definitive closure of your company or activity) then you will

have to contact your host to terminate your subscription, your account and your possible domain name.

What is PHP?

PHP is a programming language and the scripts of this language are placed in files using the ".php" file extension. Your TOWeb site uses PHP scripts for
all the i-services provided by TOWeb, such your web forms, user comments or e-Commerce functions.
Unlike scripts written in JavaScript, PHP scripts cannot run locally on your computer but only on a web server. This is why during a local preview of
your site your dynamic ".php" web pages are renamed to static ".html" web pages devoid of all the dynamic functions that cannot work locally.
To fully test all dynamic parts of your website, whether they are coming from the TOWeb i-services or any PHP scripts that you can add to your pages
(using the TOWeb script fields ) you will therefore necessarily have to publish everything your site first and then call it online from your server.

Updating your PHP version on your web server is an important point to keep in mind because in addition to making your site more efficient, you will
also make it less vulnerable to hacker attacks by using the latest versions.

Don't forget to perform a PHP support test fairly regularly, especially after your host has made updates/upgrade to your server.

Note: the PHP scripts of the TOWeb i-services and in particular those of the e-Commerce functions (related to orders, customer accounts, BackOffice,
real-time stock, ...) carry out file creation and writing operations on your space web. If you ever notice malfunctions reported on your e-Commerce
site, it is most likely due to insufficient authorizations on your web space that you will need to adjust.

Which PHP version to use on your web hosting?

PHP versions evolve over time and old versions are no longer maintained as is the case for example with PHP 5 which has not had any updates since
2019. Knowing that security vulnerabilities are regularly discovered in old PHP versions, for more security, durability and not to leave your site
obsolete or vulnerable, we recommend using the most recent version(s) of PHP.

If you have a version 13 of TOWeb then we advise to use a version 8.00 or higher of PHP because in addition to being always maintained this

version is much faster than all previous PHP versions (including version 7.4) and will therefore also increase the performance of your websites.

If you have a version 8 or 9 of TOWeb then you will have to stay with a maximum of PHP 7.4 and if possible at least a version 5.6.

If you use a version 7 or lower of TOWeb then you will have to stay with the possible old version 4 or 5 of PHP present on your hosting in order to

preserve and guarantee the good of your site while knowing that security vulnerabilities regularly discovered in older versions of PHP make your

site vulnerable to attacks (hackers, robots, viruses, etc.).

You will find below several methods allowing to know the version of PHP used at the level of your hosting:

1. If you have version 6 or higher of TOWeb, you can perform a PHP support test . The test email received in return will tell you the PHP version

number installed on your web server.
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2. If you have a version 5 or lower you can either:

ask your host provider or log in to your hosting account to find this information by using your web administration tools

or create a page of your site with a filename necessarily ending with the extension ".php", add a TOWeb HTML script field containing the

following line of code:

<?php echo "php version ". phpversion(); ?>

Then publish your site and open your page online to see the PHP version number used by your web server.
Warning: some hosts can sometimes carry out systematic PHP updates on their servers without you even knowing it, but generally this is done on
your request or will be imposed with prior notification if your version has become too old. In any case, if you are updating PHP on your server, it is
advisable to ask your host beforehand if this is possible and how to proceed.

PHP support test

The PHP support test integrated in TOWeb (accessible with the CTRL  + F8  keyboard shortcut) allows you to make sure that your host space will be
able to perfectly run all necessary scripts and dynamic functions of your web site. The vast majority of web hosts support the use of scripts on their
servers but a few free hosts do not allow scripts or sometimes very limited / restrained manner. If you use a host that does not allow the use of PHP
scripts, you will still be able to publish your website but in this case, we recommend not to use any interactive features on your site (no contact form
or other web forms, no e-commerce features, no user comments, or other i-Services ) since no dynamic function will work on your website.
And if your host supports scripting but PHP support test fails in TOWeb, then please verify each of the following points:

Verify you use the latest update of your TOWeb version

If you have enabled the option "secure FTP / TLS connection" located in the in the step #1 of the host configuration wizard ( CTRL  + F8  or

from "Publish" step ) then try disabling this option before proceeding to another test to make sure the problem is not due to that.

Make sure the URL you specified in step #4 of the host configuration wizard ( CTRL  + F8  or from "Publish" step ) is correctly entered before

making another test attempt.

Check your Windows firewall, antivirus and any other security software that may block the test : TOWeb must be allowed for all types of internet

access on your machine.

Contact your host provider to determine  

if there is not a configuration issue with your account and/or your server (such as insufficient access rights on your web space, restrictions

with certain PHP functions like mail for instance, 

if your domain name is correctly configured with their DNS servers,

and deactivate the "Browser Integrity Check" function of the firewall integrated into your hosting server (Cloudfare) if you have a "403

Forbidden" error message to verify that the blocking issue does not come from there.

Important: if the PHP support test works but you do not receive the test email, then you may want to:

consult the spam folder of your email account,

try to use another email address to determine if the problem is not coming from your email provider (which may requires you to use of a specific

email address) and contact your mail provider to make sure there is no probleme with your account

send emails using a SMTP server instead of PHP mail.

Problems & Solutions to connect or publish your website

1 - Check your version of TOWeb

Verify first that you are using the latest version 14.01 of TOWeb. The version number of TOWeb is displayed in splash screen upon startup and on the
button of the "File > License" screen or CTRL  + L .

2 - You already published your website in the past but it's suddenly not working anymore

If you were able to publish your website using your current host parameters but now encounter a connection problem don't modify your host
configuration but try again later, this might due to a high traffic from too many simultaneous user connections to your provider's server or due to a
temporary interruption of service for maintenance. Eventually if after other attempts the problem still persists, check the other points listed below,
especially the advice concerning firewall and Internet connection quality.

3 - The publication starts but fails before the end of the transfer

If the file transfer never reach 100% or if TOWeb stays totally frozen in publishing your website this is probably due to your Windows firewall or any
other internet security software installed on your computer (Norton, ZoneAlarm, Kaspery, ...). This type of issue can appear after the following events:

1. if TOWeb is not present in the exception list of your firewall

2. if your internet or protection settings have changed after the installation of a security update on your computer

3. if you installed a new version of TOWeb that was not correctly detected by your firewall and internet security software

In such cases you will need to reset your Windows firewall and internet security protection and manually add TOWeb to list of exceptions on your
machine. If after such verification you still encounter an issue check the following points :
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Verify that the size of your website is not bigger than the web space size provided by your host. If you are near the limit, try to publish your

website by using the "Entire site" update method, this will free up your web space before publishing.

Make sure you do not publish any file bigger than allowed on your web space (like a large video for instance) and no unauthorized file
(music for instance). Some host providers do not accept files larger that the size limit they establish. Furthermore, if your Internet connection is

too slow, your host provider may disconnect you to free the line if it appears to be not active (particularly on big files). When this happens, the

name of the file not fully uploaded is displayed with the error message in order to help you to locate this file.

If you have access to the Internet through a Wireless network (WIFI), verify that your signal strength is sufficient and that no other electronic

devices around are interfering ( too many errors during the data transfer may result in the failure of the upload, particularly with large files).

4 - You have never been able to publish your website yet

Verify that the FTP mode you use is the one recommended by your host provider

Verify that you correctly entered the user name and password as they were provided to you by your host, with a special care to their case

sensitivity

Verify that your FIREWALL and any other security software on your system (including your Cable or DSL modem) allow TOWeb to access the

Internet. If you are not sure, you may temporary disable your firewall and your antivirus settings but also restart your computer to make these

changes effective before to reuse TOWeb. If you are able to publish your website when your antivirus and firewall fully inactive, then refer to the

documentation of your firewall or security software to find out how to allow TOWeb to publish your website using FTP (File Transfer Protocol)

If your password contains accented or special characters then you may want to try to enable or disable the "Encode password" option located in

step 2 of the Host Configuration Wizard ( CTRL  + F8 ).

5 - Your host provider is NOT listed in TOWeb

If your host provider is not in the TOWeb's host list, you need to obtain the 4 following parameters from your host provider : the FTP server address of
your host, your login name, your password and the address of your website (your URL). Once you have these information, follow these steps :

1. In the 1st step of the Host Configuration wizard, select the option "My host isn't in the list, I will enter my FTP server address manually" and

enter the FTP server address of your host

2. Then in the second step, enter your name and your password

3. On the 3rd step, you need to indicate the specific subdirectory (if any) where your website has to be published on the FTP Server. TOWeb

generally detects this subdirectory for most servers but you may use the browse button to verify and select the good one manually if this is not

correct. If no subdirectory is detected and you encounter a problem publishing your website for the first time, contact your host provider to find

out which subdirectory name you should use.

4. On the 4th step enter your URL (the address of your website, without typing any prefix http:// or https://)

5. In the step 5, you may first try to use the option "Passive FTP connection" unless you encounter troubles publication issues like for instance a file

transfer aborted before the end of the transfer. Then finish the wizard to save your configuration information. Your website is now ready for

publication.

6- TOWeb indicates a successful transfer of your website but you can't see it or access it from the Internet
If you get the "congratulations" screen in TOWeb at the end of the transfer but can't see any result on the Internet with your web browser, this is
probably due to one of the following reasons :

1. If you are using a free web space or the one coming with your ISP connection, then go to your personal account to verify that your web pages are

correctly activated

2. Verify that the web address you entered doesn't have any typos. If this is the case, then open the Configuration Host wizard CTRL  + F8  and

update it from the step 3/5.

3. If you have your own .COM domain, your domain name may not be initialized yet in your host provider Domain Name Servers (DNS). Ask your

host provider to this DNS issue or to explain you how to do configure from your account.

4. Your host provider may require your website files to be transferred into a particular folder of their FTP server. Contact your host provider to verify

if you need to publish it under a special folder and to get the name of this folder. Then open the Configuration Host wizard CTRL  + F8  and

from the step 3/5 enter this folder name or select it from the "browse" button. Terminate the wizard to save this change and publish your website

again.

5. The transfer of your files may have been intercepted by security software activated on your machine. Verify your Windows Internet Firewall and

any security options or software (like for instance Norton, McAfee, ZoneAlarm, Kaspersky, Avast ...) installed on your computer as well as those of

your modem to authorize TOWeb to publish you website (file transfer protocol used by TOWeb is FTP on port 21).

7- The online version of your website has not changed or is not correctly displayed

Your web browser may continue to display old web pages previously visited and stored in its memory. Press the F5  key in your web browser in order
to refresh the content of your web page. You might also want to clean up the temporary Internet files and the history of web page you've visited now
and then and restart your web browser to solve this type of problem.
And if you're still seeing a different result online then press the SHIFT  + F12  keys to rebuild all your website content and publish it again using the
option "publish the entire site" to replace any damaged files on your web space.



8- Your images or fonts are not display correctly or your site is not fully functional
If you (or your web host) have just installed an SSL certificate so that your site can be secured by HTTPS access then make sure you have enabled the
SSL option in step 4 of the Host Configuration Wizard ( CTRL  + F8 ) then republish your site if possible using the "Publish the entire site" option.

And as much as possible, use local fonts on your site rather than Google's online fonts from their servers because these can sometimes be blocked by
certain web browsers or anti-tracking plugins depending on their configurations.

If you notice that only accented characters are not displayed correctly then you will have to check the configuration of your hosting. Indeed, on
some servers, an "ISO-8859-1 encoding" option is sometimes activated by default. If this is the case, you need to deactivate this option so that all
symbols and accented characters can be correctly supported (or select "UTF-8 encoding" according to the different choices offered by your hosting for
the configuration of your website).

9- Unwanted Ads
If you have not asked for ads but see them on your site when you visit it on the internet, then follow all our advice about unwanted ads on your site .

You've checked all these recommendations but the problem persists

If, despite the verification previously mentioned in this page, you are still unable to publish your website, contact our support directly from TOWeb
directly from the screen where the error is displayed or from the support form right after the problem occurs. TOWeb will then send your problem
automatically with an error report that will help us to determine and solve the problem you are facing with.

Publish on a local drive

TOWeb offers an optimized transfer of your website on a FTP server by only uploading new files or files that has changed since your last publication.
Nevertheless if you want to do the transfer by yourself like for instance if you use a web server on your computer or mapped drive (on your local
network or a Google Drive for instance) and have no FTP access then you will need to use the Export function located in the "Publish" step of TOWeb.
IMPORTANT: the transfer of your site using the FTP module of TOWeb is recommended as TOWeb synchronizes all the data of your i-services and as
synchronization can not be done with an export, this may result to functional issues especially on e-Commerce websites.
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Publish your site to your host provider with TOWeb

To publish your website you need to get the following information that your host provider have sent to you :

1. the address of the FTP server : here in our example we use "ftp.mydomain.tld" corresponding to a domain name "mydomain.tld"

2. your FTP login
3. your FTP password
4. your website URL, that is to say the internet address from where anyone will be able to see your site (in our example "www.mydomain.tld")

5. the publishing directory (or remote directory) where all you website files need to be transfered (it could be for instance /www or /public_html)

Step 1/5 : Host selection

From TOWeb, open the configuration wizard host either using the "Configure your host" screen located in the "Publish" step, or more directly by using
the keyboard shortcut CTRL+F8. Then select the Custom configuration option and enter the address of the FTP server name that you received
from your host provider. If your hosting provider allows a secure connection to your server, select whether you want to use a FTPS or SFTP connection.

Step 2/5 : User identification

In this step enter your FTP username and password that you received from your host provider. If the connection is refused and you get an error
message after clicking the "Next" button, make sure you entered these two information carefully observing lowercase and uppercase letters and
verify also that TOWeb is authorized by your Windows firewall, antivirus and any other internet protection software installed on your computer.
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Step 3/5 : Publishing directory

In this step, it is recommended to leave the default automatic detection of the publishing directory. Just verify that the directory detected and
displayed by TOWeb is the one that your host provider has given you. If this is not the case then manually enter the directory name or select it from
the list.
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Step 4/5 : Website configuration

In step 4, enter the URL of your site (usually your domain name preceded by "www."). If an SSL certificate is installed on your server to allow secure
access to your site by HTTPS then check the SSL option. Then, enter a personal email address before clicking "Start Test PHP". If test is passed you will
receive an email containing a verification number and will be ask to verify it. If you do not receive the email, consider check your antispam filters. For
more reliability on sending emails from your webiste you may want to add and use your own SMTP account  instead of using the default PHP mail
function.

https://www.lauyan.com/en/host-config.html#Bwg6BQvQ
https://www.lauyan.com/en/publish.html#GXJnPFuj
https://www.lauyan.com/en/smtp.html


Step 5/5 : Confirmation

Once the wizard is completed and terminated, you will just need to click on the "Publish the entire website" button. And later on, after any
modification made to your website, simply use the "Publish only changes" button.

For more information see also:

Problems & Solutions to connect or publish your website
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Search Engine Optimization (SEO)

The site optimizer tool of TOWeb

How will Internet visitors find your website ?

Keywords

Search Engine Advertising (SEA)

Avoid different duplicate content situations

Avoid deadlinks

Anti-plagiarism tips for your site

Structured Data

Using Google services in your website

Meta generator

Google Analytics

Using several Analytics tools

XML Sitemap files

Sitemap HTML inside a web page

Favicon

Optimizations for smartphones and tablets

Google Maps API

Additional tips

Search engine optimization (SEO) is the process of improving the volume and quality of traffic to a web site from search engines via "natural"
("organic" or "algorithmic") search results. Usually, the earlier a site is presented in the search results, or the higher it "ranks," the more searchers will
visit that site.

The site optimizer tool of TOWeb

The site optimizer of TOWeb is accessible from the link "Website Optimizer" located in the "Publish" screen. An orange pellet is displayed aside this link
to alert you about possible optimization for your site when it is the case. By default none of the base sites originally created by TOWeb are optimized
as these are only starting examples and it is up to you to customize all their content with your own texts and images.
TOWeb analysis and detects multiple points of possible improvements for better ranking of your site by search engines such as Google. The test results
vary with the content of your website, so it is important to regularly look at the results and guidance  displayed by this optimizer each time before
you publish/update your site. Each point analyzed by TOWeb can be reported:

in green to indicate that all optimization criteria are satisfied,

in red to alert you about possible optimizations of great importance,

in orange to alert you of optional optimizations (but to consider as they are generally recommended to improve your SEO and/or the popularity

of your site).

When optimizations are possible then you can click on their name for a detailed list of the changes you need to apply and/or to see the different tips
and advice identified by TOWeb. You may also save the results of the optimizer report into a file, for example if you need to study it outside of TOWeb
or if want to print it.
Finally out of all points and technical advice reported by the website optimizer of TOWeb, it is also very important to pay particular care not only to the
structure and navigation of your site but also to all your texts by reading all the other tips of the located below on this page.

How will Internet visitors find your website ?

Most of your visitors will find your website using Internet search engines such as Google. To comply and authorize this, follow this 3 steps procedure :

1. for each topics of your website (and especially your home page) verify and update their general information. You can do this from the "Search

Engine Optimization" area located in your "Topic Settings" :

title : choose the right words for your page title. This is the most important information search engines will use to locate your website. To

determine the appropriate title, imagine which words your visitors would enter in a search engines to get to your website

description : make few sentences that present and best summarize all the content of your web page (or website if it's your home page)

enable search engines : just leave the option unchecked to authorized search engines on your web pages

2. give a name for each of your web pages. Your home page will automatically be and stay with the filename "index.html" (or "index.php") but for

all other pages you may want to give as page file name that will be fixed and final for all your URLs

3. very all your texts and paragraph titles. These are scanned, extracted and analyzed by search engined robots that try to understand the meaning

to categorize and organize all these in there database. The choice of your texts and sentences is therefore very important

4. add a title on each images if you want them to be best indexed by image search engines such as Google Images

5. now your website is ready and available, you can submit your website to GOOGLE

Your website is still not visible in Google
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Your website will be automatically referenced in search engine databases but this may take times. To improve ranking and position in their search
results. To do that here are some advice to consider :

the content of your web pages : the information and text content of your website is essential. It must be useful for your visitors and should

contain the important words or sentences your visitors are looking for. If you use a word very often and place it in your topic's tile, this word will

become an important one on your website.

External links : if many websites contain a link your website, this generally means that your content is interesting or in relation with these

websites. The more links you will have on the internet the more important your website will be so you might consider the exchange of links or

banners with websites similar to yours.

regular updates : in order to make people come and visit your website often, it's important to update it periodically and add new useful

information. Search engines take in accounts such aspects so it's important to maintain your website up-to-date and alive.

try not to rename or deleted the web page names (URL) of your website as they have been bookmarked by user and stored by search engines. If

possible keep our old web page by just removing their content and providing link to the new page(s)

the page title should summarize all the content of your topic. It should not be a sequence of keywords but a sentence (with or without any

verbs). You should carefully choose the word you use for it as it must stay as short as possible. In fact your title is longer that 60 characters the

rest would generally be ignored by search engines.

the page description generally contains one or two sentence to present the content of your topic. This text is also the one commonly displayed

below a found link on the list of search results. For best SEO in search engines it is advisable to put a Meta <description> that does not exceed

268 characters (maximum 330 characters possible). It is important for both Meta Title & description summarizing a topic to be as clear and

concise as possible and stay within those limits. If this is not the TOWeb case will show in red the field name to indicate that.

Install an SSL certificate to secure your site by HTTPS .

You will find further useful information on the internet to improve your website ranking and especially the Google advice on SEO

Eventually be patient ! Your website is not likely to become famous on the internet in just few days. This may take weeks, months and even years
before your website to appear on the top of search engine results.

Keywords

Google and other search engines place a lot of importance on content. Textual content is based on the importance of the words and phrases you have
chosen to build it. These most important words in your content are called keywords, the very ones that people will type when they search on Google to
find you.
Warning: the keywords are no longer related to the HTML tag which may contain keywords but no longer used by search engines like Google.

A keyword is a word that must be searched by users and must match the subject of your site/page.
There are different types of keywords to avoid or prioritize as needed:

The "competitive" keywords are the most coveted. The more people who want to position themselves on the same keyword, the higher the places

on the first pages of results will be difficult.

The "parasitized" keywords are words whose results may vary when a word can have several possible meanings / interpretations and thus result

in a search that is not relevant to the user.

The "rare" keywords are key phrases that may be relevant, highly technical, little known or not often used. The traffic will not be important but

you will have the advantage of only very few competitors and so to reach the desired target and/or be among the top results in the search

engines on these words.

Each keyword has a specific role and needs to be carefully selected because it has a direct impact on your SEO. A few tips :

Do not abuse redundancy of a keyword but find synonyms and vary expressions.

Think "key phrase" rather than a single keyword because the search requests of Internet users generally count several words or expressions.

Choose keywords that best fit your target.

The title of your page should include the main keyword at the beginning of the sentence and be catchy.

The first paragraph has an important role, supposed to summarize the main information of your page. It's a good idea to use your main keyword

at the beginning of this paragraph and add some key phrases about the topic of your page.

Create links to keywords that link to other pages on your site. The internal mesh of your site is important, it should not be neglected.

Put some keywords in bold but in moderation.

Keyword generators:

Übersuggest is a free keyword generator that lists keyword suggestions based on your search and the selected language.

Google AdWords , primarily intended for Google AdWords users, this tool can also be used for natural referencing by the suggestions of keywords

it offers, their search volume and the degree of competition based on typed queries by the internet users.

Search Engine Advertising (SEA)

SEO (Search Engine Optimization) is essential, it requires work and patience but does not require any cost. Depending on your budget, an additional
strategy can also be considered: SEA (Search Engine Advertising) paid search to position your site among the top results of search engines with
sponsored links.
The SEA consists of the auctioning of keywords on one or more broadcast networks such as:
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Google AdWords

Microsoft AdCenter

Sponsored Links

When a user searches for keywords that the advertiser buys, the ad is displayed in designated boxes. The advertiser does not pay the display of his
advertisement but only the possible click of the user on the link (CPC, "Cost per Click").

Avoid different duplicate content situations

Duplicate content is a practice sanctioned by Google likely to seriously penalize your SEO. Our advices :

1. Configure your server in order to correctly redirect of your internet domain by using for instance your .htaccess file . Indeed, if your domain

name is for example "my-toweb-site.com", then it must be accessible and displayed by a browser either with the URL "https://my-toweb-site" or

the URL "https://www.my-toweb-site.com" but never both. Test your site by entering the name of your domain with and without its prefix "www."

to ensure that whatever the name entered is always exactly the same URL displayed in the address bar of your browser. Because, it it's not the

case, search engines will consider these 2 addresses as 2 separate websites with duplicated content and this is very strongly penalized by Google

which considers this as a duplicated practice and attempts to cheat and trick search engines by an artificial double increase of its presence on the

internet. And if your site is secured by SSL  make sure that, by using the prefix http:// in your browser, it automatically does the redirection to the

secured https:// URL.

2. The choice of the words and terms used inside your pages: look for synonyms or other expressions to avoid multiple redundancies.

3. On paragraphs and pages : use internal links on words/expressions that point to their explanations in order to avoid repetition and build a

good network of your pages with well organized and centralized information. Also check that none of your pages use the same title.

4. If you have a multilingual site, Google will not consider it as having duplicate content but on the condition of paying attention to the quality of

your translation. Because if your content is poorly translated (especially if you use an automated translator tool) or the meaning of your

sentences does not seem natural, then search engines could consider them as "duplicate content". The best way to avoid this kind of problem is

to hire a professional translator. Not only will your content not be considered duplicated but you will offer a better quality of your texts, readability

and comprehension by your visitors and this will also improve the SEO of your site for these languages.

5. Do not publish your site on several hosts and/or different domains. You will not increase its popularity by doing this, quite the contrary. Your

site should only be published  and exist in one place only on the Internet and if your site changes address or if you have multiple domain names

then use redirection to your unique site.

6. regarding the images: there is no statement from Google of a any negative impact but as things can evolve quickly (and/or not always made

official), if you ever use photos of which you are not the author (pictures you bought from a third party or free of rights found for example on the

internet) we advise you to make a change as for example a simple image crop and/or apply a graphical effect on it with TOWeb (like for example

a sepia or B&W colorization) in order to make your version different for search engines and not associated with any other sites using this picture

too.

If you need to check or spot a duplicate content by yourself on the titles of all your pages you can do a Google search the following way:

site: yoursite.com intitle: "key phrase or word to search"

By replacing the blue parts of this request with those desired (meaning the address of your site and the duplicate text you are looking for), Google will

display all the pages of your site whose title contains exactly the same terms entered between quotes.

Finally there are also many duplicate content verification tools you may use such as the free ones below:

https://www.siteliner.com for a detailed analysis of the duplicated content of your site and comparisons to other sites on internet

https://www.seoreviewtools.com/duplicate-content-checker  to search for both internal and external duplicate content of your site

https://www.copyscape.com  for searching copies of your site on the internet (but also use its other content comparison

tool https://www.copyscape.com/compare.php ).

Note: since 2013, TOWeb has made it possible to create sites responsive i.e. websites that automatically adapt to mobiles, tablets, computers and

other connected devices capable of surfing the internet (televisions, ...). Because you therefore do not need to manage or have separate site

dedicated to different devices but a single site content, you will therefore have no duplicate content" problem regarding that by using a version 5 or

higher of TOWeb.

Avoid deadlinks

Dead links are links pointing to web pages that do not exist (or no longer exist), making them impossible to open by both internet users and search
engines. Dead links can be either internal to the pages of your site, or outgoing (pointing to other sites than yours) or inbound (other sites than yours
having links to pages that no longer exist on your website). Dead links can hurt not only your SEO but also your visitors when they return to visit your
site from the favorites they saved on their browser.
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Internal dead links: TOWeb automatically regenerates your site as well as its internal links therefore none of your pages can contain any internal
dead link between them.

Outbound dead links: TOWeb's built-in site optimizer allows you to automatically analyze all external links used in your site's pages and report all

those who have died. Depending on the quality of the sites you point to and the number of external links you use, it will be necessary to check

regularly enough to make the necessary changes.

Inbound dead links: they can occur in the following 2 situations:

when permanently deleting a page from your site

when changing the file name of a page on your site

Once a page of your site has been published (and is therefore known to Google or internet visitors), it should normally never be deleted because it will
still be referenced for several days/weeks in the Google database and therefore will continue to be displayed by the Google search results, which will
lead to dead link errors. And it will also be the same for users who have added your page to their favorites.
Instead of deleting a page, it's best to only delete all of its content in order to let people know why it's being removed and place a link to a new page.
And if your page no longer has any interest, activate the TOWeb option to disable search engine indexing for it.

As for the name change of a page, it also comes down to the same consequences that a deletion may as it will no longer exist under the name known
by Google and your visitors. If you need to change the file name of a page on your site then you will need to use a redirection rule in your site's
.htaccess file to specify what was its old file name and what its new name is now. For example, if you have a page named "page.html" that you now
want to rename to "infos.html" then you will need to add the following permanent redirection in the .htaccess file of your site:

RedirectPermanent  /page.html  https://www.mysite.com/infos.html

We also recommend that you activate the custom error pages in order to have a 404 error handling on your site.

Anti-plagiarism tips for your site

Copying and pasting existing texts on the internet into your pages is not only prohibited without the consent of their authors, but it also turns out to
be very harmful to the SEO of your site. To avoid this situation, you will have to reuse the "idea" (but not the text) by rephrasing it with your own
words but also by adding your own additional information (your examples, your photos, your tips, your personal experience, ...).
You can possibly also carry out some verification to by using anti-plagiarism tools such as this one https://www.quetext.com . 

Conversely, you may also notice yourself having been plagiarized after having carried out a search for duplicate content  on the internet or after having
been simply informed of it by a third party. In such a situation where scraper pages of your site exists elsewhere, here is a procedure you may follow :

1. First contact the owner of the site to notify this person of your original page and remove the copy he/she made or find an amicable arrangement

2. If that doesn't work then 

File a copyright infringement report to Google  

Report scraper pages to Google

3. As a last resort, initiate legal proceedings with the appropriate authorities after having gathered all the necessary evidence, including the non-

response of the plagiarist to your multiple requests or the responses showing that this person does not take you seriously or recognizes

plagiarism without wanting to make the slightest modification to his/her site.

Structured Data

The structured data that you can add to certain pages on your site is used by Google and represents a standardized format for providing information
on these pages and classifying their content. Google recognizes about thirty different types of structuring content among which we find for example
articles , cooking recipes , events , job offers , reviews , products , and announcements related to COVID-19 introduced in version beta by Google since

April 3, 2020.
Your structured data must be written in a text format contained in a script of type "ld+json" (JavaScript Object Notation for Linked Data). The data
structure uses opening brackets (like "{" or "[") and closing brackets (like "}" or "]") and comma separators (","). Each data item is defined by a
name, followed by the character ":" and its value (the name and its value must be placed in quotes). For more information on the structure of
structured data and how it works you can consult the Google guide  and also use the Google structured data test tool  to verify your data. 

Once your structured data has been established, you just need to place your script in the <HEAD> section of your page, accessible in TOWeb from the

"Section <head> and other Meta tags" button located in the "SEO optimization" options of your topic.

Basic example of structured data from a COVID-19 announcement valid from April 14 to May 11, 2020 :
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<script type="application/ld+json">
{
"@context": "https://schema.org",
"@type": "SpecialAnnouncement",
"name": "NAME OF YOUR ANNOUNCEMENT HERE",
"text": "TEXT OF YOUR ANNOUNCEMENT HERE",
"datePosted": "2020-04-14T00:00",
"expires": "2020-05-11T23:59"
}
</script>

Using Google services in your website

In addition to submit your site to the Google search engine, Google offers free services handled and assisted by TOWeb. To configure them in TOWeb
you first need to open a Google account. These TOWeb options are available in the "Settings > Google Services" screen and they include:

Google Diagnostic

Google provides an invisible tag you can place in your site to confirm that you are the owner. Log in to Google webmaster tools with your Google
account to choose a verification method and select it thereafter in TOWeb. The simplest method that we recommend is to select the Add a meta tag
verification and copy/paste the line of code that provided by Google. This code line should be like this one:

Meta generator

A TOWeb Studio edition allows you, if you wish, not to generate the tag "meta generator" in your site by selecting the choice "None" for "Meta
generator" option located in TOWeb screen "File > Your website". But unless you are a web developer with very specific needs, we advise you to keep
the generator meta tag to your site not only because this information is not visible to internet users visiting your site but also because :

this meta generator tag is used to facilitate technical assistance in case of problems on your website. If you remove it and contact the technical

support Lauyan then, depending on the problems that you may encounter, this may delay the research and analysis of all possible causes and

therefore postpone the problem resolution time. A republish of your site after reactivating the "meta generator" tag of TOWeb may also be

requested by our technical support until the resolution of your problem is completed

the presence of the TOWeb meta generator tag in your site can also improve your SEO. In fact some search engines such as Google are fully

aware of the different structures and mechanisms used by major websites generators, this to better reference all text and other elements located

inside your site, so they can make the most judicious and appropriate predictions on the role, relation, meaning of all your site content; as many

points which will not be processed if this information generator is removed from your website.

Google Analytics

This service from Google tells you how visitors arrived on your site how they explored and what you can do to improve the comfort of use. To integrate
this service automatically to all pages of your website, simply connect to your Google account to know the code of your site and enter it in TOWeb. This
code is of the form
G-xxxxxxxxx (example: G-VZBBNGKK9Q) if you are using the latest version 4 of Google Analytics .

The IP Anonymization of Google Analytics (also called IP masking) helps you to strengthen your own privacy policies as well as support the
recommendations from local data protection authorities in some countries which may prevent the storage of full IP address information. If you use
Google Analytics on your site and want to activate the IP masking you only need to check this option located in TOWeb step “Options > Google
Services”.

Google Analytics 4
If you used until now the old version of Google Universal Analytics (using the UA-xxxxxxxx format) for your sites then you can leave them in TOWeb
so as not to lose your history, but we advise you to migrate to the latest version now Google Analytics 4 in order to obtain your new codes (of the form
G-xxxxxxxxxx) so that there are no data breaks in your statistics.
To use GA4 on your site you need to use a TOWeb version 11 (or greater) and follow this procedure :

1. Log in to your Google Analytics account and click on "Admin" (settings icon) to use the Google Analytics 4 Setup Assistant

2. Once the GA4 migration is done, then follow the Google procedure explaining how to know and "copy" your new GA4 tracking ID (G-xxxxxxxxxx)

3. Then "paste" your GA4 tracking ID (G-xxxxxxxxx) in the TOWeb "Options > Google Services > Google Analytics" screen before fully republishing

your website.

Warning

The old version of Google Universal Analytics using codes of the form UA-xxxxxxxx has

stopped working since July 1, 2023
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By logging into your Google Analytics account again, Google will detect your new code and start showing your new GA4 data after 24 hours.
For more information see the help center of Google Analytics .

Using several Analytics tools

By default TOWeb allows you to integrate Google™ Analytics directly into all pages of your site in an assisted way to analyze the visitors' activity of
your site. But whether you decide to use Google Analytics or another system of audience measurement, it is often useful to add a second one to
confirm the results of the first one or to have additional results like for example by using one of the these services :

Quantcast

AdobeAnalytics

Piwik

Charbeat

Clicky

ClikTale

In order to integrate these services into a page (or your entire website), you will need to use the TOWeb script fields .

The list of services previously given as examples is not exhaustive. It is up to you to find which service(s) you prefer, according to whether they offer

identical or rather complementary features, depending on whether they are free or not, according to their respect of the GDPR , or any other needs or

concerns.

Some audience measurement tools can also allow you to run advertisements on your site, such as Facebook Pixel supported by TOWeb in the
"Options > Advertising" step (a version 8.00 or greater is required).

XML Sitemap files

A sitemap file is a file used by search engines such as Google to obtain more information on your website. Your sitemap file is automatically created,
updated and published by TOWeb on your web space based on changes that you make especially for example when you add a new topic to your site.
It is not necessary to create it yourself or use any other generator. From the setting of each topic, you can specify the level of each item a page
priority between 0 (minimum) & 10 (maximum) and frequency of its updates. The sitemap file created by TOWeb is published inside the root directory
of your web space and its filename is "sitemap.xml".

After each successful publication of your site, TOWeb allows you to send the new sitemap of your site directly to the search engines of Google and
Bing/Yahoo so that they can immediately take into account your latest changes. But before that, if needed, you can also scan your QRCode with
your smartphone or tablet to direct check your website online.
TOWeb offers you the possibility to generate the information of the images of your site in your file sitemap.xml or in a separate file images.xml for a
better SEO on Google Images.
Note: If you use an external tool to manage the sitemap files of your site and/or if you want to manually update and publish them yourself outside
TOWeb, you will need to disable the Sitemap option in TOWeb. By doing so, the site optimizer of TOWeb will systematically show a "Sitemap" warning
to remind you to check that your sitemap files are up to date on the other tools you use for them.

Sitemap HTML inside a web page

The «XML» sitemap files automatically generated by TOWeb help search engine robots to discover the pages and changes of your website. But adding
an additional «HTML» sitemap to a page of your site can also be very useful, especially to your visitors. Indeed an HTML sitemap includes a structure
and presentation of the different pages of your website in a more readable format than a simple unordered XML list. Furthermore it can be more
complete and complementary to the other navigation ways of visiting your website (so in addition to tour website menus and page footers).

You can either choose to reuse an existing topic of your site or create a new page to add a HTML sitemap build by yourself in one or several
paragraphs containing your list of links on images and/or buttons. And you may as well provide more details next to the name of each link or any
description when needed. The result will then be more understandable than a simple name/text located in a website menu (as generally text in menu
are often very concise) and will also help search engines such as Google to better analyze & understand the content of your pages.
Furthermore, your topics are not necessarily always accessible from the menu or the footer of your site (especially when it begins to become quite
large). But as your site must keep the best possible ease of use and readability, neither your menu nor your footer should turn into gigantic lists of
links and to have all your pages presented in a separate page will bring them more visibility. Indeed, certain secondary topics of your website certainly
deserve to be known and red by your visitors so it is also by having an HTML sitemap page can help you will identify and present them all as you want.
TOWeb allows you to start your HTML sitemap in any section of your site (both an existing section and a new section which will be dedicated only to
this) by adding a paragraph which will use the "sitemap" object. site". You can then edit its content to add your texts, icons, buttons and improve the
presentation of all the pages of your site.

Favicon

A favicon is an icon symbolizing your website. Web browsers use favicons to display them in their address bar, bookmarks, tabs and other shortcuts

pointing to any page of your site. Furthermore, since the end of summer 2019, Google has also begun to display favicons in its Search Engine Result

Pages (SERPs). It is therefore strongly advised to add one on your site to allow users to better identify your image (for example the logo of your

company, organization, product) and better recognize it later when they are looking for you or come back to visit your site. A favicon is a squared

image, preferably with a size of 32x32 pixels and saved in a PNG or ICO format (especially if transparency is used).

Metro, iOS & Android icon
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This icon in PNG format is similar to the favicon but of greater size. It is primarily used by Apple products (including iPhone and iPad) and the latest
web browser versions of Microsoft.

Important : your favicon is supposed to be "stable", so do not change it frequently

Optimizations for smartphones and tablets

With TOWeb, some information and rules for smartphones can be added to your site in order to have it better displayed depending on the content of
your pages and/or what you want.

Google Maps API

Since June 22nd, 2016, the usage of the Google Maps APIs requires a key. If you have not any yet for your domain or site you can get your API Key
from Google . Keep in mind that each free API key comes with a 25,000 map loads per day limit so, for very large websites with numerous visitors, you
could possibly need a Premium Plan license from Google. For more information and conditions of use, please refer to Google. Once you have your API
key :

you just need to copy/paste your API key in TOWeb step "Options > Google Services > Google Maps". For more information on how to add Google

Maps to your website please see the Google Maps object .

if you use an old version of TOWeb or want to manually add your code separtly for each of your web page

then you will need to follow Google instructions and copy/paste your code by using the TOWeb script fields .

Additional tips

See also the following pages:

Navigation and structure of your website as internal links in your site but also external links to other sites are very important not only for your

visitors but also Internet search engines

Custom error pages and files "robots.txt", ".htaccess" and "sitemap.xml" to handle all the errors and rules of your website.
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Suspend the activity of your site

Certain crisis or unforeseen situations (like the Covid-19) can bring an upheaval in your activity and your website during a temporary period. As the
solution to completely stop your site or change all its content can have very negative consequences for Google and permanently harm your SEO, you
will find on this page some tips to minimize and avoid such a scenario.

Limit the functionality of your site

If you plan to resume your online activity at the end of the crisis, the preferred solution is to limit the functionality of your site and be able to put
everything back in place very easily later on.

Deactivate the shopping cart of your e-Commerce site
If all your sales are impacted, deactivating the shopping cart of your site is the most comprehensive and simple solution to prevent visitors from
ordering. In addition, your products will still remain visible to visitors and all of your catalog pages will also continue to be indexed by Google.
You can remove the shopping cart of your site and deactivate all e-Commerce functions from the "Options > e-Commerce" step of TOWeb and
subsequently reactivate everything back with a single click from there too.

Deactivate only certain products of your e-Commerce site
If only some of your products are impacted, you can activate their "Product not available for sale yet" option (and deactivate it later on when the time
comes) or modify your stock from your backoffice to set it to zero.
If necessary you can add an explanatory text to the introduction message of all your affected catalogs or modify the "checkout introduction message"
of your cart (Options > e-Commerce > Shopping cart) and, if needed, add or deactivate your delivery modes.

Inform your customers or visitors of the situation 

 Pin important information on your social networks. If you do not yet have a Facebook page or Twitter account this will be an opportunity to set
them up and use them rather than modifying your entire website. You can display social media buttons on your site from the "Theme" step of TOWeb
and add the different URLs of your social network pages there.

 Send mailings to inform customers of your situation and development. An email remains one of the simple and effective way to easily and quickly
reach your subscribers or customers.

 Use a script to display a banner or pop-up window that will inform your customers of changes in your business when they visit your site (or
certain pages of your site).

 Add a new "alert" paragraph to the home page of your site by making it clearly visible to your visitors but with the shortest possible content in
order not to the information on your home page and if needed, use a link/button pointing to a new page that will explain the situation of your activity.
If you have one or more new topics dedicated to the explanations of all the changes in your activity, don't forget to use the "Disable search engine
indexing of this topic" option located in the "Search Engine Optimization" properties of your page so that they are not taken into account by Google.
And for the CSS style of your "alert" paragraph this can be done:

by applying "Panel" or "Highlight" or "Custom 1-5" to its "Style" property and then by modifying this style from the CSS editor of the "Theme"

step to change its background color, its borders, etc.

by adding to it a possible object that can enhance your information, for example Note or Card  object.

 Add a temporary introduction page to your site. By adding a new "introduction/agreement page" to your site, this page will always be read first
when accessing your site. Then indicate in this page the necessary content that will inform your visitors of all the functional changes of your site. And
later on, when resuming your activity, simply delete this introduction page and republish your site. But be careful with this solution as using an
introductory page for a long time may have an impact on your SEO.

Delete or adapt the content of the necessary paragraphs

If some of your paragraphs no longer need to be displayed on your site for a temporary period and their content is not of essential interest in terms of
SEO for your page (for example a paragraph containing a form which is no longer appropriate to the situation) you can optionally apply the value "Not
published" to its Display property. And if a paragraph needs to be largely redone, rather than deleting it permanently, you can:

either mark it as "Not published" and duplicate it so you only update its new copy and be able to quickly return to the situation before by just

deleting it and changing to "Visible" your original paragraph,

or, if you have a Studio edition of TOWeb , use the paragraph export function to keep backups before deleting them and be able to put them back

later on using the paragraph import function (choice accessible when adding a new paragraph).

Update your structured data

If your site uses structured data ,  them accordingly. As part of the Coronavirus, you may be required to use the structured data

"SpecialAnnouncement" to highlight your information related to Covid-19 in Google's search results. If you are unable to add structured data to your

site, you can also add a Coronavirus announcements via the Google Search Console .
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
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
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Notify Google of updates to your site 

After each change and publication of your site, use the TOWeb buttons to notify Google and Bing that you have modified your site (a version 8.00 or
higher of TOWeb is required for this).

Deactivate your site only as a last resort

If all the previous tips are not enough and you have to deactivate your site then you will have to delete it from your web space (function located in the
"Publish" step) and republish only one web page instead that will explain your situation or add rules in your .htaccess file to redirect all your pages to a
single explanatory page.
But deactivating your site and its content is not recommended by Google as it could permanently damage your SEO. If you ever have to do it then :

your site should only be inactive for a very short period of time (a few days at most) in order not to have a negative impact on your SEO,

and you should avoid notifying your changes to Google after updating your site.

Additional tips

See also the following pages:

Search Engine Optimizations

Navigation and structure of your website as internal links in your site but also external links to other sites are very important not only for your

visitors but also Internet search engines

Custom error pages and files "robots.txt", ".htaccess" and "sitemap.xml" to handle all the errors and rules of your website.

https://www.lauyan.com/en/site-rules.html#WaeZYRL4
https://www.lauyan.com/en/website-pause.html#uU8pqDUy
https://www.lauyan.com/en/seo.html
https://www.lauyan.com/en/menu-links.html
https://www.lauyan.com/en/site-rules.html


Advertising 

Ads in your webiste to earn money

Advertising with Facebook Pixel

Unwanted ads on your site

Ads in your webiste to earn money

Adding ads to your pages can be a good source of revenue depending on the audience of your site and the number of visitors. From the "Options >
Advertising" step, TOWeb allows you to automatically add ads to your site whether you use Google Adsense or another ad network of your choice.
Depending on the content of your pages, TOWeb will choose for you the locations deemed most appropriate. But if the display and the choices made
by TOWeb do not suit you but instead you want a more targeted and specific display behavior, it may be more judicious to consider using TOWeb HTML
script fields instead in order to place where you want the scripts provided to you by your advertising agency.
Remarks:

Advertising scripts for TOWeb added into the pages of your site are unpaid and only appear when using the Free edition of TOWeb (but not in paid

editions).

if "unwanted advertisements" appear when you visit your site on the internet, they are generally due to either your host provider (especially if it

is a free hosting), or the use of a malicious script or service that you previously added to your site such as for instance a "free web visit counter"

that actually does more than just that but could not only add ads, spy the visitors of your website or even hack your server. If this is the case,

delete all the scripts that you added to your site before republishing it completely, change your passwords and make sure that your web server is

not damaged and/or ask your host provider to check for anomalies in your web server or web space.

Advertising with Facebook Pixel

Facebook Pixel is a traffic analysis tool comparable to Google Analytics but which, in addition to allowing the tracking of your visitors (pages visited,
purchasing actions, ...), will also allow Facebook to know what types of Net surfers purchase on your site in order to spread your advertising to all
Facebook users most likely to buy your products. To use Facebook Pixel on your site, you need to

1. manually create a pixel ID  and enter its value in TOWeb's "Options > Ads > Pixel ID" field

2. enable Open Graph meta data in your pages from the "Section <head> and other meta tags" button located at the "SEO Optimization" of your

topics (or at least the web pages that you wish to be shared by Facebook)

Remark:

Entering a Pixel ID in TOWeb also allows you to activate (or deactivate) the tracking of certain events on your website such as for the orders (Options

> e-Commerce > Shopping Cart > Event Tracking) as well as the use of your website's search engine (Options > Search Engine).

Unwanted ads on your site

If you see unwanted ads when visiting your site online then make sure

to publish your site with a Premium / E-Commerce / Studio edition of TOWeb and not with a Free edition (or with at least an E-Commerce edition

if you have an online sales site) by checking this from the "License" screen of TOWeb. From there verify first you use TOWeb version you

purchased and if it is the case but see Free edition then install your registration key

that the server of your host provider does not add advertisements to the content of your pages especially if you use a free web hosting service

that you have not added some third party scripts responsible for the display of advertising and other undesirable effects or even detrimental

actions to your site and your visitors

that web browser is not reusing and displaying old page of your site stored in its temporary internet files .

https://www.lauyan.com/en/ads.html#ADjAWNqa
https://www.lauyan.com/en/ads.html#VG4CnPkb
https://www.lauyan.com/en/ads.html#VOwa7M3n
https://www.lauyan.com/en/ads.html#ADjAWNqa
https://www.lauyan.com/en/scripts.html#qDt0S96K
https://www.lauyan.com/en/ads.html#VG4CnPkb
https://www.lauyan.com/en/seo.html#YxHMynuy
https://www.facebook.com/business/help/742478679120153
https://www.lauyan.com/en/ads.html#VOwa7M3n
https://www.lauyan.com/en/install-guide.html#BrabBoTa
https://www.lauyan.com/en/publish.html#awBJ47FR
https://www.lauyan.com/en/scripts.html#IXm0KfEt
https://www.lauyan.com/en/publish.html#6HqB518e


What is the Responsive Web Design ?

How a responsive website displays on PC and mobile ?

The image above shows how a website is typically displayed on a computer: the width of the screen allows to view the website without horizontal
scrolling and the texts are large enough to be clearly legible. You just have to scroll vertically to see the page content.

But on a mobile phone or tablet, the physical width of the screen decreases dramatically, and here is how the same site will be displayed on a
smartphone depending on whether it is responsive or not:

Responsive

https://www.lauyan.com/en/responsive-webdesign-faq.html#LH92KzRy


The responsive website have adapted its layout and remains easy to read and navigate: the menu is folded under a button at the top left
corner, the text size is important to read without effort and the content of the site has been reorganized in height without overflowing horizontally.
There is no need to zoom in/out or scroll the site horizontally with complex touchscreen gestures. The visitor has just to scroll vertically
with one finger, as on its PC. Buttons and links are easy to point/tap without risk of error.

Not Responsive

https://www.lauyan.com/en/responsive-webdesign-faq.html#YH6F6ft2


The non responsive website appears in the same way as on the computer screen, but on a surface 80% narrower. On a very few inches wide
smartphone screen, texts become too small to be legible. The visitor must make constant touchscreen gestures to zoom in & out and scroll
horizontally & vertically to reach the parts of the site he wishes to consult. These tactile manipulations are very unpleasant for a visitor
(unreadable texts, unusable web forms, ...) who is likely to quickly leave such a site.

Up and down scroll only
 

No horizontal scrolling
 

https://www.lauyan.com/en/responsive-webdesign-faq.html#s74Cn16l


No zoom required
 

Does the Retina screens are not the solution ?

No, they do not change the display problem of non responsive sites on mobile: it is the physical screen size that matters: a 2" wide screen will always
be 2" wide whatever its resolution and pixel density. Texts too small to be read comfortably will have the same size on a screen with a pixel density of
300dpi or 150dpi.

Why do I need a mobile friendly website ?

Thanks to mobility of smartphones, users search more and more frequently and immediately on the Internet for information and sites as soon as they
need them, they compare prices and services, they easily spread their information to their contacts, etc.

Mobile data traffic per smartphone worldwide (in MB/month)
Sources © Statistica 2024

As of July 2024, global internet traffic via computers accounted for only 37.1%, compared to 60.7% for mobile devices. 95.9% of internet users
access the web via their mobile device (including 93.7% via smartphone), 62.2% via a laptop or desktop computer,

Why not create a mobile website in addition to my current website ?

It was the only option before the responsive approach, but the disadvantages of this method makes the obsolete today:

two websites ... twice more work: you have to report on the mobile site any change made to the computer website, and vice versa. For a website

updated regularly as an e-commerce website that is very difficult and may cause many errors. By creating a single responsive website you save

time and money and you are sure that your content is always up to date for all devices.

search engine optimization: with separate websites, your content site will be partially or completely duplicated on several sites with different

URLs, which is a very bad SEO practice ("duplicate content" penalty). And your backlinks and keywords will be diluted in 2 locations. It is very

difficult to overcome these SEO pitfalls.

creating separate sites for mobile and PC is not the option chosen by the major brands: responsive approach is used by Microsoft on its website

and it is one that is recommended by Google to webmasters :

https://www.lauyan.com/en/responsive-webdesign-faq.html#yeCfyQA5
https://www.lauyan.com/en/responsive-webdesign-faq.html#i6HuRwjH
https://www.statista.com/statistics/738977/worldwide-monthly-data-traffic-per-smartphone/
https://www.lauyan.com/en/responsive-webdesign-faq.html#eBoeBPJ9
https://www.microsoft.com/
https://googlewebmastercentral.blogspot.ch/2012/06/recommendations-for-building-smartphone.html


When building a website that targets smartphones, Google supports three different configurations:
1. Sites that use responsive web design, i.e. sites that serve all devices on the same set of URLs,
with each URL serving the same HTML to all devices and using just CSS to change how the page is
rendered on the device. This is Google’s recommended configuration.
2. Sites that dynamically serve all devices on the same set of URLs, but each URL serves different
HTML (and CSS) depending on whether the user agent is a desktop or a mobile device.
3.Sites that have a separate mobile and desktop sites."

How to test if my website is responsive ?

There are several simple ways to test the behavior of your website on mobile phones or tablets:

Open your website on a smartphone or tablet browser: if the site is displayed in the same way on your PC but smaller because the browser has

zoom it out to fit the screen width, it is likely that the site is not responsive.

Open your website in your favorite browser but reduce the width of the window: if an horizontal scrollbar appear the website is not responsive.

Do the same test on our website in your browser and watch how the site adapts its layout when decreasing the width.

Use our responsive design test page : enter the address of your site and see how it behaves with different widths.

For more information

See examples of responsive websites directly usable in TOWeb

Add web pages, paragraphs and objects automatically adaptable

Verify your site from your computer by entering its URL in our tool to test it in different page width sizes

https://www.lauyan.com/en/responsive-webdesign-faq.html#yqDP9XAy
https://www.lauyan.com/test-rwd/
https://www.lauyan.com/en/responsive-webdesign-faq.html#5MEK44YQ
https://www.lauyan.com/en/gallery.php
https://www.lauyan.com/en/topics.html
https://www.lauyan.com/test-rwd/


Smartphones

Smartphone Web browser customization

Smartphone-specific rules

Phone numbers and Links

Additional tips

Smartphone Web browser customization

Some extra information can be added to your website to allow display customization of some web browser elements when visiting your site. These
options can be added to your site from the following screen : "Options > Smartphone" in TOWeb V7-V14 (and "File > Your website" in TOWeb V6).

Web browser status bar color on smartphones

Some browsers may recognize and use a custom color defined for the display of their elements if the version of the mobile platform supports it too.
This is the case with the Google Chrome browser and web browsers offered by default in Android devices but also with Windows Phone devices. By
using and adding this option to your site, you allow Internet users to view your site better suited to your theme, as shown in the example below with a
screenshot before and after using a custom color.

https://www.lauyan.com/en/smartphones.html#xS5EcDjc
https://www.lauyan.com/en/smartphones.html#rules
https://www.lauyan.com/en/smartphones.html#links
https://www.lauyan.com/en/smartphones.html#5LiPx5Cx
https://www.lauyan.com/en/smartphones.html#xS5EcDjc


The above screenshots were made by a Samsung Galaxy S6 and its default web browser. The way custom color is used (or not) to color certain
elements depends on web browsers, their versions and the version of the platform supporting (or not) such option.
If you want to reuse a color already present in the theme of your site, you need to proceed as follows: from step "Theme" click on the original element
and then on its color button. Once the "Colors" window is opened you can select and make a copy of its "color code" to the clipboard and then reuse
this code with a paste. Finally, if you do not want to use any of custom color simply leave (or reselect) the "Auto" color.
On the iOS platform with the Safari browser there are 3 possible display choices : the normal default display of a web page in Safari, the display with a
status bar using a black background and the status bar display using transparency. For these 2 last option to work, it is necessary to have saved your
site URL not among the favorites of your iPhone / iPad but as an icon on your home screen by using the "Share" (  ) "Add to Home screen" (  )

and then open your site directly from this icon (given that the icon to be used will be your favicon or the iOS icon defined for your site).

Smartphone-specific rules

The operating rules applicable only to mobile and touch devices are available from version 7 of TOWeb and accessible from the "Options>
Smartphone" screen.

Parallax effects

The parallax effects are not always supported or even incompatible with some smartphones and tablets (mainly older models), therefore TOWeb allows
you to disable them on these touch devices for all pages of your site.

Full screen height

The full height  option often forces you to only put very few information on the screen so that everything can also be seen on low-resolution devices
such as smartphones. If you notice that in some low resolution screens all the content is not visible when using the full height option then you will
have to disable it on smartphones by adjusting the minimum size below which this effect will be applied (default is 480px).

Force the navigation of your site in landscape mode

Some elements of your pages may need to have a minimum screen width to be presented in the most pleasant and/or readable way possible (like for
instance some data tables or reduced size images that are too small to see the details you want to show). If this is the case for some pages of your
site, then it may be desirable to activate the display of an animation indicating your visitors to switch their smartphone landscape mode (ie
horizontally) when it uses it in portrait mode (ie. vertically).

Paragraph animations

Depending on the performance of some smartphones,  the paragraph animations can cause significant slowdowns in the display and/or a less pleasant

navigation for these users. Therefore, it is recommended to disable all paragraph animations throughout your site.

Floating text around images (or any other objects)
Texts wrapped around objects (such as images for instance) are generally not easy to read on small devices as they often have only one or two words
per line. To avoid this situation and make your text easy to read for all smartphone users, it is recommended to deactivate the floating object effects
of your site from the TOWeb "Options > Smartphones" step.
Note: the use of this option requires a version 8.10 or greater of TOWeb.

Option activated on smartphone

Option deactivated on smartphone



https://www.lauyan.com/en/seo.html#sWkbJQP2
https://www.lauyan.com/en/smartphones.html#rules
https://www.lauyan.com/en/topics.html#jZrlf3D1
https://www.lauyan.com/en/topics.html#jZrlf3D1
https://www.lauyan.com/en/topics.html#sLJmX6xD


If the images (or any other floating objects) on your site have a width near 300px, you should consider setting the maximum width option to 520px
(or any higher value). If on the other hand your images or integrated objects have a width between 400px or 500px then you may rather consider to
set a the smartphone maximal width to 800px or higher. If necessary, use the smartphone and tablet test buttons located at the top right corner of the
TOWeb window to see the result in different screen modes  and/or perform an external preview (using the F12 key) in order to test by resizing the
window of your browser and make the right adjustment of the value according to content of all your pages.

Phone numbers and Links

On your site you can add SMS links and links to make phone calls so that visitors of your site can directly reach you with a simple click from their
smartphone during their visit. The visibility option "mobile only" or "always visible" can then be applied to your links according to your needs.
If you choose to display links or phone buttons also for devices that can not make calls (such as a computer) then these links will be inactive but their
content will be displayed. In such a case, it may be desirable to also correctly label your phone number in the text of your link / button rather than
just a "Contact me" message to make your number visible to all.
Finally you have the possibility to deactivate at any time all the phone links of your site from the only option "Disable automatic phone number linking"
located in the screen "Options > Smartphone" of TOWeb (from version 7 and above).

Additional tips

Navigation and structure of your website

.htaccess files

https://www.lauyan.com/en/smartphones.html#links
https://www.lauyan.com/en/menu-links.html#SgawaPB0
https://www.lauyan.com/en/menu-links.html#SgawaPB0
https://www.lauyan.com/en/smartphones.html#5LiPx5Cx
https://www.lauyan.com/en/menu-links.html
https://www.lauyan.com/en/site-rules.html


Earn money by sponsoring TOWeb

Become a "TOWeb Ambassador" and earn 30%
commissions !
Our sponsoring program for TOWeb and PageXL  is a free partnership system allowing you to receive 30%
commissions on all sales made thanks to you.

Becoming an "Ambassador" is free and simple

The creation of a Free PageXL account is required to be able to promote TOWeb and manage your commissions. From your PageXL account you will find

your TOWeb personal sponsorship link to share.

Each time a person visits our TOWeb site ( lauyan.com ) using your referral link, this will be stored for 30 days in a cookie of his/her web browser. And
if, during this 30-day period, this visitor purchases a TOWeb license, then a 30% commission of the tax-free amount will be credited to your account.

You can request and receive payment of your commissions at any time as soon as the amount of your account exceeds the threshold of 100€.

The screenshot (on which you can click to enlarge it) shows the interface with the shareable links as well as the account history of a person who has
already received a payment of 148.98€ and whose latest earnings are at 74.49€.

Everything to gain and nothing to lose !

Not only sharing your referral links  around you costs nothing but depending on the people you will contact and their need for a web solution like
TOWeb or PageXL, this can easily and quickly bring you a lot of money thanks to your 30% commissions  on the amount (tax excluded) you
receive for each sale made through your intermediary.

Completely free, open to everyone and without any commitment 

No registration or subscription fees. Becoming a "TOWeb Ambassador" is free and everyone can become one, whether or not you have already
purchased our products.
No obligation or quota is imposed on you. You decide to share your referral links with people of your choice (friends, family, professional relations, ...)
when and as you wish in accordance with the terms of the partnership  and thereafter, at any time, can stop or continue to use your referral links.

 (1)

 (3)(4)

(2)

https://pagexl.com/
https://www.lauyan.com/en/toweb-affiliate-program.html#GejHU3aA?twscroll
https://www.lauyan.com/en/_media/img/thumb/affiliate-image.webp
https://www.lauyan.com/en/_media/img/xlarge/pagexl-account-en.webp


A 30% commission on sales excluding VAT
For example,  if a visitor land on the lauyan.com TOWeb site thru your referral link and thereafter, during the next 30 days, purchases  a Studio

license, your partnership account will be credited up to 89.7€ just for this single sale depending on this person's country ! (6)

How to check the proper functioning of your referral links?

Before sharing your referral link and in order to fully understand the process and to be able to explain it to your contacts, you can perform the
following verification test:
1) use your TOWeb affiliate link for example directly by using a "copy" and then a "paste" to the address bar of your web browser
2) once on the www.lauyan.com site, when you go to the Pricing page and click on one of the Buy now buttons then at the end of the order form,
next to the question "how did you hear about TOWeb", you should see a code (your referral identifier) as well as a "referred by" mention like this :

Notes: the web browser used must accept cookies otherwise it will not work. This referral cookie will automatically expire after 30 days, unless the
referred person reuses your link again (in which case it will expire again 30 days after the last use of the referral link).

Where and how to share your referral links ?

To promote TOWeb around you, you can share your referral links in different ways:

on social networks (WhatsApp, Twitter, Facebook, PInterest, ...) by yourself using the buttons provided in your PageXL account

on your blog or website by promoting TOWeb in a paragraph, a footer, a page containing your tests/reviews, ...

by email or SMS to your friends, clients or other relationships

by making video tutorials on TOWeb and sharing your referral link there

in your contributions to forums related to website creation.

Your articles and messages on TOWeb can be fed using the key points of TOWeb and illustrated by the images, logos, icons and screenshots of TOWeb .

If you have any questions regarding our partnership program or the use of your PageXL account, please do not hesitate to contact our service using at
contact@pagexl.com .

Join our partnership program now

 Our partnership program allows you to collect commissions on TOWeb sales but also those of PageXL (our other
solution to quickly and easily create a website) using the appropriate referral links located in your PageXL account

 The terms of the partnership can be viewed in your PageXL account, below your referral links
 Commissions are not retroactive for customers who could have known and purchased a TOWeb license through you

before the use of your referral links nor from people who have not used your referral links for their purchases 
Commissions are only applicable on purchases made by new customers and therefore does not apply to any license

upgrades or subsequent purchases of other TOWeb licenses
 If you want to test your TOWeb referral link by yourself or make sure that your contacts correctly use your links before

their purchase, this can be done by checking that the content of the "How did you know TOWeb?" field is not empty but
mentioning your sponsorship in the TOWeb order form

 (5)

Min and max commissions earned depending on countries VAT

Min and max commissions earned depending on countries VAT

Min Max

TOWeb 14 PREMIUM 23€ 29,7€

TOWeb 14 E-COMMERCE 47€ 59,7€

TOWeb 14 STUDIO 70€ 89,7€

(1)

(2)

(3)

(4) 

(5)

https://www.lauyan.com/en/toweb-keypoints.html
https://www.lauyan.com/en/toweb-keypoints.html#PcWZCKjT
https://www.lauyan.com/en/znvygb?pbagnpg#cntrky.pbz
https://pagexl.com/builder/


 For example if a person residing in France where a 20% VAT is applicable and purchasing a Studio license at 299€, the
commission earned is thus 30% of the amount of 249.17€ (excl. tax), that is to say a gain of 74.75€

(6)


